gvSIG 1.1
User guide (English- Version 1*)

(*Corresponding to the spanish user guide version 3)
## Table of contents

1. Guide to the different versions of the gvSIG User Manual.............................................. 13
2. Introduction.................................................................................................................. 14
   2.1 What is gvSIG?........................................................................................................ 14
   2.2 What can we do with gvSIG?................................................................................ 14
       2.2.1 The gvSIG interface.................................................................................... 15
3. gvSIG Projects and documents.................................................................................... 17
   3.1 Saving a project...................................................................................................... 18
   3.2 Saving and Closing a project.................................................................................. 19
   3.3 Opening an existing project.................................................................................... 20
   3.4 New project............................................................................................................ 20
   3.5 Preference window.................................................................................................. 21
       3.5.1 Editing............................................................................................................ 22
       3.5.1.1 Colour of the selection.............................................................................. 23
       3.5.1.2 Colour of the reference axis.................................................................... 24
       3.5.1.3 Colour of the selection geometry............................................................ 24
       3.5.1.4 Colour of the selection handler............................................................... 25
       3.5.2 General.......................................................................................................... 26
       3.5.2.1 Extension directory.................................................................................. 26
       3.5.2.2 Language................................................................................................... 27
       3.5.2.3 Web browser............................................................................................. 27
       3.5.2.4 Extensions.................................................................................................. 28
       3.5.2.5 Appearance................................................................................................ 29
       3.5.2.6 Folders........................................................................................................ 29
       3.5.2.7 Display configuration................................................................................ 30
       3.5.2.8 Map............................................................................................................ 30
   3.5.3 Annotation preferences......................................................................................... 31
   3.5.4 Network.............................................................................................................. 33
       3.5.4.1 Firewall/Proxy.......................................................................................... 33
   3.5.5 View.................................................................................................................... 33
4. Copying and pasting documents in gvSIG................................................................. 35
   4.1 Copying/Pasting Views............................................................................................ 35
   4.2 Copying/Pasting Tables........................................................................................... 37
   4.3 Copying/Pasting Maps............................................................................................ 37
   4.4 “Cutting” documents in gvSIG............................................................................ 39
5. Views.......................................................................................................................... 40
   5.1 Creating a view....................................................................................................... 41
5.2 Properties of a view in gvSIG................................................................. 43
5.3 Layer data source.................................................................................. 45
5.4 Adding a layer to gvSIG......................................................................... 46
  5.4.1 Adding a layer from a disk file.............................................................. 47
    5.4.1.1 Selecting layers.............................................................................. 48
  5.4.2 Adding a layer using the WFS protocol.............................................. 48
    5.4.2.1 Introduction.................................................................................. 48
    5.4.2.2 Connecting to the server................................................................. 49
    5.4.2.3 Accessing the service................................................................. 50
    5.4.2.4 Selecting “Layers” ................................................................. 50
    5.4.2.5 Selecting “Attributes”.............................................................. 51
    5.4.2.6 “Options” tab.............................................................................. 52
    5.4.2.7 Filter.......................................................................................... 53
    5.4.2.8 Adding the layer to the view......................................................... 54
    5.4.2.9 Modifying the layer’s properties................................................. 55
  5.4.3 Adding a layer using the WMS protocol............................................ 55
    5.4.3.1 Introduction.................................................................................. 55
    5.4.3.2 Connecting to the service................................................................. 55
    5.4.3.3 Accessing the service................................................................. 56
    5.4.3.4 Selecting “Layers” ................................................................. 57
    5.4.3.5 Selecting “Styles” for the WMS server layers............................. 58
    5.4.3.6 Selecting values for a WMS layer’s “Dimensions” ...................... 59
    5.4.3.7 Selecting the format, spatial system and/or transparency .......... 61
    5.4.3.8 Adding the layer to the view......................................................... 62
    5.4.3.9 Modifying the layer’s properties................................................. 63
  5.4.4 Adding a layer using the WCS protocol .......................................... 63
    5.4.4.1 Introduction.................................................................................. 63
    5.4.4.2 Accessing the service................................................................. 64
    5.4.4.3 Selecting “Coverages” .............................................................. 65
    5.4.4.4 Selecting the “Format” .............................................................. 66
    5.4.4.5 Adding the layer to the view......................................................... 67
    5.4.4.6 Modifying the layer’s properties................................................. 68
  5.4.5 Adding a layer using the ArcIMS protocol........................................ 68
    5.4.5.1 Introduction to ArcIMS................................................................. 68
    5.4.5.2 Connecting to image services....................................................... 69
    5.4.5.3 Adding a layer using ArcIMS....................................................... 69
      5.4.5.3.1 Connecting to the server....................................................... 69
      5.4.5.3.2 Accessing the service......................................................... 71
      5.4.5.3.3 Selecting layers................................................................. 74
5.4.5.3.4 Adding the layer to the view ............................................................ 75
5.4.5.4 Points to remember about spatial reference systems .................. 76
5.4.5.5 Modifying the layer's properties ....................................................... 77
5.4.5.6 Information about scale limits .......................................................... 78
5.4.5.7 Attribute information requests ......................................................... 79
5.4.5.8 Connecting to geometry services ..................................................... 80
5.4.5.9 Adding a geometry layer ................................................................. 80
5.4.5.10 ArcIMS symbols ........................................................................ 81
5.4.5.11 Symbols ..................................................................................... 81
5.4.5.12 Legends .................................................................................... 82
5.4.5.13 Working with the layer ................................................................. 83
5.4.6 Adding orthophotos using the ECWP protocol ......................... 84
5.5 Table of contents (ToC) ....................................................................... 87
  5.5.1 Grouping and ungrouping layers ..................................................... 88
5.6 Copying layers in gvSIG ................................................................. 90
5.7 Creating a new layer ........................................................................... 92
  5.7.1 Creating a new SHP file .................................................................... 93
  5.7.2 Creating a new DXF file .................................................................... 97
  5.7.3 Creating a new PostGIS file .............................................................. 98
5.8 Adding an Event layer ................................................................. 99
  5.8.1 Adding an event layer from a table ................................................... 100
  5.8.2 Adding an event layer from a table associated with a layer in the view ..... 104
5.9 Layer properties ........................................................................... 105
  5.9.1 Vector layer .................................................................................. 105
    5.9.1.1 Changing colours ...................................................................... 105
    5.9.1.2 Renaming ............................................................................... 108
    5.9.1.3 Properties ........................................................................... 109
      5.9.1.3.1 Using the spatial index ....................................................... 110
      5.9.1.3.2 Scale range ................................................................. 110
      5.9.1.3.3 File extension and path .................................................... 111
      5.9.1.3.4 Hyperlink ...................................................................... 111
    5.9.1.4 Legend editor ......................................................................... 113
      5.9.1.4.1 Unique symbols .............................................................. 115
      5.9.1.4.2 Unique values .................................................................. 116
      5.9.1.4.3 Intervals ....................................................................... 117
      5.9.1.4.4 Labelling ....................................................................... 119
  5.9.2 Raster layer ............................................................................... 120
    5.9.2.1 Raster properties .................................................................... 120
5.10 Navigating around / Exploring the view .................................. 125
  5.10.1 Zooms and panning ................................................................. 126
5.23.1 Exporting to image ................................................................. 163
5.23.2 Web Map Context ................................................................. 165
  5.23.2.1 Introduction ...................................................................... 165
  5.23.2.2 Exporting a view to WMC .............................................. 166
  5.23.2.3 Importing an WMC .......................................................... 169
5.24 Annotation layer ..................................................................... 170
  5.24.1 Creating an annotation layer .............................................. 170
  5.24.2 Editing an annotation layer ............................................... 173
  5.24.3 Annotation layer properties ............................................... 174
  5.24.4 Adding an annotation layer to the view .................................. 175
  5.24.5 Example of how to create an annotation layer ....................... 175
5.25 Working with raster images ...................................................... 176
  5.25.1 Saving as raster .................................................................... 176
  5.25.2 Georeferencing with base mapping and control points ............. 184
    5.25.2.1 Moving the image to be georeferenced closer .................. 187
    5.25.2.2 Selecting control points ............................................... 188
    5.25.2.3 Saving and adding control points ................................. 193
    5.25.2.4 Options ........................................................................ 194
    5.25.2.5 Restrictions .................................................................... 194
  5.25.3 Brightness and contrast and Enhance ....................................... 194
  5.25.4 Transparency per pixel ......................................................... 197
  5.25.5 Selecting a raster layer ........................................................ 199

6 Tables .......................................................................................... 201
  6.1 Adding a Table ......................................................................... 203
    6.1.1 Adding a table from the “Project manager” ........................... 203
    6.1.2 Adding a table from a view ................................................ 205
  6.2 Table properties ........................................................................ 207
    6.2.1 Statistics ............................................................................. 207
    6.2.2 Filters .................................................................................. 208
    6.2.3 Ascending order ................................................................... 210
    6.2.4 Descending order .................................................................. 210
    6.2.5 Join ...................................................................................... 211
    6.2.6 Link ...................................................................................... 213
    6.2.7 Moving the selection to the top ............................................ 215
  6.3 Table-associated tools ................................................................ 216
  6.4 Adding a table from a CSV file .................................................. 217
  6.5 Adding a table from a JDBC data origin ....................................... 219

7 Field Calculator ........................................................................... 220
  7.1 Accessing gvSIG’s field calculator ............................................. 221
  7.2 Description of the “Field Calculator” .......................................... 222
7.2.1 Information........................................................................................................223
7.2.2 General / Advanced Tabs................................................................................227
7.2.3 “Expression” Section.......................................................................................228
7.3 Introduction example: “Field calculator”..............................................................228
8 Editing tools............................................................................................................233
8.1 Introduction..........................................................................................................233
8.2 Graphic editing.....................................................................................................233
  8.2.1 Introduction......................................................................................................233
  8.2.2 The graphic area............................................................................................234
  8.2.3 Starting and finishing an editing session in gvSIG...........................................235
  8.2.4 Procedures to input commands........................................................................237
    8.2.4.1 Tool bar....................................................................................................237
    8.2.4.2 Menu bar................................................................................................237
    8.2.4.3 Command console...................................................................................238
  8.2.5 Edition properties............................................................................................239
    8.2.5.1 Snapping...................................................................................................239
    8.2.5.2 Configuring the grid................................................................................240
    8.2.5.3 Flatness....................................................................................................241
  8.2.6 Undo/Redo......................................................................................................241
    8.2.6.1 Command stack.......................................................................................242
  8.2.7 Coordinates....................................................................................................243
    8.2.7.1 Console mode..........................................................................................244
    8.2.7.2 Graphic mode..........................................................................................244
  8.2.8 Editing commands..........................................................................................245
    8.2.8.1 Selecting....................................................................................................245
      8.2.8.1.1 Simple selection...............................................................................245
      8.2.8.1.2 Complex selection............................................................................246
    8.2.8.2 Copying....................................................................................................250
    8.2.8.3 Symmetry................................................................................................252
    8.2.8.4 Rotating....................................................................................................253
    8.2.8.5 Scaling.....................................................................................................255
    8.2.8.6 Moving Elements.....................................................................................258
    8.2.8.7 Editing vertex..........................................................................................260
    8.2.8.8 Internal polygon......................................................................................263
  8.2.9 Drawing commands.........................................................................................266
    8.2.9.1 Point........................................................................................................266
    8.2.9.2 Multipoint................................................................................................268
    8.2.9.3 Line..........................................................................................................270
    8.2.9.4 Arc..........................................................................................................272
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.2.9.5 Polyline</td>
<td>274</td>
</tr>
<tr>
<td>8.2.9.6 Polygon</td>
<td>277</td>
</tr>
<tr>
<td>8.2.9.7 Rectangle</td>
<td>279</td>
</tr>
<tr>
<td>8.2.9.8 Square</td>
<td>281</td>
</tr>
<tr>
<td>8.2.9.9 Circle</td>
<td>283</td>
</tr>
<tr>
<td>8.2.9.10 Ellipse</td>
<td>286</td>
</tr>
<tr>
<td>8.3 Alphanumeric edition</td>
<td>289</td>
</tr>
<tr>
<td>8.3.1 Editing session for an “internal” table.</td>
<td>290</td>
</tr>
<tr>
<td>8.3.2 Editing session for an “external” table.</td>
<td>291</td>
</tr>
<tr>
<td>8.3.3 Editing a layer’s table of attributes</td>
<td>292</td>
</tr>
<tr>
<td>9.1 Introduction</td>
<td>298</td>
</tr>
<tr>
<td>9.2 Accessing the geoprocesses</td>
<td>302</td>
</tr>
<tr>
<td>9.3 Buffer</td>
<td>303</td>
</tr>
<tr>
<td>9.3.1 Introduction</td>
<td>303</td>
</tr>
<tr>
<td>9.3.2 Creating an area of influence or buffer</td>
<td>304</td>
</tr>
<tr>
<td>9.4 Clipping</td>
<td>309</td>
</tr>
<tr>
<td>9.4.1 Introduction</td>
<td>309</td>
</tr>
<tr>
<td>9.4.2 Clipping</td>
<td>310</td>
</tr>
<tr>
<td>9.5 Dissolve</td>
<td>312</td>
</tr>
<tr>
<td>9.5.1 Introduction</td>
<td>312</td>
</tr>
<tr>
<td>9.5.2 Running the “Dissolve” geoprocess</td>
<td>313</td>
</tr>
<tr>
<td>9.6 Merge</td>
<td>317</td>
</tr>
<tr>
<td>9.6.1 Introduction</td>
<td>317</td>
</tr>
<tr>
<td>9.6.2 Running the “Merge” geoprocess</td>
<td>318</td>
</tr>
<tr>
<td>9.7 Convex hull</td>
<td>322</td>
</tr>
<tr>
<td>9.7.1 Introduction</td>
<td>322</td>
</tr>
<tr>
<td>9.7.2 Creating a convex hull</td>
<td>323</td>
</tr>
<tr>
<td>9.8 Intersection</td>
<td>325</td>
</tr>
<tr>
<td>9.8.1 Introduction</td>
<td>325</td>
</tr>
<tr>
<td>9.8.2 Running the “Intersection” geoprocess</td>
<td>326</td>
</tr>
<tr>
<td>9.9 Difference</td>
<td>327</td>
</tr>
<tr>
<td>9.9.1 Introduction</td>
<td>327</td>
</tr>
<tr>
<td>9.9.2 Running the “Difference” geoprocess</td>
<td>328</td>
</tr>
<tr>
<td>9.10 Union</td>
<td>330</td>
</tr>
<tr>
<td>9.10.1 Introduction</td>
<td>330</td>
</tr>
</tbody>
</table>
9.10.2 Running the “Union” geoprocess................................................................. 331
9.11 Spatial Join ........................................................................................................ 333
  9.11.1 Introduction .................................................................................................. 333
  9.11.2 Running a “Spatial Join” ........................................................................... 334
9.12 2D Translation .................................................................................................. 336
  9.12.1 Introduction .................................................................................................. 336
  9.12.2 Translating a vector layer .......................................................................... 337
9.13 Reprojection....................................................................................................... 339
  9.13.1 Introduction .................................................................................................. 339
  9.13.2 Reprojection of a layer ................................................................................ 339
10 Maps ..................................................................................................................... 340
  10.1 Accessing maps ............................................................................................... 340
  10.2 Map properties ................................................................................................ 342
  10.3 Preparing a page .............................................................................................. 344
  10.4 Inserting elements in a map .......................................................................... 345
    10.4.1 View ........................................................................................................... 346
    10.4.2 Legend ....................................................................................................... 348
    10.4.3 Scale .......................................................................................................... 348
    10.4.4 North symbol ............................................................................................ 350
    10.4.5 Box ............................................................................................................ 351
    10.4.6 Image ......................................................................................................... 351
    10.4.7 Texts .......................................................................................................... 352
    10.4.8 Graphics .................................................................................................... 353
    10.4.8.1 Editing graphic elements in a map ................................................................ 355
  10.5 Undoing / Redoing ......................................................................................... 355
  10.6 Deleting a selection ....................................................................................... 356
  10.7 Map-inserted element properties ................................................................... 356
    10.7.1 Aligning ...................................................................................................... 356
    10.7.2 Grouping / Ungrouping .......................................................................... 357
    10.7.3 Simplifying the legend .............................................................................. 358
    10.7.4 Viewing order ............................................................................................ 358
    10.7.5 Graphic line ............................................................................................... 359
    10.7.6 Size and position ....................................................................................... 360
  10.8 Tools for navigating in a map ........................................................................ 361
  10.9 Exploring the view of the map ..................................................................... 362
  10.10 Templates ...................................................................................................... 362
    10.10.1 Saving templates ...................................................................................... 362
    10.10.2 Open template ........................................................................................ 364
  10.11 Printing ......................................................................................................... 365
tool........................................................................................................................................407
3.11 Known errors in the “Export to raster” tool.................................................................407
4 GNU GENERAL PUBLIC LICENSE..................................................................................408
1 Guide to the different versions of the gvSIG User Manual.

<table>
<thead>
<tr>
<th>Guide to the different versions of the gvSIG user manual</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Version</strong></td>
</tr>
<tr>
<td>gvSIG 1.1 User Manual / Version 0</td>
</tr>
</tbody>
</table>

* This version of the user manual corresponds to version 3 of the same manual in Spanish.
2 Introduction

The gvSIG project came into being as a result of an initiative carried out by the Valencian Regional Government (Generalitat Valenciana), through its Regional Ministry for Infrastructure and Transport (the public tender “Computer services for the development of GIS applications for the Regional Ministry for Infrastructure and Transport using free software”).

The Jaume I University is in charge of monitoring the project so that it complies with all international standards (Open GIS Consortium).

IVER Tecnologías de la Información S.A. was awarded the tender and is responsible for the application’s development.

2.1 What is gvSIG?

gvSIG is a programme which manages geographic information. It has a user-friendly interface and fast access to most standard raster and vector formats. gvSIG can also integrate local and remote data in the same view through WMS, WFS, WCS and JDBC sources.

It is aimed at end users of geographic information in business and public administration (city councils, regional councils and regional and national ministries).

It is also highly suited to the university environment thanks to its R&D&I element.

It is a free, open code application with a GPL licence. From the outset, special emphasis has been given to the expansion of the gvSIG project so that developers can add functions to the application easily and develop completely new applications from the libraries used in gvSIG (as long as they comply with the GPL licence).

2.2 What can we do with gvSIG?

gvSIG is a sophisticated Geographic Information System for managing spatial data and performing complex analyses on it.

gvSIG can be used for a wide range of tasks, including:
2.2.1 The gvSIG interface

The gvSIG interface has the necessary features required to communicate with the programme. The graphical interface is intuitive and user-friendly and is suitable for any user who is familiar with Geographic Information Systems.

The gvSIG interface is made up of a main window with different tools and secondary windows for the documents created using the programme, as described in the following sections.

Before describing the different documents and tools, we must take a look at the gvSIG interface. The more familiar you become with the interface the easier it will be to go through the following chapters.

- **1. Title bar**: Located at the top of the gvSIG window. It contains the programme name, i.e. “gvSIG” in this case.
2. Buttons to maximize or minimize the programme’s active window or to completely close it.

3. Main window: Work area in which the different “Project Manager” windows and the different gvSIG documents are located.

4. Menu bar: Some of the gvSIG functions are grouped into menus and sub-menus in the menu bar.

5. Toolbar: The toolbar contains the icons for the standard commands and is the easiest way to access them. By clicking and dragging the toolbars we can move them to different positions. It is not necessary to memorize the meaning of every single icon. When you place the mouse pointer over them a message with a description of their function immediately appears.

6. Status bar: The status bar provides information about coordinates, distances, etc.
3 gvSIG Projects and documents

In gvSIG all the activities are located in one project. This project is made up of different documents. There are three types of documents in gvSIG: views, tables and maps.

- **Views**: Views are the documents in which we work with graphic data.
- **Tables**: Tables are the documents in which we work with alphanumerical data.
- **Maps**: A map generator which allows the different cartographic elements included in a map (view, legend, scale...) to be inserted.

Projects are files with a ".gvp" extension. These files do not include spatial data and associated attributes in the shape of tables. Instead they save references to the places the data sources are stored (the path to be followed in the disk in order to find the files). If the data changes the updates will be shown in all the projects they are used in.

The menu which allows you to access the project management options is located in the "File" menu.
And in the following toolbar buttons ("New project", "Open project" and "Save project").

### 3.1 Saving a project

1. Click on "File" in the menu bar and then on "Save project". Alternatively, press the "Alt+G" key combination, or the "Save" button in the toolbar.

2. When the file manager window is opened you can name the project and choose where to save it.
3. The project is saved in a file with a “.gvp” extension.

3.2 Saving and Closing a project

When you decide to finish a session in gvSIG, a window such as the one shown below appears:

The text box shows both the name of the project currently in use as well as the layers and tables which were being edited before the decision to close the project was made.

The “Select all” and “Clear selection” buttons allow you to enable or disable the check boxes in the text box which correspond to the project or to the layers being edited.

If you click on “Ok”, the changes made to the enabled elements in the text box will be saved.

If you click on “Discard changes”, none of the changes made in the project will be saved irrespective of whether they have been enabled or not.

The “Cancel” button allows you to exit the window.
3.3 Opening an existing project

1. If you wish to open an existing project to see or modify it, go to the “File” menu and click on “Open project”. Alternatively, press the “Alt+A” key combination or the “Open project” button in the toolbar.

2. When the project manager window is open, look for the “.gvp” file which contains the project you wish to open.

![Open window](image)

3.4 New project

1. Click on “File” in the menu bar and then on “New project”. Alternatively, press the “Alt+N” key combination or the “New” button in the toolbar.
2. If you are already working on a project, the following message will appear when the button is pressed.

If you press “Yes”, a window will open so you can save your current gvSIG project. When the previous project has been saved a new blank project will appear on the screen.

3.5 Preference window

The preference window allows you to customise gvSIG.

You can access the preference window by going to the "Window" menu then to "Preferences"

or by clicking on the “Preferences” button in the tool bar.
When you have accessed the tool, a new window appears in which you can configure your preferences.

Select the property you wish to access from the tree on the left and the preferences you can configure will appear in the space on the right.

### 3.5.1 Editing

This allows a series of default colours used in a gvSIG editing session to be chosen. A detailed explanation is provided below:
3.5.1.1 Colour of the selection

This allows you to set the default colour for the selected geometry of a layer which is being edited.
3.5.1.2 Colour of the reference axis

This allows you to set the colour of the reference axis which will guide you through any editing operations, for instance operations such as “symmetry”, “rotate” etc…

3.5.1.3 Colour of the selection geometry

This allows you to set the default colour of the selection frame used to select the required geometry.
3.5.1.4 Colour of the selection handler

This allows you to set the default colour for the “Handlers”, in other words the vertexes which make up the selected object. In this case, the colour of the outline can be selected, as can the colour of the inside of the handler.
3.5.2 General

This tool establishes whether gvSIG needs to remember the project windows’ position and size.

If you pull down the tree (click on “+”), the properties you can configure in “General” will appear.

3.5.2.1 Extension directory

This tool defines the directory for the extensions that gvSIG must use.
3.5.2.2 Language

This allows you to select the language in which gvSIG must be shown. To select a language, click on the pull-down menu and select the language from those available.

![Language menu](image)

Remember that gvSIG must be restarted for the language change to take effect.

3.5.2.3 Web browser

This allows a default web browser (for the Linux operating system) to be specified for any search carried out from gvSIG to any of the hyperlinks found in the application.

The first option contains the pull-down menu in which the different supported browsers are located.

The second option can be used to specify which browser you want to open the different URLs included in the application such as the URLs in the “Help” menu (Example: firefox %www.gvsig.gva.es).
3.5.2.4 Extensions

This allows you to configure the extensions that gvSIG uses while running. Pull down the extension tree and select the required extension.

A description of the selected extension is displayed. You can activate or deactivate the extension and modify its order of priority in the list.
N.B.: If you activate an extension, you will have to restart gvSIG to use it.

### 3.5.2.5 Appearance

You can use this tool to modify gvSIG’s appearance. Pull down the box with the available options and select the required option.

N.B.: You will have to restart gvSIG for this change to take effect.

### 3.5.2.6 Folders

You can use this option to create a shortcut to the folders your projects (.gvp), data (raster and vector) or templates (.gvt) are saved in.
3.5.2.7 Display configuration

You can specify the points per inch for your display in the “Resolution” text box. gvSIG allows you to calculate the exact resolution of your display as follows:

- Place a ruler on the screen to measure the straight line drawn in the “Test measurement” box.
- Write the measurement obtained in the text box underneath (the value 5.61 has been inserted in this example) and the units in which this measurement was taken.
(“Centimetres” in our case).

- Click on the “Calculate resolution” button.
- gvSIG automatically provides a points per inch value for the resolution of your display. This appears in the corresponding text box (the result in our case is 95ppi).

### 3.5.2.8 Map

This section of the preference window can be used to customise how you wish to work with your map documents.

You can define both the horizontal and vertical grid spacing values and decide whether the grid should be displayed, enabled or disabled and whether the ruler should be enabled or disabled simply by clicking on the required check boxes.

When you have selected your preferences, click on “Ok”.

![Preferences Window](image)

### 3.5.3 Annotation preferences

The annotation preferences allow you to define the default characteristics you wish the annotation layers to have.
You can predefine the default characteristics you wish the annotation layers to have.

- **Text**
  You can select the default text to be written in the annotation layer if the record of the field you have chosen to label is blank. You can choose not to write anything in the record if you wish so that it remains blank.

- **Font type**
  You can select the default font type in which you wish the annotation layer’s text to be written.

- **Text style**
  You can select the default text style you wish the annotation layer to have.

- **Text height**
  You can select the default text height you wish to be used in the annotation layers.

- **Text rotation**
  You can use the text rotation option to select the default orientation that the text in the annotation layers will have. For example, if you want the text to be shown horizontally, input “0 degrees”. If you want the text to be shown vertically, input 90°.
Remember that gvSIG uses sexagesimal graduation and this turns anti-clockwise.

- **Text colour**
  
  You can select the default text colour you wish the text in the annotation layers to be shown in.

### 3.5.4 Network

gvSIG allows you to check the status of a network connection.

![Network status](image)

#### 3.5.4.1 Firewall/Proxy

If you use a proxy connection, you can configure your connection parameters so that gvSIG can use them.

![Firewall/Proxy](image)

### 3.5.5 View

You can configure the values that gvSIG will use for zooming in or out of a view and
changing the selection colour which by default is "Yellow".

You can also use this window to define map and measuring units for gvSIG.

You can use this window to change the view projection by clicking on the "Change" button. A dialogue box appears from which you can choose the reference system.
4 Copying and pasting documents in gvSIG

If you copy and paste a document, you should remember that if this document has any other documents associated with it these will also be copied (example: if a map is copied the views it includes will also be copied).

N.B. You can select several documents to be copied at the same time.

N.B. Remember that if you press “No” or “Cancel” in any of the dialogue boxes which appear during the process, none of the changes you have made in the process will be saved.

4.1 Copying/Pasting Views

Select the view you wish to copy from the “gvSIG Project manager”, right click and select “Copy” from the contextual menu.
If you wish to copy the view to another gvSIG project, select “Paste” from the contextual menu. If a project already has a view with this name a message will appear to indicate that you must change the name of the view you are trying to paste.
N.B. The message “No table will be pasted” means that the tables which are active in the source view will not appear in the target view unless they are activated in this view. If you wish to cancel the operation, press “No”. If you press “Yes” a new dialogue box will appear so the view can be given a new name.

Write the new view name and press “OK”. This view will be added to the project. If you press “Cancel” the process will be terminated.

4.2 Copying/Pasting Tables

The procedure for copying/pasting tables is similar to the procedure described above. However, in this case tables with the same name can exist in a project.

4.3 Copying/Pasting Maps

The procedure for copying and pasting maps is similar to the previous two cases.
Select the map you wish to copy from the “Project Manager”, right click and select “Copy” from the contextual menu.

If you wish to paste the map to a project which already has a map with the same name, the following message will appear.

![Paste maps dialog](image)

If you press “No”, the operation will be cancelled.

If you press “Yes”, a new dialogue box will appear. Write the new name for the map in the box and press “OK”.

![Input dialog](image)

If you press “Cancel” the process will be terminated.

If any of the views associated with the map already exist in the current project the following message will appear.

![Paste maps dialog](image)
If you press “Yes”, a new map document will be created.

If you press “No” the operation will be cancelled.

N.B. The message “The conflicting views will not be pasted” indicates that the views the maps are associated with will not be added. Instead, the views which already exist in the current project with these names will be used (example: You have copied a map with an “A” view and a “B” view. When you try to paste the map into the project, you find that an “A” view already exists. The operation will add the “B” view and will leave the “A” view intact so that the map will use the pre-existing “A” view).

4.4 “Cutting” documents in gvSIG

Use the “Project manager” to select the document you wish to cut. Right click and select the “Cut” option from the contextual menu. The following window will appear.

If you press “Yes” the selected document will be “cut” from your project.
5 Views

Views are the gvSIG documents used as the working area of cartographic information. A view can contain different layers of geographic information (hydrography, transport infrastructures, administrative regions, contour lines, etc.).

When one of the views that make up a project is opened, a new window appears divided into the following parts:

- **Table of contents (ToC):** The ToC is located on the left-hand side of the window. The Table of Contents lists all the layers it contains and the symbols used to represent the elements which make up the layer.

- **Display window:** The display window is located on the right-hand side of the screen. The project’s cartographic data are shown in this display window.
• **Locator:** The locator is situated in the bottom left-hand corner. The locator allows the current frame to be situated in the work area as a whole.

When a view is opened, the main window increases the number of menus and buttons, thus adding the tools required to work with the elements which make up the view.

The size of the ToC can be enlarged to show a full description of all the themes by simply dragging its edge to the right or downwards.

### 5.1 Creating a view.

To create a “View” in gvSIG go to the “**Project Manager**” window (“Show” menu / “Project window”).

1. In the “Project manager” window, select “**Views**” in the document type.
2. Then click on the “**New**” button.
3. A document in “Views” is created (immediately) which by default is called “Untitled - 0”.

© 2007 Conselleria de Infraestructuras y Transporte

Page 41 of 409
4. The name of the “View” can be changed by selecting the document from the list and clicking on the “Rename” button. A window appears in which the name of the “View” can be changed.

5. To access the “View properties” window, click on the “Properties” button.

5.1. It is important to select the cartography units and the distance units for the “View”. Their default values are expressed in metres.

5.2. The “View” background colour can be configured. It is white by default.

5.3 From gvSIG version 0.3 onwards, the “Views” support different projections
and reference systems. You must select the reference system the cartographic information is to be displayed with.

5.2 Properties of a view in gvSIG

To access the properties window of a view, go to the “View” menu and select “Properties”.

<table>
<thead>
<tr>
<th>View</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export</td>
<td></td>
</tr>
<tr>
<td>Import</td>
<td></td>
</tr>
<tr>
<td>Centrar_la_Vista_sobre_un_punto</td>
<td></td>
</tr>
<tr>
<td>New layer</td>
<td></td>
</tr>
<tr>
<td>Add layer</td>
<td>Alt-O</td>
</tr>
<tr>
<td>Navigation</td>
<td></td>
</tr>
<tr>
<td>Query</td>
<td></td>
</tr>
<tr>
<td>Set layers as</td>
<td></td>
</tr>
<tr>
<td>Configure locator map</td>
<td></td>
</tr>
<tr>
<td>Selection</td>
<td></td>
</tr>
<tr>
<td>Properties</td>
<td></td>
</tr>
</tbody>
</table>
The properties you wish your view to have can be configured via the following window.

If you click on the “Current projection” button, a new window will appear in which the view’s datum, projection and time zone can be selected.
If you click on the pull-down menus, the different options available for each element in the reference system are shown. If you make any changes, click on “Apply” and then “Ok”. When you have configured the view’s properties, click on “Ok”.

5.3 Layer data source

Different types of cartographic information can be added to a view. Vector and raster files can be loaded. Each of these groups can contain a wide range of formats.

GIS data: The standard GIS format is the shape, which stores both spatial data and their attributes. A shape (also called “Shape file”) is actually three or more files with the same name and different extensions (even though in gvSIG it is handled as one file):

- dbf: Table of attributes.
- shp: Spatial data.
- shx: Spatial data index.

From version 0.5 onwards, gvSIG also has the capacity to access the MySQL Spatial and PostGIS spatial data bases via a new driver which uses JDBC.

CAD data: These are vector drawing files which support the dxf and dgn formats. The CAD files may contain information on points, lines, polygons and texts. From version 0.4 onwards, gvSIG also allows access to the information contained in Autodesk’s 2000 dwg files.
WMS data (Web Mapping Service): gvSIG can be used to consult WMS data, i.e. data available on the web.

WFS data (Web Feature Service): From version 0.5 onwards, gvSIG can be used to download WFS vector layers from servers that comply with the Open Geospatial Consortium (OGC) Standard.

WCS data (Web Coverage Service): From version 0.4 onwards, gvSIG allows access to remote information based on the OGC’s WCS protocol.

GML (Geography Markup Language): From version 1.0 onwards, gvSIG allows GML documents to be displayed and exported. Geography Markup Language (GML) is an XML format to transport and store geographic information whose design is based on specifications produced by the OGC group.

Images: gvSIG can display different raster images (tiff, jpg, ecw, mrsid, etc.). From version 0.4 onwards, gvSIG can save images which have been modified in these formats.

From version 0.5 onwards, “colour palette” (GIFs, 8-bit PNGs, etc.) raster files can be opened and raster files without georeferencing can also be opened. Moreover, this new version supports GIF, BMP y JPEG2000 formats.

5.4 Adding a layer to gvSIG

Firstly, open a “View” document in gvSIG.

You can access this option by going to the “View” menu and then to "Add layer" or by using the “Control + O” key combination

<table>
<thead>
<tr>
<th>View</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export</td>
<td>▼</td>
</tr>
<tr>
<td>Import</td>
<td>▼</td>
</tr>
<tr>
<td>New layer</td>
<td>▼</td>
</tr>
<tr>
<td>Add layer</td>
<td>Alt-O</td>
</tr>
<tr>
<td>Properties</td>
<td></td>
</tr>
</tbody>
</table>

or by clicking on the "Add layer" button in the tool bar.
A window appears in which you can select and configure the layer’s data source by its type:

5.4.1 Adding a layer from a disk file

Click on the “Add” button
5.4.1.1 Selecting layers

The “Add” dialogue window allows you to move around the file system to select the layer to be loaded. Remember that only the files of the type selected will be shown. To indicate the type of file to be loaded, select a file from the “Files of type” pull down menu.

If several layers are loaded at the same time, the order in which the themes will be added to the view can be specified with the “Up” and “Down” buttons in the “Add layer” dialogue.

5.4.2 Adding a layer using the WFS protocol

5.4.2.1 Introduction

The Web Feature Service (WFS) is one of the OGC standards (http://www.opengeospatial.org) which is included in the list of standards (of this type) that gvSIG supports.
WFS is a communication protocol via which gvSIG retrieves a vector layer in GML format from a supporting server. gvSIG retrieves the geometries and attributes associated to each “Feature” and interprets the contents of the file.

5.4.2.2 Connecting to the server

Go to the “Add layer” and then select the WFS tab.

1. The pull-down menu shows a list of WFS servers (you can add a different server if you don’t find the one you want).

2. Click on “Connect”. gvSIG connects to the server.

3. and 4. When the connection is made, a welcome message from the server appears, if this has been configured. If no welcome message appears, you can check whether you have successfully connected to the server if the “Next” button is enabled.

5. The WFS version number that the server you have connected to is using is shown at the bottom of the box.

N.B. You can select the “Refresh cache” option which will search for information from the server in the local host. This will only work if the same server was used on a previous occasion.
5.4.2.3 Accessing the service

Click on “Next” to start configuring the new WFS layer.

When you have accessed the service, a new group of tabs appears. The first tab (“Information”) shows all the information about the server and about the request that is to be sent. This information is updated as more layers are selected.

5.4.2.4 Selecting “Layers”

The “Layers” tab can be used to select the layer you wish to load. A two-column table appears in which the layer name and the geometry type are shown. As the geometry type is obtained by clicking on the layer (it needs to be obtained from the server), this column is completely blank at the start.

The “Show layer names” option shows the name of the layer as it is recognised by the server and not by its description, which is what appears in the table by default.
5.4.2.5 Selecting “Attributes”

The “Attributes” tab allows the fields (or attributes) of the selected layer to be selected. When the layer is loaded, only the fields that have been selected are retrieved. To select the attributes, enable the check box which appears to their left.
The "Options" tab shows information about user authentication and the connection. The "User" and "Password" fields are used in the WFS-T to be able to identify a user in the server so that writing operations can be carried out (not yet implemented).

The connection parameters are:

- **Number of features in the buffer**, i.e. the maximum number of elements that can be downloaded.
- **Timeout**. This is the length of time beyond which the connection is rejected as it is considered to be incorrect. If these parameters are very low, a correct request may not obtain a response.

The Spatial Reference System (SRS) is another important parameter. Although this cannot currently be changed, it is hoped that this will be possible in the future. In any case, gvSIG reprojects the loaded layer to the spatial system in the view.
5.4.2.7 Filter

You can use this tab to apply filters to your WFS layers. Click on the "Filters" tab in the window.
The “Fields” text box shows the layer’s attributes which can be used as a filter. Click on the selected field to see its values. When the layer is loaded for the first time, the values in the column cannot be selected. However, if you have a filter sentence for the layer you can apply it in the filter text area and the filtered layer will be loaded directly.

If you do not have a filter sentence, load the WFS layer into the ToC, then right click on the mouse and select the “WFS properties” option from the contextual menu.

To create the filter for the WFS layer, double click on the field you wish to use as a filter and it will appear in the bottom text area. Then click on the operator you wish to apply and finally select the value in the “Values” text area by double clicking on it.

When you have created the required filter, click on “Ok” and it will be applied to the WFS layer.

5.4.2.8 Adding the layer to the view

When all the parameters have been configured, click on “Ok”. The layer will be loaded into
a gvSIG view.

5.4.2.9 Modifying the layer’s properties

By right clicking on the layer, its contextual menu appears. If the “WFS Properties” option is selected, an option display opens (similar to the “Add layer” display). This can be used to select new attributes and other layers and change the layer’s properties.

5.4.3 Adding a layer using the WMS protocol

5.4.3.1 Introduction

Part of the gvSIG philosophy in its creation included the implementation of open standards for access to spatial data. Thus, gvSIG includes a WMS client which complies with the current OGC (Open Geospatial Consortium, http://www.opengeospatial.org) standard.

5.4.3.2 Connecting to the service

Go to the "Add layer" window and then select the WMS tab.
1. The pull-down menu shows a list of WMS servers (you can add a different server if you don’t find the one you want).

2. Click on “Connect”.

3. and 4. When the connection is made, a welcome message from the server appears, if this has been configured. If no welcome message appears, you can check whether you have successfully connected to the server if the “Next” button is enabled.

5. The WMS version number that the connection has been made to is shown at the bottom of the box.

5.4.3.3 Accessing the service

Click on “Next” to start configuring the new WMS layer.
When you have accessed the service, a new group of tabs appears. The first tab in the adding a WMS layer wizard is the information tab. It summarises the current configuration of the WMS request (service information, formats, spatial systems, layers which make up the request, etc.). This tab is updated as the properties of its request are changed, added or deleted.

5.4.3.4 Selecting “Layers”
The wizard’s “Layers” tab shows the WMS server’s table of contents.
Select the layers you wish to add to your gvSIG view and click on “Add”. If you wish, you can choose a name for the layer in the “Layer name” field.

N.B. Several layers can be selected at the same time by holding down the “Control” key and left clicking on the mouse.

N.B. To obtain a layer description move the cursor over a layer and wait a few seconds. The information the server has about these layers is shown.

5.4.3.5 Selecting “Styles” for the WMS server layers

The “Styles” tab allows you to choose a display view for the selected layers. However, this is an optional property and the tab may be disabled because the server does not define styles for the selected layers.
5.4.3.6 Selecting values for a WMS layer’s “Dimensions”

The “Dimensions” tab helps to configure the value for the WMS layer dimensions. However, the dimensions property (like the styles property) is optional and may be disabled if the server does not specify dimensions for the selected layers.
No dimension is configured by default. To add a dimension, select one from the “Settings editor” area in the list of dimensions. The controls in the bottom right-hand corner of the tab are enabled. Use the slider control to move through the list of values the server has defined for the selected dimension (for example “TIME” refers to the dates the different images were taken). You can move back to the beginning, one step back, one step forward or move to the end of the list using the navigation buttons which are located below the slider control. If you know the position of the value you require, you can simply write it in the text field and it will move automatically to this value.

Click on “Add” so that you can write the selected value in the text field and request it from the server.

gvSIG allows you to choose between:

- Single value: Only one value is selected
- Multiple value: The values will be added to the list in the order they are selected in
Interval: An initial value and then an end value are selected

When the expression for your dimension is complete, click on “Set” and the expression will appear in the information panel.

N.B. Although each layer can define its own dimensions, only one choice of value is permitted (single, multiple or interval) for each variable (e.g. for the TIME variable a different image date value cannot be chosen in each layer).

N.B. The server may come into conflict with the layer combination and the variable value you have chosen. Some of the layers you have chosen may not support your selected value. If this occurs, a server error message will appear.

N.B. You can personalise the expression in the text field. The dialogue box controls are only designed to make it easier to edit dimension expressions. If you wish you can edit the text field at any time.

5.4.3.7 Selecting the format, spatial system and/or transparency

The “Formats” tab allows you to choose the image format the request will be made with, specify if you wish the server to hand in the image with a transparency (to superimpose the layer onto other layers the gvSIG view already contains) and also the spatial reference system (SRS) you require.
5.4.3.8  Adding the layer to the view

As soon as the configuration is sufficient to place the request, the “Ok” button is enabled. If you click on this button, the new WMS layer will be added to the gvSIG view.
5.4.3.9  Modifying the layer's properties

Once the layer has been added its properties can be modified. To do so, go to the Table of contents in your gvSIG view and right click on the WMS layer you wish to modify. The contextual menu of layer operations appears. Select “WMS Properties”.

The “Config WMS layer” dialogue window appears. This is similar to the wizard for creating the WMS layer and can be used to modify its configurations.

5.4.4  Adding a layer using the WCS protocol

5.4.4.1  Introduction

The WCS (Web Coverage Service) is another of the OGC standards supported by gvSIG. The WCS is a coverage server. It is different from WMS as this standard defines a map as a representation of geographic information in the shape of a digital image file which can be shown on a computer screen. The map does not include its own data but WCS, however, does provide its own data, which can subsequently be analysed. WCS therefore allows raster data to be analysed just as WFS allows vector data to be analysed.
1. The pull-down menu shows a list of WCS servers (you can add a different server if you don’t find the one you want).

2. Click on “Connect”. gvSIG connects to the server.

3. and 4. When the connection is made, a welcome message from the server appears, if this has been configured. If no welcome message appears, you can check whether you have successfully connected to the server if the “Next” button is enabled.

5.4.4.2 Accessing the service

Click on “Next” to start configuring the new WCS layer.

When you have accessed the service, a new group of tabs appears.
The first tab in the adding a WCS layer wizard is the information tab. It summarises the current configuration of the WCS request (service information, formats, spatial systems, layers which make up the request, etc.). This tab is updated as the properties of its request are changed, added or deleted.

5.4.4.3 Selecting “Coverages”
Select the coverage you wish to add to your gvSIG view. If you wish, you can choose a name for your layer in the “Coverage name” field.
5.4.4.4 Selecting the “Format”

You can choose the image format you wish to use to make the request and reference system (SRS) in the “Format” tab.
N.B. Tabs such as “Time” and “Parameters” are disabled in this case. Configuring these variables depends on the server chosen and the type of data it has access to.

5.4.4.5 Adding the layer to the view

As soon as the configuration is sufficient to place the request, the “Ok” button is enabled. If you click on this button, the new WCS layer will be added to the gvSIG view.
### 5.4.4.6 Modifying the layer’s properties

Once the layer has been added its properties can be modified. To do so, go to the Table of contents in your gvSIG view and right click on the WCS layer you wish to modify. The contextual menu of layer operations appears. Select “WCS Properties”.

The “Config WCS layer” dialogue window appears. This is similar to the wizard for creating the WMS layer and can be used to modify your configurations.

### 5.4.5 Adding a layer using the ArcIMS protocol

#### 5.4.5.1 Introduction to ArcIMS

In the proprietary software environment, ArcIMS (developed by Environmental Sciences Research Systems, ESRI) is probably the most widespread/popular widely used (Internet) cartographic server on the Internet thanks to the number of clients it supports (HTML, Java, ActiveX controls, ColdFusion...) and to its integration with other ESRI products. ArcIMS is currently one of the most important remote cartographic information providers. Although the protocol it uses does not comply with the Open Geospatial Consortium
(because it was created long beforehand), the gvSIG team believes that offering support for ArcIMS is important.

5.4.5.2 Connecting to image services

The extension can access image services offered by an ArcIMS server. This means that, just like a WMS server, gvSIG can request a series of layers from a remote server and receive a view rendered by the server containing the requested layers in a specific coordinate system (reprojecting if necessary) and in specific dimensions. In addition to displaying geographic information, the extension allows you to request information about the layers for a particular point via the gvSIG standard information button.

ArcIMS is slightly different in its philosophy from WMS. In WMS, the request is normally made by independent layers whilst in ArcIMS the request is global.

The steps required to request a layer from an ArcIMS server and to request information for a particular point are listed below.

5.4.5.3 Adding a layer using ArcIMS

Our example uses the ESRI ArcIMS server. Its URL is http://www.geographynetwork.com. This is the address a web browser requires to access the HTML visual display unit.

Before loading a layer from this server, the datum WGS84 in geodesic coordinates (code 4326) has to be set up previously as the view’s spatial system.

5.4.5.3.1 Connecting to the server

If the extension is loaded correctly, a new ArcIMS data source will appear in the “Add layer” dialogue box (fig. 1).
If the server has a standard configuration, simply indicate its address. gvSIG will try to find the servlet’s full address. If the servlet has a different path, you will have to write it into the dialogue box.

When the connection has successfully been made, the server version, its compilation number and a list of image and geometry services available are shown.

In our case, the full address is
The service can be selected from the list or can be written in directly.

Finally, if the "Override service list" check box is enabled, gvSIG will delete any catalogue that has already been downloaded and will request them again from the server.

![List of services available](image)

**Figure 2: List of services available**

### 5.4.5.3.2 Accessing the service

The next step is to select the ImageServer type service required by double clicking or selecting it and clicking on "Next". The dialogue box changes and an interface with two
tabs appears (fig. 3). The first tab shows the metainformation given by the server about the service’s geographic limits, the acronym of the language it has been written in, units of measurement, etc. It is a good idea to find out if a coordinate system has been defined in the service (using EPSG codes) as this can directly influence the requests made to the server, as Figure 3 shows.

N.B. If no coordinate system has been defined in the service, the extension will assume that it is the same coordinate system as the one we have defined for the view.
Figure 3: Metadata from the ArcIMS server

We can continue by clicking on "Next" or return to the previous dialogue by clicking on "Change service".
5.4.5.3 Selecting layers

The last dialogue box is the layer selection. We can define a name for the gvSIG layer or leave the default value (the service name) in this window. A box appears below with a list of the service layers in tree form. When the mouse is moved over the layers, information about these layers appears: extension, scale ranges, type of layer (raster or vector image) and if it is visible by default in the service (fig. 4).

![Figure 4: Metadata from a service layer](image-url)
We can view each layer’s ID via the “Show layer ID” check box. This check box is useful when there are layers whose descriptor is repeated. Therefore, the only way to distinguish between them is via an ID, which will always be unique. A combo box is also available to select the image format we wish to use to download the images. We can choose JPG format if our service works with raster images or one of the other remaining formats if we want the service to have a transparent background.

N.B. The transparency in 24-bit PNG images is not correctly displayed in gvSIG 0.6. This type of files will be supported in gvSIG 1.0.

The box with the layers selected for the service appears below. If you wish, you can add just some of the service layers and also reorganise them. This makes the service view totally personalised.

N.B. The configuration cannot be accepted until a layer has been added.

N.B. Multiple selections of service layers can be made by using the Control and CAPS keys.

5.4.5.3.4 Adding the layer to the view

When the “Ok” button in the dialogue box is pressed, a new layer appears in the view (fig. 5). If no layer has been added previously, the extension of the ArcIMS layer is shown, as per the standard gvSIG procedure.
It must be remembered that when the layer extension is shown, the layers that make up the chosen configuration may not appear and a blank or transparent image appears instead. If this occurs, use the scale control dialogue box (V. Information about scale limits section).

5.4.5.4 Points to remember about spatial reference systems

An ArcIMS server does not define the spatial reference systems it supports as opposed to the WMS specification. This means that a priori we do not have a list of EPSG codes that the map server can reproject. In short, ArcIMS can reproject to any coordinate system and leaves the responsibility of how the projections are used to the client.

Therefore, if our gvSIG view is defined in ED50 UTM zone 30 (EPSG:23030) and we request a global coverage service (stored for example in the geographic coordinates WGS84, which correspond to code 4326) the server will not be able to reproject the data correctly because we are using global coverage for a projection of a specific area of the Earth.
However, the procedure can be carried out in reverse. If we have a view in geographic coordinates (and thus global coverage), services defined in any coordinate system can be requested because the server will be able to transform the coordinates correctly.

In short, requests to the ArcIMS server must be made in the view's coordinate system and they cannot be requested in another coordinated system.

Moreover, as we mentioned above, if an ArcIMS server does not offer information about the coordinate system its data is in, the user will be responsible for setting up the correct coordinate system in the gvSIG view. Thus, if a user with a view in UTM adds a layer which is in geographic coordinates (even though the server does not show it), the service will be added correctly but will take the view to the geographic coordinates domain (in sexagesimal degrees).

An additional effect is that if the view uses different units of measurement from the server, the scale will not be shown correctly.

5.4.5.5 Modifying the layer's properties

The layers requested from the server can be modified via a dialogue box, which can be accessed from the layer's contextual menu (fig. 6) just like the WMS layers. This dialogue box is similar to the box used to load the layer, apart from the fact that the service cannot be changed.
5.4.5.6 Information about scale limits

The extension allows us to consult the layers' scale limits which make up the requested service via a dialogue box which can be maintained in the view during the session (fig. 7). This window shows the layers on the vertical axis and the different scale denominators on the horizontal axis via a logarithmic scale. This box is small on screen but can be enlarged to improve the difference between the scales.

The vector layers, raster layers and the layers that can be seen on the current scale (marked with a vertical line) in a darker colour and the layers we cannot see above or below the current scale are differentiated by different coloured bars (described in the window legend).
5.4.5.7 Attribute information requests

Attribute information requests about the elements for a particular point is one of gvSIG’s standard tools. Its functionality is also supported by the extension.

The WMS specification allows information about several layers to be requested from the server in one single query. This is different in ArcIMS. We need to make one server request per layer required.

This means that no requests for unloaded layers or unseen layers that are not visible on the current scale or layers whose extension is outside the view will be made. Even if all these layers are filtered, the information request usually takes longer than is desirable because of this intrinsic feature of ArcIMS.

When all the request responses have been recovered, the standard gvSIG attribute information dialogue appears with each of the layers (LAYER) which return information as a tree. If we click on a layer, its name and ID appear on the right (fig. 8).

Under this node, if we are talking about a vector layer, all the records or geometric elements the server has responded to appear, and give each one their corresponding attributes (FIELDS).
If it is a raster layer, such as an orthoimage or a digital terrain model, it returns the values for each of the bands (BAND) in the requested pixel colour, instead of records.

Figure 8: Displaying attribute information

5.4.5.8 Connecting to geometry services

The extension allows access to both ArcIMS image services and geometry services (Feature Services). This means that a server can be connected to and geometric entities (points, lines and polygons) and their attributes obtained. This is not dissimilar to WFS service access.

However, the variety of existing geometry services is much lower than the variety in the image server. There are two main reasons for this. On one hand, providing the public with vector cartography implies security problems because many bodies only want to offer the general public views and images. The vector data becomes either an internal product or must be paid for. On the other hand, this type of services generate much more traffic on the network and in the case of basic information servers could become a problem.

5.4.5.9 Adding a geometry layer

Loading a geometry layer is practically the same procedure as loading the image server as mentioned above (Accessing the service section and the following sections). In this case, the number of layers to be selected must be taken into account. If we wish to download all the layers offered by the service the response time will be very high.
The only difference between loading an image layer is that in this case we can choose whether we wish the layers to be downloaded as a group via a check box. This is useful for processing the vector layers as one layer when it needs to be moved and activated in the table of contents.

Unlike the image service, in which all the service’s layers appear as one unique layer in the gvSIG view, in this case each layer is downloaded separately and appears in the view grouped under the name defined in the connection dialogue.

### 5.4.5.10 ArcIMS symbols

Cartography symbols are configured in the server in one AXL extension file for both geometry and image services. We can divide symbol definition into two parts. On one hand, we can talk about the definition of the symbols themselves, i.e. how a geometric element, such as a line or polygon, should be presented. On the other hand, we can talk about the distribution of these symbols according to the cartographic display scale or to a specific theme attribute.

In ArcIMS terminology symbols are different from legends (SYMBOLS and RENDERERS).

### 5.4.5.11 Symbols

There are various types of symbols: raster fill symbols, gradient fill symbols, simple line symbol, etc. The extension adapts the majority of the symbols generated by ArcIMS. Table 1 shows the ArcIMS symbols and indicates whether they are supported by gvSIG.

<table>
<thead>
<tr>
<th>Label</th>
<th>description</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>CALLOUTMARKERSYMBOL</td>
<td>Balloon-type label</td>
<td>NO</td>
</tr>
<tr>
<td>CHARTSYMBOL</td>
<td>Pie chart symbol</td>
<td>NO</td>
</tr>
<tr>
<td>GRADIENTFILLSYMBOL</td>
<td>Fill in with gradient</td>
<td>NO</td>
</tr>
<tr>
<td>RASTERFILLSYMBOL</td>
<td>Fill with raster pattern</td>
<td>YES</td>
</tr>
<tr>
<td>RASTERMARKERSYMBOL</td>
<td>Point symbol using pictogram</td>
<td>YES</td>
</tr>
<tr>
<td>RASTERSHIELDSYMBOL</td>
<td>Customised point symbol for US roads</td>
<td>NO</td>
</tr>
<tr>
<td>SIMPLELINESYMBOL</td>
<td>Simple line</td>
<td>YES</td>
</tr>
<tr>
<td>SIMPELMARKERSYMBOL</td>
<td>Point</td>
<td>YES</td>
</tr>
</tbody>
</table>
In general, the most common symbols have been successfully “transferred”. Some of the symbols cannot be obtained directly from gvSIG (at least in the current version), such as the raster fill symbol or they need to be “adjusted” such as the different types of lines. This means that a raster fill symbol is not a symbol that can be defined by the gvSIG user interface, but it can be defined by programming.

### 5.4.5.12 Legends

gvSIG supports the most common types of legends: unique value and range and value themes as well as the scale-range control over the whole layer. ArcIMS goes much further in its configuration. It can generate much more complicated legends in which symbols can be grouped together, scale-range controls can be established for labels and symbols and different labelling based on an attribute can be shown (as though it were a value theme for labelling).

This group of legends can generate very complex symbols for a layer in the end. The current implementation status of the gvSIG symbols needs to be simplified to reach a compromise to recover the symbols that best represent the layer as a whole.

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GROUPRENDERER</td>
<td>Legend which groups others together</td>
</tr>
<tr>
<td>SCALEDEPENDENTRENDERER</td>
<td>Scale dependent legend</td>
</tr>
<tr>
<td>SIMPLELABELRENDERER</td>
<td>Labelling layer legend</td>
</tr>
<tr>
<td>SIMPLERENDERER</td>
<td>Unique value layer legend</td>
</tr>
<tr>
<td>VALUEMAPRENDERER</td>
<td>Value and range themes</td>
</tr>
<tr>
<td>VALUEMAPLABELRENDERER</td>
<td>Labelling themes</td>
</tr>
</tbody>
</table>

Table 2: ArcXML legend definition labels
When a GROUPRENDERER is found, the symbol ArcIMS draws first is always chosen. Thus, in the case of the typical motorway symbol for which a thick red line is drawn and a thinner yellow line is drawn over it, gvSIG will only show the red line with its specific thickness.

If a scale dependent legend is discovered during a symbol analysis, this is always chosen. If more than one is discovered, the one with the greatest detail is chosen. For example, in ArcIMS we can have a layer with simple road symbols (only main roads are drawn) on a 1:250000 scale and based on this a different theme is shown with all types of roads (paths, tracks, roads, etc.). In this case, gvSIG will show this last theme as it is the most detailed.

If a labelling legend is discovered during a symbol analysis, it will be saved in a different place and will be assigned to the selected definitive legend. In the case of the VALUEMAPLABELRENDERER label, only the legend of the first processed value will be obtained as a label symbol. The rest will be rejected.

In short, it is obvious that the failure to adapt the legends for gvSIG is a simplification process in which different legend and symbol definitions must be rejected to obtain a legend which is similar to the original as far as possible. It is to be expected that the gvSIG symbol definition will improve considerably so that it can support a larger group of cases in the future.

5.4.5.13 Working with the layer

Working with the layer is similar to any other vector layer, as long as we remember that access times may be relatively high. The layer attribute table can be consulted, in which case the records will be downloaded successively as we display them.

If we wish to change the table symbols to show a unique value or range theme we must wait as gvSIG requests the complete table for these operations. On the other hand, the downloading of attributes is only carried out once per layer and session and therefore, this wait only occurs in the first operation.

In general, if our ArcIMS server is in an Intranet, it will be relatively fast to handle, but if we wish to access remote services we may be faced with considerable response times.

The main feature to bear in mind when working with an ArcIMS vector layer is that the geometries available at any given time are only the ones displayed. This is because we can connect to huge layers but only the visible geometries are downloaded. As far as
gvSIG is concerned, the geometries shown on the screen are the only ones available and thus, if we export the view to a shapefile for example, are only a part of the layer.

Finally, we need to remember that to speed up the geometry downloads they are simplified to the viewing scale in use at any given time. This drastically reduces the amount of information downloaded as only the geometries that can actually be "drawn" are displayed in the view.

Loading a geometry layer is practically the same procedure as loading the image server as mentioned above (Accessing the service section and the following sections). In this case, the number of layers to be selected must be taken into account. If we wish to download all the layers offered by the service the response time will be very high.

Unlike the image service, in which all the service's layers appear as one unique layer in the gvSIG view, in this case each layer is downloaded separately and appear in the view grouped under the name defined in the connection dialogue.

After a few seconds the layers appear individually but are grouped under a layer with the name we have defined for it.

The layer symbols are established at random. A pending feature is to recover the service symbols and configure them by default so that gvSIG can display the cartography as similarly as possible to how it was established by the service administrator.

### 5.4.6 Adding orthophotos using the ECWP protocol

If you wish to add an orthophoto to gvSIG using the ECWP protocol, first open a view and click on the “Add layer” button.

Click on the “Add” button in the dialogue box. A file browser window appears.
Choose the “gvSIG Image Driver” option from the “Files of type” pull-down menu.

Write the URL of the file you wish to load as follows in “File name”:

ecwp://server address/path of the file you wish to add.

For example:

ecwp://raster.alava.net/datos/ecw/Ortofoto_5000.ecw
try.ecw

When you have input the data, click on “Open”.

The orthophoto will be added to the layer list.
Select the new added layer and click on “Ok”.
The image will be added to the view.
5.5 Table of contents (ToC)

The “Table of Contents” is the area used to list the different layers which make up the cartographic information.

A check box next to each layer indicates whether it is "visible" or not.

Remember that an active layer is not the same as a "visible" layer. When a layer is “active” it is highlighted compared to the other layers included in the “Table of contents”. When a layer is activated, gvSIG is notified that the elements of this layer can be worked with.
The order of appearance of the layers in the “View” is important because it ties in with the display order. Layers made up of text elements, points and lines are placed at the top whilst the polygonal layers and images which make up the background of the view are placed at the bottom.

To move the layers in the ToC, place the cursor over them, left click on the mouse and drag the layer to the required position.

The layers in the ToC can also be selected by using the Control and CAPS keys.

5.5.1 Grouping and ungrouping layers

From version 0.4 onwards, gvSIG allows several layers to be grouped together. This is useful because it means a large number of layers can be kept in the ToC without taking up a lot of space.

This option also allows operations to be carried out on all the layers that make up a group at the same time.

To group a set of layers together, select the layers, click and hold down the CAPS key and right click on the mouse on any of the layers and select the “Group layers” option.
The following dialogue window appears and a name for the new grouping can be input.

![Dialogue window for renaming grouping]

When the name of the new grouping has been input, it appears in the ToC as shown below.
To undo a grouping, right click on the grouping so that the contextual menu appears. Select the “Ungroup layers” option.

5.6 Copying layers in gvSIG

You can also use gvSIG to copy documents and create copies of the layers you are working with in your view.

Firstly, select the layer in the ToC and right click on it.

A new menu appears. Select the “Copy” option.
You can paste the layer you wish to copy in the same view as the one you are working with or in a different view, either in the same project or in a different one.

N.B.: Remember that currently if you modify the layer, these changes will be reflected in all the copies.

If you wish to “Paste” the layer, right click on the point you wish to paste the new copy and select the “Paste” option.

N.B.: You can use this method when working with layer groups.

If you create a layer group, place the mouse pointer over the group name and go to the “Copy” option, you can “Paste” the whole layer group in the same way as you would with an individual layer.
5.7 Creating a new layer

gvSIG can create a new layer in the following formats: shp, dxf and postgis. The tool can be accessed from the “View / New Layer” menu.

<table>
<thead>
<tr>
<th>Vista</th>
<th>Ayuda</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exportar</td>
<td></td>
</tr>
<tr>
<td>Importar</td>
<td></td>
</tr>
<tr>
<td>Nueva capa</td>
<td>Nuevo SHP</td>
</tr>
<tr>
<td>Añadir capa</td>
<td>Nuevo DXF</td>
</tr>
<tr>
<td>Propiedades</td>
<td>Nuevo postgis</td>
</tr>
</tbody>
</table>
5.7.1 Creating a new SHP file

Select the “New SHP” option opens the wizard which will help you create the new layer.

The first window of the wizard allows you to choose the name you wish the new .shp file to appear with in the ToC, in addition to the geometry type associated with it.
The second window of the wizard allows you to add all the fields you wish to the attribute table associated with the layer and to define some of the properties of these fields.

To add fields to the table, click on “Add field”. One field is added every time you click on this button.

If you wish to delete any of the fields created, simply select the field and click on the “Delete Field” button.

You can edit the rest of the properties from the attribute table in which the fields are defined.

- **Field name**: Place the cursor over the field name (“New field” by default) and write the new name. The maximum number of characters allowed for the field name is 10.

- **4. Field type**: Place the cursor over any of the files in the “Type” field. A pull-down menu appears in which the type of field you wish to create can be selected.

  - **BOOLEAN**: Boolean type data admits “true” or “false” values.
  - **DATE**: This allows you to create a field which includes dates. The maximum number of characters allowed is 8.
  - **INTEGER** and **DOUBLE** are two number type fields. The former is for whole numbers and the latter for decimal values.
  - **STRING**: This is an alphanumeric field type. The maximum number of characters allowed is 254.
1. Field length: This allows you to set the maximum number of characters for the field created (at present, this only applies to String-type fields).

Once the structure of the table associated with the shape file has been determined, click on “Next”.

You can save the file in the new window and choose the Reference System for the view the new layer is going to be inserted into by clicking on the button to the right of “Current Projection”.
If other layers have been inserted in the view, this button will be disabled since the view already has a selected reference system.

To save the new layer, indicate the file path to save the file in the text box.

You can also open the search dialogue box to select the file path the new shape file will be
saved in. To do so, click on the button to the right of the text box. Write the name for the new layer (remember that this name will appear in the source file of the shape file and that it may be different to the name which appears in the ToC) and click on the “Save” button.

When you have finished creating a new SHP file, it will be added to the ToC. In addition, the editing tools will be activated to allow you to create the elements of the new layer.

5.7.2 Creating a new DXF file

The procedure to create a new DXF file is similar to that used to create a new SHP file, as described in the previous section. This tool can be accessed from the “View/New layer/New dxf” menu.
If this tool is selected, the wizard will open a window allowing you to select a path for the file which is going to create a reference system for the view.

5.7.3 Creating a new PostGIS file

If you wish to create a new PostGIS file, go to the menu “View/New layer/New PostGIS”.

The initial steps to create a new PostGIS file are similar to those followed in the section on creating a new Shape file.

The difference lies in the way the new layer is saved, as this is entered into a PostGIS database.

Fill in the fields which apply to your connection and click on “Finish”.

5.8 Adding an Event layer

A new layer can be created from a table in gvSIG by using “Add event layer”.

There are two ways to do this: you can add a table to the project or you can work with a table associated with one of the layers in the view in which you are working at a particular time.
5.8.1 Adding an event layer from a table

Firstly, the table needs to be loaded. To do so, go to the gvSIG “Project manager” and select "Tables" in document types. Then click on "New".

A search dialogue opens to add the table you require. Click on "Add".
A dialogue box appears in which you can choose two types of data sources: dbf and csv.

When you have found the table you require, select it and click on “Open”. gvSIG automatically returns to the "New table" window and adds the table you require to create the event layer in the text box.
Click on “Ok” to finish the process.
When the table has been added, a view must be active to create its corresponding event layer and load it. If no view is active, you can return to the “Project manager” and add one or create a new blank one. When you have activated this view, go to the “Add event layer” by using the corresponding button in the tool bar:

A window with three pull-down menu bars appears.
We can select the table we need to add the new layer from the first pull-down menu bar.
Then, we can select the table fields which will become the X and Y values.

If you click on “Ok”, a new points layer will appear based on the coordinates contained in
5.8.2 Adding an event layer from a table associated with a layer in the view

If you wish to work with a table associated to the layers in the view, you will firstly have to activate the attribute table of this layer. To do so, click on the following button in the tool bar:

If you click on “Add event layer”
you will see that the table has been added.

5.9 Layer properties
You can access the active layer's properties from its contextual menu (right click on the layer).

5.9.1 Vector layer

5.9.1.1 Changing colours
Go to the layer's contextual menu and click on the “Change colour” option. A window opens in which you can select the colour you wish to view the layer with.

<table>
<thead>
<tr>
<th>Change color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename</td>
</tr>
<tr>
<td>Properties</td>
</tr>
<tr>
<td>Zoom to layer</td>
</tr>
<tr>
<td>Delete layer</td>
</tr>
<tr>
<td>Reload</td>
</tr>
<tr>
<td>Group layers</td>
</tr>
<tr>
<td>Bring to front</td>
</tr>
<tr>
<td>Copy</td>
</tr>
<tr>
<td>Cut</td>
</tr>
<tr>
<td>Paste</td>
</tr>
</tbody>
</table>

There are three ways to select the colour depending on the window tab you select.

Swatches
Selecting the colour from the “Swatches” tab is relatively easy. Place the mouse pointer over the desired colour on the palette and left click.

The colours you have used recently appear in the “Recent” palette.

**HSB**

A colour can be defined by its hue, brightness and saturation values. Any colour can be identified by values of these three variables. Black is obtained when there is an absence of light. Grey is obtained when the saturation is low (high light interference or mixture). White is the brightest colour of the greys (maximum frequency of different length waves).

This colour representation model is called HSB (Hue, Saturation, Brightness).

gvSIG has a colour selection window based on the HSB and RGB system which allows colour to be selected via HSB attributes and also obtain RGB values to reproduce them on the screen.

The following table shows the **Hue** variations which are represented on the horizontal axis of the square. The **Saturation** variations are represented on the vertical axis and the **Brightness** variations are shown on the side bar.
You can set one of the colour values by clicking on the corresponding check box. Click on the square area to define the values for the other 2 parameters. Slide the horizontal bar to set the value for the parameter marked with the check box. When you have defined the colour you require, click on “Ok”.

**RGB**

RGB colour uses an additive model, in which the primary colours (red, green and blue) are combined to make other colours.
In this case, each primary colour is coded with a byte, so that each value is in a natural numbers \([0, 255]\) interval. Thus, the RGB combination for black is \(R=0, G=0, B=0\) and \(R=255, G=255, B=255\) for white.

### 5.9.1.2 Renaming

If you wish to rename the selected layer, right click on the layer and go to the "Rename" option.

A new window appears:

![Rename window](image)

Write the new name in the text field and click on “Ok”.
N.B.: When you do this, the layer name changes in the ToC, but the file name is not changed.

5.9.1.3 Properties
Right click on the selected layer in the ToC to access the properties window.

When you click on the “Properties” option, a new dialogue box opens. This can be used to edit some properties.
The layer name can be changed by writing the new name in the text field in the “General” tab.

5.9.1.3.1 Using the spatial index

If you mark the “Use spatial index” check box, a spatial index will be created which makes the layer loaded in the view appear more quickly. This is because the view is loaded using this index.

If there are write permissions, a .qix file is created with the same name as the layer it is associated with in the layer’s original directory. If there are no write permissions, the file will be created in the user’s temporary file directory.

5.9.1.3.2 Scale range
A viewing scale range (maximum and minimum) can be set in the properties window.

### 5.9.1.3.3 File extension and path

The file extension and path are shown in the actual properties section.

### 5.9.1.3.4 Hyperlink

A link can be set up between a text, html or image file and a layer element in the properties window.

To provide a better idea of how the tool works, let us look at the following example. The aim is to link the image *torreelectrica.jpg* to a specific element:

- Activate the view in the ToC.
  - Change the layer into editing mode (“Layer” menu then “Start edition”).
  - Open the table of attributes and edit the record you wish to create the link to. Write the path of the file you wish to link without its extension. Press “Enter” to save the modification made in the table.
Go to the “Hyperlink” table in the layer properties window and select the field the record is located in which will be used to create the hyperlink. Write the extension of the file you wish to link and whether it is an image file (gif, jpg, png) or a text file (at present gvSIG can only link plain text files (txt, rtf...). Html files can also be linked. In this case, write html in the “Extension” text box and select “Link to text files”.

When all the requirements have been selected, click on “Apply” and then on “Ok”.

Then go the view tool bar and click on the hyperlink button.

Select the view element that corresponds to the record which has the associated link and place the cursor over it. Click on the element. A window appears with the linked file.
5.9.1.4 Legend editor

This tool can be used to carry out theme mapping relatively easily.
To symbolise or represent the element data or variables in a layer, you can choose the most suitable colour, pattern, etc. for each one.
Go to the “Properties” menu (right click on the layer) to edit the legend symbol properties.

A new window appears. Click on the “Symbols” tab.
Use this tab to define the legend type you wish to use to represent the layer data more specifically.

You can choose between the following:

- **Unique symbols**: This is gvSIG’s default legend type and represents all the elements of a layer using the same symbol. It is useful if you need to show the location of a layer over and above any of its other attributes.

- **Unique values**: Each record can be represented by a unique symbol according to the value it has in a particular field in the table of attributes. It is the most effective method to show categorical data, such as towns, types of land, etc.

- **Intervals**: This type of legend represents the layer elements using a range of colours. The intervals or graduated colours are mainly used to represent numerical data which increase progressively or have a range of values, such as population, temperature, etc.

- **Labelling**: Texts or labels can be automatically added to the view according to the values each element has in a particular field in its table of attributes.

The options shown in the symbols menu vary according to the type of layer (point, line or polygon layer).

The options available for a polygon layer, which has the most configuration tools, are...
shown below.
A legend can be saved or loaded (recovered) at any time.

5.9.1.4.1  Unique symbols

The following symbol configuration options are available:

- **Fill**: Allows the fill colour to be selected.
- **Fill type**: Allows the fill pattern to be selected.
- **Line**: Allows the line colour to be selected.
- **Line style**: Allows the style of the line to be selected.
- **Synchronising line and fill colours**.
- **Line width**: Allows the width of the line to be defined.
- **Transparency**: Gives the elements a degree of transparency so that polygon layers can be superimposed and yet still viewed.
Click on the “Symbol type” pull-down menu and select the symbol you wish the layer to be displayed with. Select the colour and set the size of the symbol you have chosen.

Click on “Apply” to see a preview of the set configuration.

Click on “Ok” if you wish to make this configuration permanent. In point-type shape layers you can use the “Unique symbol” option in the “Symbols” tab to define the symbol type, the colour and point size you wish this layer to be displayed with.

5.9.1.4.2 Unique values
The following symbol configuration options are available:

- **Classification field**: A pull-down menu appears in which you can select the layer’s table of attributes’ field which contains the data to be sorted.

- **Add all/Add**: Once you have selected the “Classification field”, click on the “Add all” button to see all the different values. These values have all been assigned a different symbol (colour). Click on these symbols to modify them. By default, the label (the name which appears in the legend) is similar to the value it has in the field. You can include new values to the list by pressing the “Add” button.

- **Remove all/Remove**: This allows all (Remove all) or some (Remove) of the elements in the legend to be removed.

- **Labels**: Left click on any of the “Label” “cells” to modify the name they will have in the legend.

5.9.1.4.3  **Intervals**
- **Classification field**: A pull-down menu appears in which you can select the layer’s table of attributes’ field, which contains the data to be sorted. The field must be numerical because this is a gradual classification (by ranges of values).

- **Number of Intervals**: This must indicate the number of ranges or intervals that define its classification.

- **Start colour and End colour**: Select the colours to be graduated. The start colour is for the lowest values and the end colour is for the highest values.

- **Computing intervals**: When you have defined the previous options, click on the “Compute intervals” button to see the legend’s end result. The symbols and the labels which appear by default can be modified by clicking on them, as in the previous cases.

- **Add**: New ranges can be added to the computed intervals.

- **Remove all / Remove**: This allows all (Remove all) or some (Remove) of the elements in the legend to be removed.

- **Type of intervals**: From gvSIG version 0.4 onwards, you can specify the interval type you wish to divide the information into in order to represent it. You can choose between the following options:
  - Equal intervals: The number of intervals are specified and the sample is
divided into this number of equal intervals.

- **Natural intervals**: The number of intervals is specified and the sample is divided into this number of intervals according to the Jenk method of optimising the natural breaks for the intervals.

- **Quantile intervals**: The number of intervals is specified and the sample is divided into this number of intervals but the values are grouped together according to their order number.

### 5.9.1.4.4 Labelling

- **Enable labelling**: Activate the check box to make the labelling visible in the view.

- **Labelling field**: This is a pull-down menu which allows you to choose the layer’s table of attributes’ field, which contains the values to be shown as labels.

- **Text height field**: This allows you to choose the layer’s table of attributes field which contains the values to be used for the label height.

- **Text rotation field**: This allows you to choose the table of attributes field which indicates the label rotation angle.

- **Text colour**: Allows the text colour to be selected.
• **Font**: Allows the type of font to be selected.

• **Constant text height**: Select the units (metres or pixels) and the text size. If you select “pixels”, the apparent text size will remain constant, even if you change the viewing scale; if you select “metres”, the text height on the display will vary according to the scale you are working in but will remain constant in geographic units.

### 5.9.2 Raster layer

#### 5.9.2.1 Raster properties

Right click on a raster layer and select the "Raster properties" option. This opens a menu in which we can carry out various operations on the raster layer.

![Raster properties menu](image)

This menu is divided into five tabs:
• **Information**: Provides general information about the raster layer, the file path, the number of bands, the pixel dimensions, the file format, the data type and the geographic coordinates of the corners.

• **Bands**: Provides tools to change the mode in which each image band is viewed.

• **Transparency**: Provides tools to change the transparency levels that can be applied to a raster layer.

• **Enhance**: Provides a tool to enhance the raster layer.

• **Pansharpening**: Provides a tool to increase the satellite image resolution if the panchromatic band for these images is available.

In the “Bands” tab you can make compositions using the different bands in a raster image. You can also add more bands from other files. This is useful when working with Landsat-type images, in which each band is delivered in a different file.
In addition to the “Transparency” option in gvSIG version 0.3, which is now called “opacity”, and which indicates the “occlusion” percentage of this layer over the previous ones, there is now a transparency option which allows the indicated colour groups (RGB) to be completely transparent. This is very useful to eliminate visual artefacts as a result of missing data in orthophotos or satellite images and to remove borders in an image mosaic.

To access the options, click on the corresponding “Activate” check boxes.
The “Enhance” tab can be used to modify the image brightness, contrast and enhancement. This last option is essential to be able to view 16-bits per band images correctly.

The “Pansharpening” tab can be used to increase the resolution of satellite images if the
panchromatic band for these images is available.

N.B.: If the image bands are in different files, they must be added to the layer using the “Bands” tab.

Use the “Bands” tab to find the best band combination for the view. In this section, you can load the image which corresponds to the panchromatic band but you must not select it to be visualised.

When the bands have been loaded, you can carry out the pansharpening. Go to the “Pansharpening” tab and activate it by clicking on the “Activate Pansharpening” check box. Select the panchromatic band with which the pansharpening is to be carried out from the band list. Finally, select an algorithm to be applied. There are two methods available, “Brovey” and “HSL”. Both of them have a slide bar control to carry out adjustments.

- In “Brovey” the general brightness of the resulting image is increased or decreased.
- In “HSL” the coefficient which is added to the brightness taken from the pansharpening band varies before it is replaced in the output image. This coefficient can vary between 0.15 and 0.5. When modified, the obtained result also influences the output image’s general brightness.
If you click on the "Apply" or “Ok” buttons, the pansharpening will be applied on the image in the view, thus increasing the image resolution.

5.10 Navigating around / Exploring the view

There are several tools you can use to navigate around the map. These are basically zooms and panning.
5.10.1 Zooms and panning

You can activate these tools by clicking on the "View" menu and then on "Navigation".

or by using the button bar which is quicker.

**Zoom in**: Enlarges a particular area of the view.

![Zoom in icon]

**Zoom out**: Reduces a particular area of the view.

![Zoom out icon]

**Previous zoom**: Goes back to the previous zoom used.

![Previous zoom icon]
**Full extent:** Full zoom of the total area included in all the layers of the view.

**Panning:** This allows you to change the view zoom by dragging the viewing field all over the view with the mouse. Click and hold down the left button of the mouse then move the mouse in the direction you require.

**Zoom to selection:** Full zoom of the total area of all the selected elements.

**Zoom to layer:** To zoom to the layer, right click on the selected layer in the ToC, or click on the “Zoom to layer” option in the contextual menu.

![Contextual menu](image)

### 5.10.2 Zoom manager

You can access the “Zoom manager” from the tool bar by clicking on the following button:
or from the “View” menu, then “Navigation” and “Zoom manager”.
By clicking on the “Zoom manager” you can save a zoom so that you can go back to it at a later stage.
This tool can be used to name the current zoom of the view with the text bar which appears in the window.
Click on “Save” and the zoom currently in the view will automatically be added to the “Zoom manager” text box.
You can create and save as many zooms as you wish. Use the “Select” and “Delete” buttons to manage your working areas.

5.11 Configuring the locator map
The locator is a general map which is displayed in the bottom left hand corner of the view’s window. It is used to show the working area (main window zoom).
Click on “View” in the menu bar and select “Configure locator map”.
A window appears in which we can add layers (we can add the same types of layers as in the view) which will make up part of the locator map. This window can also be used to remove layers or edit the layers’ legends.

When you click on the “Add layer” button, the following window appears
This new function allows the layer loaded in the locator map to be reprojected. To do this, click on the button next to “Current projection when you have selected the layer you wish to load in the locator map.

In the following window, select the reference system you wish the layer to have in the locator map and click on “Finish” for the changes to take effect.
5.12 Request tools

5.12.1 Information tool

You can access the information tool via the following button in the tool bar

or by going to the “View” menu bar, to “Query” and then to “Information”. The “Information Tool” is used to obtain information about the map elements. When you click on an element using this tool, gvSIG shows the selected element’s attributes in a dialogue window. However, the layer of the element you wish to identify must previously be activated.
5.12.2 Measuring areas

You can access this tool via the following button

or by going to the “View” menu and then to “Query” and “Measure area”.

This tool works in much the same way as “Measure distances”. Click on the point that represents the first polygon vertex that defines the area to be measured. Move the mouse and click on each new vertex until you reach the last one, then double click so that the application knows there are no more.

The calculation for the measured area appears at the bottom right of the view window.
5.12.3 Measuring distances

This tool provides information about the distance between two points. You can also access the tool by going to the “View” menu, to “Query” and then to “Measure distances”.

Firstly, make sure you have correctly defined the units of measurement (metres by default). Remember that the units can be defined in the “Project manager” in the view properties or from the “View” menu and the “Properties” when working in a view.

You can use the measure distance tool by clicking on the mouse at the source point and dragging it to the destination point. You can take as many measurements as you like. Double click on the last one to finish.

The calculation for the measured distance appears at the bottom of the view window. Both the distance of the last measured segment and the total distance are shown.

| Metros | X = 851,293.88 | Y = 4,519,393.36 | P:302,982.37 | A:5,698,409,532.97 |

5.13 Selecting elements

You can select one or several elements or items by making either a graphic request or an alphanumeric request.

The selected data are shown in the view in the colour you have configured (by default this is yellow).
You can access the different ways of selecting elements by going to the tool bar or by going to the “View” menu and then to “Selection” as long as the layer you wish to work with has already been activated in the ToC.
5.13.1 Selecting by point

This is the basic selection method and consists of clicking on the element you wish to select.

5.13.2 Selecting by rectangle

This allows you to select the elements which are partly or wholly located inside a rectangle.

To define the rectangle, place the cursor point over the position you wish to start to draw the rectangle in, left click on the mouse and hold the button down until you have defined the area you wish to select.

5.13.3 Selecting by polygon

This allows you to select elements which are partly or wholly located inside a polygon. To define this polygon, place the cursor in the part of the view you wish to draw the selection polygon in. Left click on the mouse in the view to add the polygon vertices. When you have finished, double click on the mouse. All the elements which are located inside the polygon or which intersect with any of its sides will be selected.

5.13.4 Selecting by layer

You can access this tool by going to the “View” menu then to “Selection” and “Selection by
layer”. It allows you to select elements in the active layer based on the selection made in another layer.

The options available using this tool are:

2. **New set**: This creates a new selection set.

3. **Add to set**: This creates a selection set based on the previous request and the current request.

4. **Select from set**: This creates a selection set from what has already been selected, the current selection request is extracted from the previous one.

An example of how to use this tool consists of selecting the cities and towns of the Valencian Region whose municipal boundaries are affected by flood risks.

We start with a shape file with the areas of the provinces in the Valencian Region which are subject to flood risks.

Then the layer corresponding to all the cities and towns in the Valencian Region is added.

Pre-select the full flood risk layer.

We go to the “Selection by layer” tool. Use the “Intersect with” option in the first pull-down menu, “Select items from active layers that are:...”. Use the “riesgo_inundación_25000_completo” option in the second pull-down menu “Selected items of a layer”.

We can now click on “New set” and the layer with the new selection will appear.
5.13.5 Selecting by attributes

You can access this tool using the following button:

![Filter tool button]

gvSIG allows selections to be made using requests (filters).

Selecting elements by attributes allows you to define exactly what you want to select, including several attributes, operators and calculations.

Requests can be made using logical operators, such as “equals” “more than” “different from”, etc.

If you press the “Filter” button in the tool bar, a dialogue window will appear to define your request.

![Filter dialogue window]

PROVINCIAS = 'Valencia'

New set  Add to set  Select from set
3. **Fields**: Double click on the field you wish to add to your request from the “Fields” list in the layer.

4. **Logical operators**: These allow you to insert a logical expression into your request by clicking on them.

5. **Values**: This shows a list with the different values the selected field has. If you wish to add a value to the request, double click on it.

6. **Request**: This is the window which represents the request to be made. You can write here directly.

7. **Selection buttons**: These buttons make the request using:
   - “New set” (deletes any previous selections).
   - “Add to set” (adds the elements selected by the request to the existing elements).
   - “Select from set” (makes the request from the selected elements).

### 5.13.6 Inverting the selection

When you have made your selection, you can click on the following button in the tool bar or you can go to the “View” menu then to “Select” and “Invert selection”
and invert the previous selection as shown below.

![Image of selection inversion]

### 5.13.7 Clearing selection

If you click on this button, the selected element set will once again become empty. You can also access this option by going to the “Layer” menu then to “Clear selection”.

![Layer menu with Clear selection option highlighted]

### 5.14 Locate by attribute

This tool allows you to zoom in on areas of a layer by specifying the value of a particular attribute.

You can access this tool by clicking on the button
or by going to the “View” menu then to “Locate by attribute”.

When the tool is selected, the following window appears

You will find all the layers loaded in the ToC in the “Layer” pull down menu. The fields
associated with the chosen layer are included in the “Field” pull down menu. The data included in the selected field appears in the “Value” pull down menu.

If you mark the “Open with the view” check box and decide to close the view, the “Locate by attribute” window will appear the next time you open the view.

When you have made the selection, click on the “Zoom” button and the chosen area will be shown in the view.
5.15 Centring the view on a point

This tool allows you to locate a point in the view by its coordinates and to centre the view on this point.

You can also access the tool by going to the “View” menu then to “Centre view on a point”.

© 2007 Conselleria de Infraestructuras y Transporte
When you have accessed the tool, a dialogue box will appear in which you can input the required coordinates and select the point colour.

When you click on the "Ok" button, the view centres on this point and the information window that corresponds to this point appears.

5.16 Catalogue. Searching for geodata

The catalogue service allows you to search for geographic information on the Internet.
gvSIG offers a user-friendly interface which allows you to find geodata and load it in the view, as long as the nature of the data allows this.

### 5.16.1 Connecting to a server

Before you can carry out a search, you will need to connect to a catalogue server. To access the wizard, you will first need to open a view and then click on the following button:

The first window of the catalogue opens. Input the required parameters to connect to a server. These include:

- The server address.
- The server protocol, which in the case of the catalogue can be:
  - Z39.50: General information retrieval protocol.
  - SRU/SRW: Variant of Z39.50.
  - CSW: Catalogue protocol defined by the OGC in the “Catalogue Interface 2.0” specification.
- Data base name: You only need to indicate the data base you wish to connect to in the case of z39.50. If no value is input you will connect to the default data base.

Then click on the “Connect” button. If the connection is made and the server supports the
specified protocol, a new window will appear to start the search.

5.16.2 Searching

To carry out a search, you need to fill in the fields that appear in the following form.

Click on the button and the window will drop down to show more fields which will allow you to carry out an advanced search. The fields you can search in are set by the server. This means that some of the search fields in this form may have no effect in some servers.
If you change the view zoom, the new coordinates will be reflected in this form. If you wish to restrict the search area enable the corresponding check box.

Then click on “Search” and wait for the search to be carried out.

**5.16.3 Viewing the results**

If the search has been successful, a new window containing the search results will open. Use the “Previous” and “Next” buttons to see each of the results obtained.
The left-hand side of the window shows information about the metadata obtained. If you wish to see all the information, click on the "Description" button. You will also be able to see a miniature image at all times, metadata permitting.

If the metadata has any geodata associated to it, the “Add layer” button will be enabled. gvSIG can currently recognise different types of associated resources, such as WMS, WCS, Postgis tables and web pages. If you click on this button, a new window will be opened and will show all the resources the application has been able to find.
If you click on a WMS, WCS or Postgis type resource, the new layer will automatically be loaded in gvSIG. If the resource is a web page, for example, the operating system’s default browser.

5.17 Gazetteer

A gazetteer is a data set in which a link is established between a toponym and its geographic coordinates.

gvSIG has a catalogue client which allows you to search by toponyms and centre the view on a specific point.

5.17.1 Connecting to a server

Create a view first and open it. The following button will appear automatically in the gvSIG tool bar.

Click on the button. A wizard opens to help you to carry out a search. The parameters to be input are:

- The server address.
- The server protocol, which in the case of the gazetteer can be:
  - WFS-G: Toponym search protocol defined by the OGC.
  - WFS: Although this protocol was created with a different purpose in mind, it
can be used for a toponym search, as long as it has a text attribute in one of the tables. This protocol also allows you to carry out a “Feature” search in any other field, but not necessarily a text attribute.

- **ADL**: Protocol specified by the Alexandria Digital Library.
- **IDEC/SOAP**: Protocol that uses the Catalanian Cartographic Institute (ICC) gazetteer web service.

When you have input all the parameters, click on the "Connect" button and wait until the server is found and accepts the specified protocol. If it is accepted, a new window will appear to start the search. If not, an error message will appear.

### 5.17.2 Searching

To carry out a search, you will need to fill in the criteria that appear in the following form. You can see the simplified form or carry out an advanced search by clicking on the button in the top right hand corner. This drops down the window.
If you change the view zoom, the new coordinates will be reflected in this form. If you wish to restrict the search area activate the corresponding check box.

There are also three options in the “Aspect set up” box which you can use to set up the search view:

- **Zoom to search**: This puts the toponym found in the centre of the gvSIG view.
- **Delete old searches**: This deletes all the texts found in the previous searches from the view.
- **Draw result**: This draws a point and a text label in the place the resulting toponym has been found.

When you have filled in all the fields in the form, click on “Search” and wait for the search to be carried out.
5.17.3 Viewing the results

A new window containing the search results will open. Use the “Previous” and “Next” buttons to move through the different pages of results.

Finally, select the toponym required and click on “Localise”. The gvSIG view will centre on the point the toponym is located in.

5.18 Deleting layers

To permanently remove the active layers from the view, right click on the layer in the ToC and select the “Delete layer” option.
A confirmation dialogue appears.

5.19 Exporting layers

5.19.1 Introduction

The “Export to...” tool allows you to save the elements selected in a layer in a different format. If no elements have been selected the whole layer will be exported.

At the time of going to press the export formats supported by gvSIG were shape, dxf, and postgis and gml.

5.19.2 Exporting a shape

Select the “Layer” option from the menu bar then go to “Export to.../shp”.
If you have selected elements in the layer to be exported, gvSIG will tell you how many elements are going to be exported and will ask for confirmation before carrying out the operation.

If you continue with the operation, a dialogue box will appear in which you will be asked to select the file the new shape is to be saved in.

When you have accepted, a new message will appear asking whether you wish to insert
the new layer into the view.

If you click on “Yes”, the layer will be added to the active view.

5.19.3 Exporting to dxf

Select the “Layer” option from the menu bar then go to “Export to…/dxf”.

Follow the same process used for exporting to shape.

5.19.4 Exporting to postgis and Oracle Spatial

Select the “Layer” option from the menu bar then go to “Export to…/postgis”.

© 2007 Conselleria de Infraestructuras y Transporte
If you have selected any elements, a window will appear telling you how many elements are going to be exported (as in exporting to shp and dxf).

If you click on the “Yes” option to continue the gvSIG exports, gvSIG will ask you to input the name of the table you wish to save the exports in. Remember that if the table already exists in the data base, the information it contains will be deleted.

Write the name of the table and click on “Ok”.

A new window appears in which you will have to input the parameters of the data base connection.
The parameters are:

- **Name** of the connection.
- **Computer**: IP address of the computer the database is hosted in.
- **Port**: Port on which the computer is listening to the PostgreSQL service.
- **User**: User name recognised by the administrator to make the connection.
- **Password**: User password required to validate the connection.
- **db**: The database the new table is to be created in.
- **Driver**: Driver required for the data base. (At the time of going to press, drivers for postGIS and mySQL were available).

When you have input the connection parameters, click on “Ok”.

### 5.19.5 Exporting to gml

Select the “Layer” option from the menu bar then go to “Export to…/gml”.

Follow the same process used for exporting to shp or dxf.

### 5.19.6 Exporting to Oracle Spatial
The procedure for exporting to Oracle Spatial is similar to the procedure described above with one difference: for the connection to an Oracle Spatial data base option to be available in the previous connection parameter window, the drivers to enable this process must first be downloaded by following the instructions on the project’s web site. These instructions are summarised below:

The Oracle drivers must be installed to access Oracle Spatial data bases. Follow the steps below:

- Accept the licence terms.
- Download the file **ojdbc14.jar (1,545,954 bytes) - classes for use with JDK 1.4 and 1.5** on the following page.
- NB. You must register to use the downloaded file
- Move the file to the following folder:
  - In Windows:
    - Move the file to the **bin\gvSIG\extensiones\com.iver.cit.gvsig\lib** folder. This is in the directory gvSIG is installed in.
  - In Linux:
    - Move the file to the **bin/gvSIG/extensiones/com.iver.cit.gvsig/lib** folder. This is in the directory gvSIG is installed in.
5.19.7  Exporting to a raster layer

This tool allows you to extract portions of a raster layer using a selection in the view or by inputting the coordinates that define the portion to be extracted. It allows the user to change the spatial resolution of the clipping or of the whole image, choose the bands to be extracted or generate a new raster layer for each of the original bands.

To access this option, go to the ToC and select the raster layer you wish to select a portion of.

Then go to the Layer/Export to menu and select the “Raster” option.

The following window appears:

5.19.7.1  Image clipping

There are two ways of selecting an area to be clipped from the original raster layer:

- You can use the text boxes in the window to input the data which correspond to:
Real coordinates: If the source image is georeferenced.
Pixel coordinates: If the source image is not georeferenced.

- You can also make your selection directly from the view by clipping the whole image or selecting a part of it.
- This button allows you to obtain a clipping from the whole image.
- This button allows you to obtain a clipping from a selected area in the view. Place the cursor over the image, then click and drag. Check that the text boxes are automatically completed.

If you wish to save the raster layer clipping you have created, click on “Save” and select the location you wish to save this file in. The image will be saved in TIF format.

5.19.7.2 Changing spatial resolution
The controls that allow you to specify the clipping’s (or whole image) spatial resolution are located in the Clip table, with the additional options panel pulled down (to pull this panel
down click on the button). You can define the resolution by specifying the Cell size or the Width and Height of the raster layer to be generated in pixels as well as choosing the interpolation method using the resolution change. At the moment, only the “Nearest neighbour” option is operational.

![Resolution change dialog box](image)

### 5.20 Band selection

The original raster layer’s band list appears at the bottom of the Clip table. You can use this list to choose the bands the output raster layer will have if you enable or disable the check boxes in the Bands column. If you check the Create one layer per band option, a new layer will be generated for each of the bands checked in the list. The new layers will be added to the ToC.
5.21 Saving and Adding a raster layer clipping to the current view

When you have established all the parameters which define the raster layer clipping you have made, click on “Save”. This opens a dialogue box which allows you to search for a directory to save the clipping in. If you wish to add the layer to the view, go to the “Add layer” button in the tool bar once you have saved the clipping.

5.22 Example of a raster layer clipping

This example shows how a clipping is taken from an orthophoto. First, select the area by defining a rectangle in the gvSIG view. When you have finished, the coordinates will automatically be input into the text boxes based on the selection. You can fine tune these selected values from the view by inputting the new value directly into the text boxes containing the data.
Then pull down the box. As the resulting image is to be resampled, not as much resolution is required. Therefore, go to the “Spatial resolution” section and select “Width x Height”. This enables the text boxes so that you can input the output raster layer resolution.

When one value is input the other one is automatically completed when you press Enter or when you exit the field, as the proportions between the width and height must be maintained. The cell size for the chosen output resolution is also calculated. If “Cell size” had been chosen, you would have had to specify the size in metres for each pixel and thus the width and height for the chosen cell size would have been calculated.

You now need to select the bands you want the output layer to have. In this case, select them all as this is a three-band orthophoto and we want to include them all.

Finally, for our example, the “Create a layer per band” option needs to be enabled to do just this.

Each new layer will have the same data type as the original image. If you click on “Save” a dialogue box opens to indicate the directory and image name.

To retrieve the layers you have created, go to the Add layer” button and then to the directory they were saved in.

5.23 Exporting to image and WMC

5.23.1 Exporting to image

This option allows you to convert the active view into an image or raster file.

Select the “View” menu then go to “Export/Image”.
When you have selected the tool, a new window appears which you can use to edit the name of the image to be saved and the type of file (jpg, png...) you wish to save it in.
When you have saved the image, you can recover it from gvSIG by going to the “Add layer” tool and searching for a “gvSIG Image Driver” file type.

Use the ToC to check that the exported image is a raster layer by accessing its properties (right click on the layer in the ToC and then go to “Raster properties”).

5.23.2 Web Map Context

5.23.2.1 Introduction

Web Map Context (WMC) is another OGC standard (http://www.opengeospatial.org) which can be added to the list of standards of this type supported by gvSIG.

It can reproduce a view made up of Web Map Services (WMS) layers on any GIS platform which supports WMC. If your project has a view which contains WMS layers, you can
export these layers. The result is an XML file with a specific format and .cml extension which can be imported by another platform on which the view it describes can be reproduced.

5.2.3.2.2 Exporting a view to WMC

Exports to WMC are currently limited to WMS type layers, although it is hoped that its functions will extend to all layers that comply with OGC standards in the future.

To obtain a WMC file, open a view in gvSIG and add the WMS layers you require.

Then go to the “View” menu and select “Export” and then “Web Map Context”. The following dialogue will be shown.
N.B.: If you cannot find the "Web Map Context" option in the "Export" option, your project does not contain any WMS layers.

Basic mode only shows the compulsory properties which cannot be taken for granted by the application.

- **View**: This defines which view is going to be exported to the WMC. The view which is currently active is selected by default.

- **Title**: This is the title of the view which will be shown when your .cml file is loaded at a later date. The current title of the view is used by default but this can be changed.

- **ID**: This field is also compulsory and represents a file ID which must be unique.

- **File**: You can search for the place you wish to save the .cml file in from the "Browse" button.

- **Version**: Use this tool to specify the WMC version you wish to use. The version 1.1.0 is selected by default as it is the most highly developed and the most recommended. However, several applications and geoportals are often limited to a specific version.

  gvSIG currently supports Web Map Context in its versions 0.1.4, 1.0.0 and 1.1.0.

- **Extent**: This defines the extension of the map to be exported.
  - **Defined by the view's extent**: This option only exports what we can currently see in the view.
  - **Use full extent**: This extension is better to use the full WMS layers depending on how their respective servers define them.
If you click on the “Advanced” button, the advanced configuration dialogue will drop down. This allows you to define more properties to obtain a complete WMC.

- **Abstract**: This contains a summary of the view defined by WMC.
- **Keywords**: This list of words allows you to classify and “metadata” the WMC.
- **URL description**: If you have a web site which refers to this WMC, write its link here.
- **URL logo**: If you have an image associated with this WMC, write its link here.
• Map size (pixels): This defines the pixel size that the WMC-defined view will have. The current gvSIG view size is used by default but you can customise the size if you wish.

• Contact info: Information that allows third parties to contact the WMC author.

5.23.2.3 Importing an WMC

Importing Web Map Context allows you to use gvSIG to open views with WMS layers which have been created with other platforms or with another gvSIG.

Use the “View” menu and select “Import” and then “Web Map Context”.

The WMC file selection dialogue opens.

Choose the WMC file you wish to import. On the right, you can specify how you wish to view the layers.
• **New view**: This adds a new view to the current project and loads the WMC as specified in the file.

• **Layers in the active (current) view**: This option only appears if the active gvSIG window is a view. It allows you to quickly add the layers to the current view.

• **Layers in other view**: This adds the layers defined by the WMC in the chosen view. In this option, a list of views appears to select the view that will contain the new layers.

Click on the “Open” button to import the file based on your preferences.

### 5.24 Annotation layer

This gvSIG tool makes advanced labelling easy.

The process creates a new layer which represents annotations. The main features of this new layer can be summarised as follows:

- The new layer is only composed of the annotations created.
- The table associated with this new layer only contains the fields which refer to the text of the annotations (Text, Font, Colour, Height and Rotation).
- The layer created is always in .shp format, irrespective of the format of the original layer.

#### 5.24.1 Creating an annotation layer

To create an annotation layer, first select the layer from the ToC (Table of Contents).
In the menu bar, select the “Layer” option, then select “Export to” and finally select the “Annotation” option.

This option opens the wizard which will guide you through the steps required to create the annotation layer.

- In the wizard’s first window, select the data which gvSIG requires to carry out the operation from the pull-down tab:
  - **Duplicate control**: Select either “None” or “Centred” to choose the position in which you wish the annotations to be inserted.
    - Centred: A label is created for each value and this will be inserted in the centre of all the labels which are the same.
    - None: A label is inserted for each value, even if these are repeated.
  - **Select the field to be labelled**: Choose the field which contains the text you wish the labels to show.

If you do not wish to modify the format of the annotations created by gvSIG and prefer a standard format, click on “Finish”. If you wish to customise the format, click on “Next”.

The wizard’s second window allows you to select the **fields of attributes of a a table** (if there are any) which contain the values which allow you to customise the labelling.
The following parameters can be customised.

1. **Slope** – the slope the annotation will have in the view.
2. **Colour** – annotation text colour.
3. **Height** – annotation text height.
4. **Units** – units in which the value assigned to the “Height” field are to be measured. The options currently available are map units or pixels.
5. **Font** – annotation text font.

Set the values to be used for customising the required parameter (by pulling down the list). Leave the default value in the fields you do not wish to customise.

Click on “Finish” when you have input these changes.
5.24.2 Editing an annotation layer

An annotation layer can be edited like any other layer. To start an editing session in gvSIG, select the layer in the Table of Contents and then select the option “Start edition”.

When you start an editing session, an option appears in the menu bar called “Modify annotation”. This will allow you to individually customise the annotation you wish to change.

When you click on this button, the appearance of the cursor will change. You may graphically select the annotation by clicking on the point associated with the text and then access a set of properties shown in the following image.
5.24.3 **Annotation layer properties**

If we select the “Properties” option from the annotation layer contextual menu, the following box appears:

The “Layer properties” box has two tabs. The “General” tab allows you to access the general properties of the layer and the “Annotations” tab allows you to select:

1. whether you wish the annotation text to be shown in pixels or metres in the view.
2. whether you want only the text to appear (select the “Draw text only” option) or if you prefer the text to be accompanied by a location point (deselect the “Draw text only” option). However, remember that this point is useful, for example, to move the annotation or to access the “Modify annotation” window.

3. If you wish to avoid overlays, activate the “Avoid overlays” option.

4. If you wish to eliminate overlaying annotations, activate the “Clear overlaying annotations” option.

5.24.4 Adding an annotation layer to the view

To add an annotation layer, click on the “Add layer” button in the tool bar and select the “Annotation” tab.

![Annotation Layer Selection](image)

In the box you can select the annotation layer you wish to load, in addition to the units in which the annotations are displayed (pixels or metres) and the projection of the layer.

5.24.5 Example of how to create an annotation layer

The following image shows how an annotation layer is created out of a polygon layer called “muni10000.shp” which contains all the towns in the Valencian Region. In the first window of the wizard, insert the type of duplicate control you wish to use and select the field which
contains the text to be shown. This is the field in a layer’s table of attributes which contains the name of the town.

If you do not wish to customise the presentation, click on “Finish” and indicate where you wish the new annotation layer to be saved.

The following image shows the result (the rest of the fields in the wizard are left with their default values and this one is zoomed in) of creating the “annotation layer”.

The annotation layer which has been created is the one in red called “Towns” in the Table of Contents.

5.25 Working with raster images

5.25.1 Saving as raster

First of all, load the cartography you need to make a clipping onto a gvSIG view. Select the “Save as raster” tool which appears in the tool bar.
Now select two points in the view to define the rectangle that will contain the area to be saved. The following dialogue box then appears. If the rectangle you have marked is too small, this box will not appear and you will have to select a larger rectangle.

The coordinates of the points which delimit the selected area in the view appear at the top of the “Save as raster” dialogue. These coordinates can be changed manually. The “Selection” area appears in the centre of the dialogue. This includes three selection methods:

- **Scale.** If you select “Scale”, the “Scale” text box and the “Resolution” pull-down menu are enabled. The pull-down menu values correspond to the points per inch in the exported image.
  Input a value for the scale and press “Enter”. The Mts/pixel values and the “Width” and “Height” size of the output image are recalculated.
• **Mts/pixel**: If you select “Mts/pixel” from the three radio-buttons column, the text box to input this value will be enabled. Input a Mts/pixel value and press “Enter”. The “Scale” value and the size (“Width” and “Height”) of the output image will automatically be recalculated.
- **Size:** If you select “Size”, the text box to input the “Width” and “Height” values will be enabled. When you input one of these values, the other will be recalculated automatically to maintain the height/width proportions. The remaining data (“Mts/pixel” and “Scale”) will also be recalculated automatically. You can also select the unit of measurement you wish to see the values in via the “Pixels” pull down menu.
Click on the “Select” button to choose where you wish to save the image. The most suitable driver will be loaded according to the type of file you choose (N.B. watch how the button to the right of “Select” changes), i.e. when a .jp2 output file is selected for example, you can open the properties box which corresponds to a Jpeg2000 format. The formats available to save a file are geoTiff, jpg (georreferenced with a worldFile) and jpeg2000. An ecw extension can be selected exceptionally and only with Linux kernel 2.4.
When you select the output file the properties button is enabled.

For geoTiff files, a box similar to the one below appears:

- **Block size**: The block size defines the amount of data read each time so it can be compressed. The greater the block size the faster the compression speed but more memory is used.
- **Photometric**: [MINISBLACK | MINISWHITE | RGB | CMYK | YCBCR | CIELAB | ICCLAB | ITULAB]. This assigns the photometric interpretation. This is RGB by default, because the input image has 3 byte-type bands.
- **Interleaving**: [BAND | PIXEL]. The tiff files have band interleaving. Some applications only support pixel level interleaving. In these cases, this option can be modified.
• **Compression:** [LZW | PACKBITS | DEFLATE | NONE] This assigns the compression to be used. The default option is none.

A table like this will be obtained for jpg.

![Propiedades de jpg](image)

• **Block size:** The block size defines the amount of data read each time so it can be compressed. The greater the block size the faster the compression speed but more memory is used.

• **Compression:** This allows the image's compression level to be adjusted.

• **Progressive:** This allows you to make progressive jogs.

When the image has been selected and the properties have been adjusted, click on “Ok”. A progress bar appears. This process may take an extremely long time depending on the size of the output image. It can take from a few seconds to several days. Thus, it is advisable to control the size of the output image via the number of pixels so we are not taken by surprise.
When the process finishes, a statistics table indicates the saved image path, the disk size of the output image, the length of the process and whether the image has been compressed or not.

To check that the georeferencing has been correctly carried out, you can load the image you have saved as another layer and apply a transparency.
5.25.2 Georeferencing with base mapping and control points

The gvSIG programme allows an image to be georeferenced (.jpg, .tif, .gif, .png) using control points on a georeferenced base map.

Firstly, the georeferenced base map needs to be loaded (in raster or vector format or both) to a gvSIG view.
Secondly, the image to be georeferenced must be added. You can load this image by going to the “Add layer” tool and selecting the “Georeference” tab.

Use the “Load” button to access the image you wish to georeference.
If you enable the “Use image georeferencing” check box and the image is georeferenced, it will be added to the view with its current georeference. If it is not, the image will be loaded in the centre of the view.

You will then find a browser button which can be used to select the map projection.

When you have finished the process, click on “Ok”. The image to be georeferenced will appear in the view and will have an asterisk “*” in the ToC to indicate that this is the layer the process is being carried out on. A new window will also appear to carry out the georeference process but first, the image to be georeferenced will have to be moved closer to the base map’s reference zone so that you can select the control points more quickly.
5.25.2.1 Moving the image to be georeferenced closer

If the layer to be georeferenced is selected in the ToC, four new buttons will appear in the tool bar.

- ![This button](image)

  This button resizes the image to be georeferenced. The image size can be modified and brought closer to the base map scale.

  Select this tool and go to the image to be georeferenced. A frame will be created around the image. If you place the cursor on one of the image sides, it will turn into a double arrow. This will then allow you to modify the frame size by moving the cursor. The newly created frame boundaries will become the new reference size for the image being georeferenced.
This tool allows you to move the image to be georeferenced around the view and thus bring it closer to the reference base map.

This tool takes you back to the previous position of the image to be georeferenced in the view.

This tool is activated when the previous tool has been used and allows you to redo what you have previously undone.

5.25.2.2 Selecting control points
Click on the “New point” button in the “Georeference” dialogue and go to the view.

![Image of the georeference dialogue]

Place the mouse pointer over the image to be georeferenced and look for a control point. This point is defined as a red circle with a cross in the middle. If you move outside the boundaries of this image, gvSIG shows an error message and you will have to select a point once again.

If you click on the following button

![Image of the georeference dialogue with control point]

two small windows will drop down. In the left-hand window, the location of the created control point appears over an image zoom, as the following image shows.
If you wish to specify the point further, you can zoom into the image using the zoom tools in the centre of the dialogue box.

If you then click on the point in the mini view and drag it you can move its location. These changes will automatically be reflected in the gvSIG view.

When you have marked the control point on the image to be georeferenced, this will disappear from the view (this option is marked by default in the "Options" tab in the "Georeference" window and can be modified at any time) and will only leave the base map with the destination point marked on the view.

In this case, the point is defined by a blue square with a cross in the centre.
You can do the same with the mini view on the right as you did with the left, i.e. if you wish to move closer to the point location, you can zoom into the right-hand image and drag the point over the view to place it more precisely.

You can also specify the points in the text boxes in the georeference dialogue window. When the points have been input, press “Enter” and the point will be located in the view. Remember that the “X” and “Y” text boxes belong to the image to be georeferenced and that “Longitude” and “Latitude” correspond to the georeferenced image.

If you have made a mistake with the point and wish to delete it, click on “Remove selected point”.

If you click on this button, a confirmation message will appear.
If you click on "Yes", the point will be deleted.
If you wish to remove all the points, click on the “Remove all the points” button.

The control point selection must be repeated as a minimum of three points are required for georeferencing, although at least nine are advisable.

There is another series of tools in the “Georeference” window:

- This tool allows you to go to the first control point, to the previous point, search for control points using a pull-down menu, go to the following control point and go to the last pull-down point respectively.
- This button allows you to select control points from the view. Firstly, select the control point of the image to be georeferenced and finally, the control point of the destination coordinate.

You can disable an input control point via the "Active" check box in the “Point” tab. This means that the point will not be used in the error and georeference calculations and the symbols will not appear in the view. If you need the point again, you can enable the check box.

If you click on the “Table” tab, a table will appear with all the points and their errors. This table can be enlarged to show more information.
5.25.2.3 Saving and adding control points

When you have finished the georeference process, you can save your control points by using the following tools:

- in a metadata file associated with the image with the .rmf extension (if data already exists in this file, gvSIG will warn you that it is going to overwrite it).
- in a .csv file: In this case, a dialogue window opens to select a file to save the data (X, Y coordinates and the errors in X, Y and RMS).

However, if you wish to add points from a file, use the following tools

- to retrieve .rmf control points associated with the image.
- to load control points from a .csv file.

N.B.: You can also save the georeference points in the table panel.
5.25.2.4 Options
You can use the “Options” tab in the georeference window to enable and disable some of the options according to your preferences.

5.25.2.5 Restrictions
- It is currently only possible to georeference bmp, gif, jpg, png and tif formats.

5.25.3 Brightness and contrast and Enhance
Applying “Brightness and Contrast” and “Enhance” filters to raster images. Firstly, load the cartography in raster format in a view and right click on the name of the
raster layer selected in the ToC. When the menu appears select the “Raster properties” option.

Then go the “Enhance” tab.
You will see that the “Brightness and contrast” and “Enhance” adjustment panels are disabled by default. These panels can be enabled by checking the boxes at the top of each panel. If these check boxes are disabled no filters will be applied to the image even though the values have been input into the panel. If, at any time, any of these filters have been applied to the image, the values will appear in the panel.

You will find two slider controls in the “Brightness and contrast” panel. Values can be modified by using the slider or by directly inputting the values in the numerical field on the right and pressing “Enter”. The brightness and contrast increase range goes from -255 to 255. To fine tune these values without having to input them in the numerical field, click one end of the slider control to either increase or decrease the value, unit by unit.

You will find a “Preview” check box in the panel. This is useful for obtaining a preview of the image without having to “Accept” or “Apply” changes every time they are made. If this check box is enabled, the image is refreshed with the new filters when the mouse button is released after modifying the brightness or contrast values using the slider control or when “Enter” is pressed if the numerical field has been used to modify the value.
When brightness and contrast filters are applied the previous image takes on the above appearance. When “Cancel” is pressed, no changes are applied and the input values are lost. If you press “Accept” and you return to “Raster properties” you will see that the previously input values have been saved.

5.25.4 *Transparency per pixel*

This assigns transparency to a raster based on the colour of its pixels. To assign this transparency, first load the cartography, then place the mouse pointer in the ToC over the raster layer you wish to modify. Right click and the contextual menu will appear. Select the "Raster properties" option. When the dialogue box opens, select the "Transparency" tab. Only the top part of the panel corresponds to this tool. Enable the “Activate” check box and the controls that correspond to this function will be activated.
You can write the required combination of red, green and blue values in the “R”, “G” and “B” text boxes. When you have input these values, you can add them to the list with the right-facing arrow. These values will be added with an AND (&) if the “And” check box is enabled and with an OR (|) if the “Or” check box is selected.
Adding the values with an AND means that all the pixels that have the red, green and blue values we have input will become transparent. Adding the values with an OR means that all the pixels that have the red or green or blue values we have input will become transparent.

If you select an entry from the list and click on the left-facing arrow, the values will appear in the text boxes and can be modified.

You can input multiple values in the list. This means that when you accept the operation all the pixels whose colour coincides with the values input in the list will be transformed.

### 5.25.5 Selecting a raster layer

This tool allows you to select raster layers from the view and for them to be selected in the ToC.

This is useful if you are using an orthophoto mosaic and you need to find out exactly which orthophoto you are working with.

You can access this tool from the tool bar by clicking on the following button
or by going to the “View” menu then to “Selection”.

We are now going to show an example of the use of the tool.
Remember that there are a large number of orthophotos in the ToC with similar names which as a whole make up the province of Valencia in the “View”.
Go to the view. Make sure the selection tool for the raster layer is active and click on the orthophoto you wish to work with.

You will see that the chosen orthophoto has automatically been selected in the ToC.

6 Tables

Tables are documents which contain alphanumeric information. Tables are made up of rows or records (which represent each of the elements in the data base) and columns or
fields (which define the different attributes of each element).

- **Row or record**: Used to represent the different elements in the table.
- **Column or field**: The types of attributes which define each element.
- **Cell**: A cell is the intersection of a record and a field. A cell is the minimum working element and may contain information.
- **Record information**: This provides information about the total number of elements (records) contained in the table.
All the vector information layers have their own “Table of attributes”. Each graphic element in a particular layer has its corresponding record in the “Table of attributes”.

To select elements in the table, left click on them. Use the “Control” and “Shift” (CAPS) keys to select more than one record.

6.1 Adding a Table

You can load a table in gvSIG in two ways:

- From the “Project manager”
- From the “View”

6.1.1 Adding a table from the “Project manager”

Select “Tables” as the document type from the “Project manager” and click on “New”.

A dialogue box will open in which you can add the table.
When you click on the “Add” button, a browser window will open.

Specify the type of file you wish to load in gvSIG in “Files of Type”. When you have located the file that contains the table, select it so that it is added to the “File name” text box and click on “Open”.

You will automatically be returned to the "Add table" dialogue. If you wish to add more than
one table, click on "Add" again and repeat the process. When you have finished, click on “Ok”.
The table will then be displayed. It will also appear in the “Project manager” text box.

6.1.2 Adding a table from a view

Click on the “See table of attributes” button from the display window of a view with at least one active layer, i.e. a layer that is selected in the ToC,

or go to the "Layer" menu and then select the "See table of attributes" option.
The table will automatically be added to the project.

If you minimise the view, go back to the “Project manager” and select “Tables” as the
document type, you will see that the table displayed in the view appears in the text box.

6.2 Table properties
You can access “Table properties” from the “Project manager” window.

You can use this window to:
• Rename the table.
• Edit the creation date.
• Add an owner to the table.
• Add comments.

When you have input the changes, click on “Ok” and they will be saved.

6.2.1 Statistics
You can access this option by clicking on the following button
or by going to the “Table” menu and then to “Statistics”.

The “Statistics” tool allows you to obtain the most common statistical values.

N.B.: Remember that the tool will not be activated until you select a numerical field.

If you wish to obtain field statistics:

- Select the field (left click on the field heading).
- Then click on the “Statistics” tool.

You can only obtain statistics from a series of records:

6. Firstly, select the field the values are located in.
7. Select the desired records.
8. Click on the “Statistics” tool.

6.2.2 Filters

You can access this tool by clicking on the “Filter” button in the tool bar
or by going to the “Table” menu and then to “Filter”.

The “Filter” tool works in much the same way as in the “Views” section. gvSIG allows selections to be made using filters. Selection using filters allows you to define exactly what you want to select, including several attributes, operators and calculations.

Requests can be made using logical operators, such as “equals” “more than” “different from”, etc.

If you press the “Filter” button in the tool bar, a dialogue window will appear to define your request.

- **Fields**: Double click on the field you wish to add to your request from the “Fields” list in the layer.
- **Logical operators**: These allow you to insert a logical expression into your query by clicking on them.
- **Values**: This shows a list with the different values the selected field has. If you wish to add a value to the request, double click on it.
- **Request**: This is the window which represents the request to be made. You can write here directly.
• **Selection buttons**: These buttons make the request using:
  - “New set” (deletes any previous selections).
  - “Add to set” (adds the elements selected by the query to the existing elements).
  - “Select from set” (makes the request from the selected elements).

N.B.: In a gvSIG view, when you activate a layer by selecting it in the ToC, the filter tool will also be activated in the tool bar, even though no table has been loaded. This allows you to work with the table associated with the selected layer. The “Table” menu will also be added in the menu bar. This provides another way to access the filter tool when it drops down.

### 6.2.3 *Ascending order*

You can access this tool by clicking on the following tool bar button

or by going to the “Table” menu and then to “Ascending order”.

The “Ascending order” tool allows you to order the table records.

- It orders the values from the lowest to the highest in a numerical field.
- It orders the records in alphabetical order, starting from “A” in a text field.

### 6.2.4 *Descending order*

You can access this tool by clicking on the following tool bar button

or by going to the “Table” menu and then to “Descending order”.

The “Descending order” tool allows you to order the table records.
• It orders the values from the highest to the lowest in a numerical field.
• It orders the records in alphabetical order, starting from “Z” in a text field.

### 6.2.5 Join

The “Join” tool allows two tables to be joined via a **common field**.

You can also access this tool by clicking on the following button

or by going to the “Table” menu and then to “Join”.

To join the two tables, carry out the following steps:

• Firstly, specify the source table the join is to be made from.

![Select origin table of the join](image)

• Then specify the field to be used for the join.
9. Then indicate the table you wish to join to the first one.

5. Finally, indicate the field in the second table which is common to the first one.
If you open the data source table, you will see that the fields of the destination table have been joined. The name of the field added to the table is identified by the word “Join_(Field name)”

6.2.6 Link

You can access this tool by clicking on the following button in the tool bar

or by going to the “Table” menu and then to “Link”.

The “Link” tool allows two tables to be linked via a common field, so that any changes that take place in one table will also be shown in the other one.

• Firstly, specify the source table the link is to be made from.
Then specify the field to be used for the link.

10. Then indicate the table you wish to link to the first one.
6. Finally, indicate the field in the second table which is common to the first one.

6.2.7 Moving the selection to the top
This tool allows the records selected in the table to be moved to the top of the table.
You can access this tool by clicking on the following button in the tool bar

or by going to the “Table” menu and then to “Move selection to top”.
The following table shows an example in which two records have been selected to move to the top of the table.
If you click on the button, the table will change the position of the selected records.

6.3 Table-associated tools

When a table has been loaded, either from the “Project manager” or from the view, the tools associated with the table will appear in the tool bar.
A new menu, called “Table”, will also be activated in the tool bar. This can also be used to access the different tools.

<table>
<thead>
<tr>
<th>Table</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Join</td>
<td></td>
</tr>
<tr>
<td>Link</td>
<td></td>
</tr>
<tr>
<td>Redo</td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td></td>
</tr>
<tr>
<td>Insert row</td>
<td></td>
</tr>
<tr>
<td>Remove row</td>
<td></td>
</tr>
<tr>
<td>Manage fields</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td></td>
</tr>
<tr>
<td>Ascending order</td>
<td></td>
</tr>
<tr>
<td>Descending order</td>
<td></td>
</tr>
<tr>
<td>Statistics</td>
<td></td>
</tr>
<tr>
<td>Move selection to top</td>
<td></td>
</tr>
<tr>
<td>Invert selection</td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td></td>
</tr>
<tr>
<td>Remove joins</td>
<td></td>
</tr>
<tr>
<td>Remove links</td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td></td>
</tr>
</tbody>
</table>

### 6.4 Adding a table from a CSV file

From version 0.5 onwards, gvSIG can read information contained in a plain text file, whose fields are separated by a semi-colon.
To carry out this operation, go firstly to the “Project manager”. Select “Tables” and then click on “New”. A search dialogue box will open. Click on “Add” and the file browser will appear in a new window (select “csv string” in “Type of file” to show the csv files).

When the .csv file has been selected, click on “Open”.
If you click on “Ok”, the data of the table you have added will be shown.
6.5 Adding a table from a JDBC data origin

The contents of a database table can be imported to gvSIG using database managers (PostgreSQL, MySQL, GBMS-HSQLDB, ODBC). gvSIG processes the information obtained just like any other table.

Note: Oracle drivers installation is required for access to Oracle Spatial databases of the geoBD extension. Please follow the steps below:

- Go to Oracle Database 10g Release 2 (10.2.0.3) drivers.
- Accept the license terms.
- In the next page, download the file ojdbc14.jar (1,545,954 bytes) - classes for use with JDK 1.4 and 1.5. (Registration required)
- Move this file to the next folder:
  - Windows:
    - Move the file to the bin\gvSIG\extensiones\com.iver.cit.gvsig\lib folder, that is in the directory where gvSIG is installed.
  - Linux:
    - Move the file to the bin/gvSIG/extensiones/com.iver.cit.gvsig/lib folder, that is in the directory where gvSIG is installed.

To load a table with the information obtained from a JDBC data origin you must:
Firstly, go to the "Project manager" and select "Tables". Then click on "New". Select the “Data base” tab in the window that opens (“New table”) and configure the data base server connection parameters:

![New table dialog box](image)

If the information entered is correct, a new table will be created in gvSIG with the information contained in the original JDBC table.

7 Field Calculator

gvSIG’s field calculator allows you to perform different types of calculations on the fields of a table (for example calculate areas, perimeters, convert the data in a field from degrees to radians, etc).
7.1 Accessing gvSIG’s field calculator

To access the field calculator, you must first start an editing session in gvSIG.

- If you wish to activate the edition of a layer loaded in a view, go to the layer’s contextual menu and select “Start edition”.

- If you wish to edit a recently-loaded table, go to the “Table” menu and select “Start edition”.

- If you decide to use the field calculator on a “New layer” (for example New shp) which
you are going to create (remember that to access this option you must go to the “View” menu and select the “New layer” option), the layer will automatically appear in editing mode when inserted in the view.

<table>
<thead>
<tr>
<th>Vista</th>
<th>Ayuda</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exportar</td>
<td></td>
</tr>
<tr>
<td>Importar</td>
<td></td>
</tr>
<tr>
<td>Nueva capa</td>
<td>Nuevo SHP</td>
</tr>
<tr>
<td>Añadir capa</td>
<td>Nuevo DXf</td>
</tr>
<tr>
<td>Propiedades</td>
<td>Nuevo postgis</td>
</tr>
</tbody>
</table>

Once you have started an editing session, activate the table of attributes on which the operations are going to be performed and select one of the fields (by clicking on the field heading).

The following button will then be activated in the tool bar:

This will allow you to access the field calculator.

NB. The first time you open the field calculator in a new gvSIG session, a warning window appears to inform you that the calculator is “Loading operators”. Once this process has finished, the window which allows you to perform operations with the various fields appears.

7.2 Description of the “Field Calculator”
The field calculator window has three different sections.

7.2.1 Information

The Information section provides information about the type of field and the commands selected in the “General” tab.

The following information can be found in this section:

11. “Operator” = This indicates the command selected and the expression which allows it to be executed.

Example: In this case the command we wish to use is “log”, which allows us to calculate the logarithm of a field with a numerical value.
The “log (Parameter)” operator indicates that, for example, in order to obtain the logarithm of a field which contains the area data of a plot shp, the word “Parameter” must be replaced by the field we wish to obtain the logarithm of. As a result, the expression will be as follows: log([AREA])

1. “Parameter”= This can be one of three different field types which must be entered in the expression box in order to perform the calculation.
   - Numerical value: a String, Double or integer type field must be entered.
   - String value: A String type field must be entered.
   - Date value: A date type field must be entered.

NB. If a table field is selected in the “Field” section of the field calculator, the information window indicates what type of data it is.

NB. In order to input parameters into the “Expression” text box, either double click on the name of the field from the list of fields in the General tab or type in the name of the field, in which case the String expressions input must be placed in inverted commas.
7. **“Return”** = This indicates the type of data obtained as a result of the calculations.

**Numerical Value** = The result must be String, Double or integer type field data.

NB. If a String field type has been selected, it should be noted that this field type uses string values. If we add two String fields to another String field, the final result is a string and not the result of the operation (for example: 2+2 = 22, not 4).

**Boolean Value** = A Boolean value returns a true/false answer to a question. If the result of the question is in a numerical field, it would therefore be either “1/0” depending on whether the reply was true or false.

Let us look at an example:

We wish to know if there are records in a field which are the same as those in another field. The command which allows us to find this out “==”

If we type the following sentence: [integer] == [double] (double and integer being the names of two fields, each with numerical values), the response according to the type of target field (Boolean or String) can be seen in the image below:
**Date Value:** The result must be in a Date type field.

NB. If a new layer is created in a gvSIG view (View menu / New layer), the wizard for this action allows you to specify the “Type of field” on which calculations are going to be performed.

If you are working with a layer and wish to know the field type, simply start a layer editing session, go to the “Table” menu and select “Manage fields”.

<table>
<thead>
<tr>
<th>integer</th>
<th>double</th>
<th>boolean</th>
<th>string</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>5.0</td>
<td>false</td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>5.0</td>
<td>true</td>
<td>1</td>
</tr>
<tr>
<td>7</td>
<td>9.0</td>
<td>false</td>
<td>0</td>
</tr>
<tr>
<td>9</td>
<td>6.0</td>
<td>false</td>
<td>0</td>
</tr>
</tbody>
</table>
This opens a window called the “Field manager”, which allows the fields of a table to be created, renamed or deleted. It can also be used to confirm the field type.

7.2.2 **General / Advanced Tabs:**

8. **General:** This provides information about:
9. **Fields**: The text box shows all the fields of the table being worked on.

10. **Type**: Access to commands depends on which check box is activated.

11. **Commands**: These are the operators which allow expressions to be constructed to perform the calculations required.

12. **Advanced**: A search box may be opened to look for an expression saved in a file.

Once the file has been selected, click on the “Evaluate” button to find out whether the expression is correct or not.

NB. The expressions must be written in Python programming language.

### 7.2.3 “Expression” Section

The name of the field the results of the calculations of the expressions entered in the text box appear in is next to the “Column” text.

NB. The expressions are only calculated on the records selected in the table (if no records have been selected, the calculation is performed on all the records in the selected field).

### 7.3 Introduction example: “Field calculator”

Let us look at a simple example to explain how the field calculator works.

In order to **work out the area of a series of plots** in a layer we have created:

First, open a gvSIG view and load an orthophoto which will be used as a base to determine the location of the plots.

Next, select the tool in order to create a new shp file (View/New layer/SHP).

Select a “Polygon” type layer, click on the “Next” option and then create a “Double” type field called “Area”, leaving the default value at 20.
Draw four plots on the orthophoto using the “Insert polyline” tool selected from the tool bar. The image below shows that a record for each of the plots has been created in the table.

Select the field from the table and activate the field calculator.
The following information appears in the “General” tab:

“Field”. This contains the various different fields which comprise the table being worked on.

“Type” of field selected. Access to different commands depends on the type of field.

“Commands” which can be used in the calculations.

The “Information” section shows that:

- If the “area” command has been selected in the “General” tab, a brief description will be displayed in the information window.
If the “area” command has been selected in the “General” tab, the information window returns a message with information on the field type (remember that when designing the “area” shape, a Double type numeric field was created in which the area will be calculated).

The “Expression” area displays the name of the column on which the calculation is being performed and a text box for the calculation sentence to be used.

In this case, the sentence included in the expression section is simple (no parameters are required as they are in other expressions which shall be explained later on).

To sum up and conclude this example, once the “area” command has been selected, click on “Ok” and the field created in the table will automatically be filled with the area values of
each of the polygons drawn.

<table>
<thead>
<tr>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>1746.563...</td>
</tr>
<tr>
<td>1736.109...</td>
</tr>
<tr>
<td>5106.418...</td>
</tr>
<tr>
<td>3352.420...</td>
</tr>
</tbody>
</table>

0 / 4 Total regist...
8 Editing tools

8.1 Introduction
There are two types of edition. Firstly, there is the graphic edition of elements which creates, modifies and deletes graphic elements and secondly, the alphanumeric edition of elements which creates, modifies and deletes data associated with the elements.

8.2 Graphic editing

8.2.1 Introduction
gvSIG’s CAD extension can make complex drawings from basic elements, such as lines, circles or polygons.
Features can be duplicated or modified as you wish by using actions such as copying or rotating.
To carry out these tasks, we need to know what type of layer is being edited. Once we know the type of layer, we can see which tasks can be carried out.

When the “Start edition” option is selected, the edition tool bar buttons appear. Only the buttons which can be used in the layer being edited are active. Thus, for example, if a points layer is being edited, the selection, move and point insertion tools are enabled whilst if, for example, the layer is a line layer, all the tools are enabled except the point insertion tool.
Another tool which appears when an editing session is started is the command console or message and command area, located at the bottom of the graphic area. This tool allows you to input commands via the computer keyboard. These are then carried out in the graphic area.

8.2.2 The graphic area

If you select the “Layer” menu option then go to “Start edition”, the application window
shows the following areas.

- **Menu bar**: Menus with which you can access the application’s functions. The contents will change according to the situation, thus, for example, the "Geometry" menu will only appear when a layer is being edited.

- **Tool bar**: Bar which shows the drawing command icons.

- **Graphic area**: This takes up the majority of the display and is where the layer which is being edited is shown.

- **Command console**: This is where the editor’s PROMPT is located (active line of the console). This means that the programme is ready to receive commands. When a command is input, the corresponding process is run and the messages, information or parameter requests are shown.

- **Status bar**: This shows the scale, the measuring units, the absolute coordinates of the cursor position (X and Y) in these units and the projection.

### 8.2.3 Starting and finishing an editing session in gvSIG

Firstly, enable the layer you wish to edit by selecting it in the ToC. Place the cursor over it and right click on the mouse. The contextual menu appears. Select the “Start edition” option.

N.B.: More than one layer can be edited and you can alternate what you do with them. However, whatever you do will only take effect on the active layer. To change the layer you are working on, select it in the ToC.
When you finish your editing session, go to the “Finish edition” option in the contextual menu.

N.B.: The application will create a projection of the object you are working on to help you with the graphic editing. This will allow you to get a visual idea of the obtained result. The object projection will be shown in red.

The figure shows how a projection of the figure copied in a different colour is created during the copying process. This projection allows you to specify exactly where you want to place the new object in the graphic area.
8.2.4 Procedures to input commands

There are three general mechanisms for the application to run user commands. The first mechanism is to select the command by clicking on the corresponding button in the tool bar. The second option is to activate the tool by selecting it in the menu bar (normally in the “Geometry” tab) and the third and last mechanism is by inputting commands in the command console using the keyboard.

8.2.4.1 Tool bar

The edition tool bar appears when a layer is being edited. The tool bar icons will be activated according to the type of layer being edited.

8.2.4.2 Menu bar

When an editing session starts, a new menu called “Geometry” appears in the bar from which we can access the different tools.
8.2.4.3 Command console

The commands, options, messages or parameter requests the programme runs are shown in the area called "Command console". The bottom line of the command console is called the "line command" and shows the action the application is running.

The command console area size can be increased or decreased. To modify its size, place the mouse pointer on the separation bar between the command console and the graphic area, left click on the mouse and move the bar up or down until it is situated in the required position. When you have finished, let go of the mouse button.

You can also hide the command console by clicking on the down-facing triangle situated at the top right of the console. To show the command console, click on the upward-facing triangle.

To input commands into the command console using the keyboard, write the name of the
command or order and press “Enter”. Commands can be input in capital or small letters. When a command is input, a window or a set of options associated with this command appears. For example, if the “rectangle” command is input, a window will appear in which the definition of a corner point is requested. When the point has been inserted, a second point or “C” is requested to indicate that the object will be a square.

8.2.5 Edition properties

When a layer editing session has been started, if you right click on its name in the ToC, a contextual menu appears in which, among other things, you can access the “Edition properties” to configure them.

8.2.5.1 Snapping

You can configure the “Snap tolerance” in the first editing page. “Snap” or “Snapping” is the process of moving an element until it coincides exactly with the coordinates of another element. If the “Snap tolerance” is 4 pixels, two elements which are the same distance or closer than 4 pixels will be joined in a common coordinate.
You can do element snapping between layers by enabling the corresponding check boxes in the “Selected” column.

You can modify the values of the "Maximum features edition cache" column to accelerate the snappings and handlers being edited. This is the maximum number of geometries you wish to work with in the cache.

8.2.5.2 Configuring the grid

If you select “Grid” in the tree on the left, this will allow you to configure the grid’s properties.

The grid is a point pattern which extends over the whole of the graphic area. It is useful in that it allows you to line up objects and calculate the distance between them.

You can enable the “Show grid” and “Adjust to grid” check boxes and edit the distance between the grid points.

![Image of grid configuration settings]

When the grid is shown, the graphic area will look like this.
8.2.5.3 Flatness

You can configure “Flatness” by selecting the corresponding option in the tree on the left.

In gvSIG, a circle or any curved geometry is made up of straight sections. The flatness number you specify will define the maximum size of these sections.

8.2.6 Undo/Redo

gvSIG has several mechanisms to undo steps you have already taken in the layer you are editing or redo some you have undone.
8.2.6.1 Command stack

The command stack is a tool which allows you to undo/redo several commands at once. It also provides information about the commands carried out, such as the name and time they were carried out.

The command stack can be activated in different ways.

- By clicking on the tool bar icon shown below.

2. By selecting the menu bar option "File" then going to "Command stack".

The command stack saves all the commands given on the layer being edited since the last time it was saved.

You can select the commands you wish to undo in the slider control. You can move the slider control up or down until you have positioned it in the order in which you wish to continue working.
You must remember that you cannot undo one specific command, you have to undo all the commands given up to that point, i.e. we have to go to the last step we wish to keep and continue editing from this point. For example, let us suppose that we take eleven steps and when we reach the eleventh step, we realise that step number six is incorrect. We cannot simply go to step 6 and cancel it, we have to undo the eleventh, tenth, ninth steps, etc. until we get to the fifth one.

The advantage of using the command stack is that we can undo all the changes at once without having to undo them one by one. In addition, we know which steps we are undoing. You can access Undo/Redo from the edition tool bar by clicking on the corresponding icon.

The button with the left facing arrow allows you to undo the last step.

The button with the right facing arrow allows you to redo the last step you have undone.

**8.2.7 Coordinates**

A point can be referenced in two ways:

- **Console mode.** The point coordinates are input numerically.
- **Graphic mode.** The point is indicated by using any of the pointer devices (normally a mouse).
8.2.7.1 Console mode

Two reference systems can be used in the console.

• Cartesian coordinates: These define points X and Y based on the reference point.
• Polar coordinates: These define a point according to the distance based on the reference point and an angle in respect to the horizontal axis.

The coordinates can also be:

• Absolute: They define a point based on the coordinate source (0,0).
• Relative: They define a point based on the last defined point.

Inputting Cartesian coordinates.

Input the X and Y values separated by a comma (X,Y). The X value is the positive or negative distance, in units along the horizontal axis, the Y value is the distance in units along the vertical axis.

The values used to designate the points can be whole, decimal, positive or negative.

The absolute coordinate values are based on the source (0,0), which is the place the X and Y axes intersect. For example, the point 25,7 designates a point located 25 units away from the source on the X axis and 7 units away on the Y axis.

The relative values of the coordinates are based on the last input point. Use the relative coordinates when you know the coordinates of a point based on the previous point. To designate a relative point, place the (@) symbol in front of the coordinates.

For example, the @1,2 coordinates determines a point 1 unit away on the X axis and 2 units away on the Y axis from the previously designated point.

Inserting polar coordinates

To input polar coordinates, indicate a distance and an angle separated by the < symbol. For example, to designate a point 5 units away from the previous one with a 45 degree angle, write @5<45.

The angles increase anti-clockwise and decrease clockwise. To move anti-clockwise, indicate a negative angle. For example, the 1<315 position is the same as the 1<-45 position.

8.2.7.2 Graphic mode

Designating a point in graphic mode is simply to indicate it using a pointer device. If you have a mouse as a device, the mouse's movement is linked to the cross hairs (crossed
axis pointer) on the display.

Place the cross hairs on the desired point and left click on the mouse to define the point.

### 8.2.8 Editing commands

Editing commands are the set of orders used to edit or modify a drawing. More specifically, they cover all the processes and mechanisms required to modify and work with what has already been drawn.

gvSIG uses three different ways to run these commands.

- By clicking on the corresponding button from the tool bar.
- From the menu bar.
- By writing the command in the command console.

#### 8.2.8.1 Selecting

**8.2.8.1.1 Simple selection**

To select one of the drawn objects in the layer we are editing, click on the "Select" button in the tool bar,

or go to the “Geometry” menu bar and then to “Select”.

<table>
<thead>
<tr>
<th>Geometry</th>
<th>Table</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insert</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Complex selection</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Then click on the object you wish to select.

**8.2.8.1.2 Complex selection**

You can access this button in the tool bar,

![complex selection button](image)

or by going to the “Geometry” menu bar then to “Complex selection”.

When the “Complex selection” tool has been selected, right click on the mouse in the graphic area. The following contextual menu will appear.

<table>
<thead>
<tr>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Out of rectangle</td>
</tr>
<tr>
<td>Inside polygon</td>
</tr>
<tr>
<td>Intersects/Contains polygon</td>
</tr>
<tr>
<td>Out of polygon</td>
</tr>
<tr>
<td><strong>Inside circle</strong></td>
</tr>
<tr>
<td>Intersects/contains circle</td>
</tr>
<tr>
<td>Out of circle</td>
</tr>
<tr>
<td>Select all</td>
</tr>
<tr>
<td>Cancel</td>
</tr>
</tbody>
</table>

Click on the option you wish to use to select the elements.

If you use the “Inside circle” option you can delimit a circle so that the elements you wish to select remain inside this area.
The selection result corresponds to the following image.

You can also write the “select” and “complex selection” commands in the command console.

**Command: “select”**
Write the command “select” in the command console.

When a message appears in the command console requesting you to add the selection point, input the coordinates of the object you wish to select. If there is an object in the defined coordinates, it will be selected.
Command: “complex selection”

Write the command “complex selection” in the command console and when the selection options appear, write the desired option. The options are shown with their names, and in square brackets ([]) the text you need to input in the command console to use the option.

If, for example, you wish to select the features that are in a polygon area, you need to write “complex selection” in the command console, press “Enter” and then select the “IP” option. This allows us to indicate the coordinates of the vertices which will make up the polygon (when the coordinates of each of the vertices are indicated a polygon is drawn in the drawing window) and when it is finished, the elements which are inside it are selected so you can work on them.

The following image shows how a selection option is input.

The following figure shows the definition of the selection polygon in the graphic area.
When the polygon is finished, the elements contained inside it will be selected so you can work on them.

**Selection options**

- **Inside circle [IC]:** This allows you to delimit a circle and select all the elements located inside this area.
- **Outside rectangle [OR]:** This allows you to delimit a rectangular area and select the elements which lie outside this area.
- **Inside polygon [IP]:** This allows you to draw a polygon area and select the elements located inside this area.
- **Intersects with/Contains polygon [CP]:** This allows you to draw a polygon area and select all the elements located inside it or which intersect with its perimeter.
- **Outside polygon [OP]:** This allows you to delimit a polygon area and select the
elements which lie outside it.

- **Intersects with/Contains circle [CC]:** This allows you to delimit a circle and select all the elements located inside it or which intersect with its perimeter.
- **Outside circle [OC]:** This allows you to delimit a circle and select the elements which lie outside it.
- **Select all:** This selects all the elements contained in the layer regardless of where they lie in it.

### 8.2.8.2 Copying

This makes a copy of the objects you have selected. The elements copied will keep the same size and orientation as the originals.

To access this tool, click on the “Copy” button in the tool bar or go to the “Geometry” menu bar, then to “Modify” and “Copy”.

The copying process is basically the same as the move process but the source objects do not move from their initial positions. New objects are created in the new location which are identical to the originals in size, shape and in the distance between them.

To make a copy, when the objects to be copied have been designated, two points need to be indicated, the base point and the move point.

As with the rest of the tools, a projection of these objects will be shown in the view to specify the view location the copied objects are to be inserted in.
When the copied objects are situated in their location, click on the view again to set their position.

To copy objects from the command console, write the command "copy" when you have selected the objects you wish to copy, input the first move point and then the second point.

For example, when the command and the first move point have been input (30,40), the projection of the figure being copied appears.

Input the second move point, (60, 40 in the example), and the new identical element will appear in the defined location.
8.2.8.3 Symmetry

This tool allows you to make a drawing which is symmetrical to the selected one. You can access this tool by clicking on the “Symmetry” button in the tool bar or by going to the “Geometry” menu bar, then to “Modify” and “Symmetry”.

To obtain a symmetrical drawing in gvSIG, firstly select the element and then select the “Symmetry” option. Then, click on the display graphic area to insert the first symmetry axis point. gvSIG will then create a red projection of a figure which is symmetrical to the selected figure. You can then input the second point the symmetry axis will pass through by clicking on the graphic area again.
If you wish to run the tool from the command line, firstly write the command “symmetry”. Input the first point the symmetry axis will pass through and press “Enter”. The console will then ask you to input a second point this axis has to pass through. Input the point and press “Enter” again.

The console will ask you if you wish to keep the source object, write “Y” if you wish to keep it and “N” if you do not.

8.2.8.4 Rotating

You can use this tool to rotate the selected objects by taking a base point as the centre. You can activate this tool by clicking on the “Rotate” button in the edition tool bar.
or by going to the "Geometry" menu bar, then to “Modify” and “Rotate”.

To rotate an element, first place the base point by clicking on the graphic area. Move the mouse, with the help of the projection that gvSIG uses to the effect, until the new position has been established.

Left click on the mouse in the view to define this point.

If you wish to rotate an element from the command console, select the object to be rotated, write the command “rotate” and input the first move point. Then input how much you wish to rotate it in sexagesimal degrees. The object will be rotated clockwise if you write a negative angle and anti-clockwise if you write a positive angle.
8.2.8.5 Scaling

This command can be used to modify the size of the selected objects. Select this tool by clicking on the “Scale” button in the tool bar

or by going to the "Geometry" menu bar then to "Modify" and “Scale”.

There are two ways of scaling, either by indicating a scale factor or by reference.

**Scaling by “Scale factor”**

To graphically scale elements using a scale factor, select the objects whose size you wish to modify, activate the scale tool and set the base point. The application will create an image which will give you a reference point about the size of the objects you are modifying. As you get closer to the point you have set as the base point, the elements you are working with will get smaller, whilst the farther away you move, the bigger they will get. When the objects are the desired size, click on the drawing window again. The same scale factor is applied for both the X and Y coordinates.

To graphically scale using the "Reference" option, select the objects and activate the "scale" command, then right click on the mouse inside the graphic area to show the tool's contextual menu. Select the “Reference” option. Indicate the points on the reference line and on the scale line as the messages in the command console are shown.
You can also use the “scale” command in the command console. When you have selected the objects to be scaled, write the command “scale” and then input the base point as shown in the following figure.

To increase the size of the objects you must input a scale factor which is greater than 1. If you wish to reduce the size of the objects, the scale factor must be between 0 and 1. If no value is input, gvSIG will use the scale factor 2 by default.

**Scaling by “Reference”**

If you wish to scale using the "Reference" option, select the elements you wish to scale, choose the base point, then input the letter "r" into the command console to indicate that scaling by reference will be used. Specify the source point and the final point of the reference straight line and then input the source point and final point of the scale line.
8.2.8.6 Moving Elements

This tool allows you to move the selected objects from one point to another in the view by indicating a move vector.

You can use this tool by selecting it from the tool bar by clicking on the "Move" button

or by going to the “Geometry” menu bar, then to “Modify” and "Move".
If you wish to move an element, select the object you wish to move and then activate the “Move” option. Click on the graphic area to define the move point.

gvSIG will create a red projection of the elements it is moving which can be used as a guide to position them in their new location.

When the element is located in the desired position, left click on the mouse again to define the new position.

To use the “move” command from the command console, write the command “move”. The console will show a message requesting a move point. Input the point.
Then input the second move point. Press “Enter” and the object will move to its new position.

8.2.8.7 Editing vertex

This tool allows you to go through the vertices of the selected objects easily and carry out other actions, such as adding a new vertex or deleting the vertex which is being edited. To access this tool, click on the “Edit vertex” button in the tool bar.

You can also access the tool by going to the “Geometry” menu bar then to “Modify” and “Edit vertex”.
To edit the vertices of a figure, select the figure and click on the “Edit vertex” button in the tool bar. A red pointer appears in one of the vertices of the figure you are editing.

If you right click on the mouse, a menu will appear from which you can select the actions you wish to carry out.
If you click on the “Next” option, the cursor will move to the next vertex of the selected object.
You can also access this tool from the command console. To do so, write the command: EDIT VERTEX.

If, for example, you wish to go through the vertices of an element, write the command and input the parameter “S” (next). To go to the previous vertex, write the parameter “A”. To delete a vertex write the parameter “E” and press “Enter”. To add (insert) a vertex, write the parameter “I” and press “Enter”. The X and Y coordinates of the new vertex will then be requested (remember that these coordinates should belong to the polygon perimeter). Input the data in the console and press “Enter”. A new vertex will be created in the figure.
8.2.8.8 Internal polygon

This tool allows you to create a polygonal feature inside an existing feature.

You can access this tool by going to the "Geometry" menu then to "Modify" and "Internal polygon"
or from the following tool bar button:

You can create an internal polygon, either graphically or from the gvSIG command console. If you wish to create the polygon graphically, the polygon element layer must be in editing mode and you must select the polygon on which you wish to use the selected tool. Activate the "Internal polygon" tool and place the cursor where you wish to insert the first vertex.

Then insert the vertices of the polygonal feature you wish to create.
When you do not wish to insert any more vertices, right click on the mouse and select “End” from the contextual menu that appears.
The corresponding internal polygon is created.

You can also use this tool from the command console. To do so, write the command “internal polygon” in the command line.

Then input the X and Y coordinates of the points which will correspond to the vertices of the new polygonal feature. When you have finished, write “e” to close the new internal polygon you have created.
8.2.9 Drawing commands

This section deals with gvSIG’s drawing commands. The rest of the commands can modify the elements but with the exception of the “copy” command, they cannot create new features and we thus require the actual drawing commands to do so.

gvSIG includes basic drawing elements, such as lines, circles or polygons, which can be used to obtain any complex drawings.

All the elements you wish to insert need one or several points to be specified so that they are correctly placed in the drawing.

Remember that the tools to insert new elements vary according to the type of layer being edited. Thus, for example, a point can only be inserted in a point-type layer and is not supported by any other type of layer.

8.2.9.1 Point

You can activate this tool by clicking on the “Point” button in the tool bar.
You can also activate it by going to the “Geometry” menu bar then to “Insert” and “Point”.

To insert a point, place the graphic cursor (cross hairs) in the graphic area in the place you wish to insert the point and left click on the mouse. The point will appear in the specified position.

To insert a point from the command console, write the command “point”. Input its coordinates and press “Enter”. The defined point will appear in the specified position.

You can also define a point based on the previously inserted point. To indicate that you are going to use relative coordinates, type in the “@” symbol before you input them, for example, inputting “@0.30<30” means you wish to insert a point which is 0,30 units and at a 30º angle from the previous point.
8.2.9.2 Multipoint

You can activate this tool by clicking on the “Multipoint” button in the tool bar

or by going to the “Geometry” menu bar then to “Insert” and “Multipoint”.

![Multipoint tool in tool bar and menu bar]

```plaintext
#Define point > 10.20.
#Insert point > @20<30.
#Insert point > .
```
You can use the multipoint tool to create a drawing made up of a series of points which function as a single feature (i.e. we only need to select one of the points for the rest to also be selected). You need to bear in mind that this is not thus a points layer but a multipoint layer.

To insert a multipoint in the graphic area, select the tool and place the cursor over the part of the graphic area you wish to place the point. Left click on the mouse to insert the point. Repeat this step as many times as you wish.

When you have finished adding points, right click on the mouse. A contextual menu will appear. Click on “End” to finish the new multipoint feature.

You can create a multipoint feature from the command console. To do so, write the command “multipoint”. Input the coordinates of each point you wish to add in the console and press “Enter”. To finish the insertion of the new multipoint feature, write the command “E”.
8.2.9.3 Line

This command allows you to draw a line feature, which is actually a straight line segment. This feature is limited by its initial and final points. The final point may be the start of the next segment. When the first point has been inserted an elastic line appears on the display. You can use the mouse to determine where you wish the final point to go. As with the rest of the editing tools, there are three ways to access line creation. You can go to the edition tool bar and click on the “Line” button

or go to the “Geometry” menu bar then to “Insert” and “Line”.
Place the cursor inside the graphic area and insert the line vertices in the desired points. gvSIG will create a projection from the last inserted point to the mouse pointer which you can use as a reference point to set the points in the drawing.

You can also draw a line from the command console. Write the command “line” and then input the coordinates to define the points which delimit the segments which make up the line.

You can also insert the second and/or successive points by defining a distance and an angle. For example, to insert a point 1 unit away from the previous point at a 45° angle, write 1<45.

The following image shows how a third point is inserted, after inserting the first and second points, one unit away from the previous point at a 180° angle.
8.2.9.4 Arc

You can draw an arc by clicking on the “Arc” button in the tool bar

or by going to the “Geometry” menu bar then to “Insert” and “Arc”.

Three points are requested to draw an arc. The first and last points mark the initial and final points of the arc and the second one marks an intermediate point through which the hypothetic circle of which the arc is a part would pass. To insert an arc from the command console, write the command “arc”. The three points required to define the arc will be requested one after another.
8.2.9.5 Polyline

This feature can be a set of arcs and/or segments combined by the user. You can draw a polyline by selecting the tool from the edition tool bar and clicking on the “Polyline” button

or by going to the “Geometry” menu bar then to “Insert” and “Polyline”.
The polyline allows you to insert straight lines in the graphic area, but these differ from standard lines in that they allow you to insert an arc from the last vertex, to which it will always be located at a tangent, and end the polyline thus creating a polygon. 
Click on the graphic area in the place you wish the first point of the polyline to be located and insert the following points by left clicking on the mouse in the places you wish to locate them.
If you wish to draw an arc, right click on the mouse and select the “Internal arc” option in the contextual menu.

When this option has been selected, gvSIG shows a projection of an arc from the last inserted vertex to the mouse pointer.
If you wish to insert more lines, go back to the contextual menu and select the “Internal line” option.

If you wish to close the figure so that a straight line is drawn from the last inserted point to the first point, select the “Close polyline” option.

To draw a polyline from the command console, write the command “polyline”. Input the coordinates of the source point. Then you can insert the second point or input one of the parameters to draw an arc “A”, or close the polyline “C”. When you have selected the arc option, you can draw more straight lines using the parameter “N”. The following image shows how the polyline draws a straight line from the arc's last vertex to the source, thus creating a closed figure after inputting the parameter “C”.

8.2.9.6 Polygon

This option allows you to draw regular polygons which will be handled as a closed polyline. As usual, there are three ways of activating the polygon command.

You can select this tool by going to the tool bar and clicking on the "Polygon" button.

The second option way of activating the tool is by going to the “Geometry” menu bar then to “Insert” and “Polygon”.

© 2007 Conselleria de Infraestructuras y Transporte
To graphically insert a polygon in the drawing, select the tool and then click inside the graphic area on the place you wish to position the polygon’s central point.

The application will generate a projection of the object. Move the mouse using the polygon projection as a reference point until it is the size you require, and click on the graphic area once again.

You can tell gvSIG if you wish the polygon you are drawing to be defined as inscribed or circumscribed in the circle. By default, the polygon will be inscribed in the circle. To modify this setting, define the central point of the polygon, right click on the mouse to open the contextual menu and select the desired option.
gvSIG also allows you to modify the number of sides you wish the polygon you are editing to have. To do so, select the polygon object and input the number of sides in the command console.

The third way to select this tool is from the command console. To draw a polygon from the command console, write the command “polygon”, specify the number of sides you wish the polygon to have, whether it should be drawn as inscribed or circumscribed (“I” or “C” respectively), and finally insert the radius, which must be delimited by indicating its length in the units in which the view is defined.

8.2.9.7 Rectangle

This allows you to draw a rectangle by indicating its diagonally opposite vertices.

Click on the “Rectangle” button in the tool bar.
You can also select the tool by going to the “Geometry” menu bar then to “Insert” and “Rectangle”.

To graphically draw a rectangle in the layer you are editing, select the tool and place the first vertex in the required position in the graphic area. The application will show a projection of the rectangle you are drawing. Move the mouse, choose the position for the vertex diagonally opposite the one you have already inserted and left click on the mouse to define it.

To work with the command console write the command “rectangle” and then input the
coordinates for the first vertex and the diagonally opposite vertex.

8.2.9.8 Square

A square is simply a rectangle with equal sides. To prevent possible mistakes when drawing the square, the application allows you to create a square based on a rectangle and makes it have equal sides. To draw a square, first select “Rectangle” and insert the first vertex, then right click on the mouse and click on the “Square” option (“Corner”) in the contextual menu.
The following figure shows an example of the creation of a square from the command console.

After the first point of the rectangle has been input, gvSIG is told to make the figure become a square by inputting the letter “C”. You can then insert the opposite corner.
If you make a mistake in inputting the coordinates the application will still draw a square by calculating the size of the vertical line (Y axis), using the coordinate specified for the X axis.

8.2.9.9 Circle

This command draws a circle inside the graphic area. You can select this tool by clicking on the “Circle” button in the tool bar or by going to the “Geometry” menu bar then to “Insert” and “Circle”, as shown in the figure below.

There are two ways of defining a circle.

The first option is to define the central point and the radius. Select the “Circle” tool and click on the graphic area in the place you wish to locate the centre of the circle you are drawing. Then move the mouse to increase the radius of the circle until it reaches the required size. gvSIG will, as always, create a projection of the circle as a reference point to show the position of the circle in the drawing.

The second way of drawing a circle in gvSIG is to define it by using three points.

To access this option to define a circle, first select the tool and then go to the contextual
menu by right clicking on the mouse in the graphic area.

There is only one circle that goes through three given points. When you use this option an elastic circle appears. It is defined by these two points and the cursor until we define the third point, as shown in the figure below.

You can also draw a circle from the command console using any of the methods described above for graphic drawing.
Write the command “circle” in the command console and press “Enter”. Insert the coordinates of the central point and then the coordinates of the point that will mark the desired radius or length (use the status bar to check whether you are working in metres or another measuring unit).
To insert a circle from the command console by defining three points, write “3p” when the “circle” command has been activated. When you use this option an elastic circle appears. It is defined by these two points and the cursor until we define the third point, as with the case of the graphic drawing of the circle.
The figure below shows how to create a three-point circle.
8.2.9.10 Ellipse

An ellipse is defined by an axis and the length of the second axis to the centre of the ellipse.
There are, as always, three ways of selecting the ellipse drawing tool. To graphically draw an ellipse you can click on the “Ellipse” button in the edition tool bar.

The second option is by going to the “Geometry” menu bar then to “Insert” and “Ellipse”.

---

June 2007
To graphically draw an ellipse, indicate the initial and final points of the ellipse’s axis by left clicking on the mouse in the corresponding places. When the initial point has been input an elastic line will be shown which can be used as a reference point to mark the final point of the axis. When it has been set the ellipse projection will be shown until the third point which marks the distance to the other axis is defined.
To draw an ellipse from the command console, write the command "ellipse". When gvSIG requests the initial point of the ellipse axis, indicate the point coordinates. It will then request the final point of the axis and finally the distance to the other axis.
8.3 Alphanumeric edition

A table is part of a data base. It is made up of rows or records and columns or fields which contain the alphanumeric information needed to characterise the elements (polygons, lines or points) which make up the theme maps, cartography in general and graphs. The rows represent elements or objects and the columns represent the variables or attributes associated with each element.
In general terms, there are two types of tables; “internal” tables which are typical of an information layer and are found in the same file and “external” tables which can be added to a gvSIG project.

Each element (point, line or polygon) of a layer only has one record in that layer’s table of attributes.

8.3.1 Editing session for an “internal” table.

- Open a “View” and add the layer you wish to work with.
- Remember that to start an alphanumeric editing process in gvSIG, you must put the layer you are working with in editing mode. In order to do this, select the layer in the ToC, go to the “Layer” menu and select “Start edition”.
- Select the “See table of attributes” button
or go to the “Layer” menu and select “See table of attributes”.

The table associated with the layer will be automatically added to the project.

If you go to the “Project Manager” and select the “Tables” type of document, you can check that the table shown in the view is included as a separate document in the project.

- To finish the table editing session, go to the “Layer” menu and select “Finish edition”. When the session finishes a message appears asking if you would like to save the changes. Click on “Yes” to save all the changes made in the table.

### 8.3.2 Editing session for an “external” table.

- Go to the gvSIG’s “Project Manager”, and select the “Tables” type of document.
- Click on “New”.
- Click on “Add” and open the table you wish to edit.
- When you click on “Open” the table is displayed automatically on the screen.
- Go to the “Table” menu and select “Start edition”.
8.3.3 Editing a layer’s table of attributes

8.3.3.1 Adding a record

To add a new record to a table associated with a layer, a graphic element must be inserted. When an element is added to the associated table a new blank record appears.
Enter the data for the new entity and press “Enter”.

N.B.: Remember that if you wish to delete the selection, you can go to the tool bar and click on “Clear selection” or you can use the menu bar by clicking on the “Layer” menu and then on “Clear selection”.

N.B.: You can create a new layer with the elements selected in the table if you wish. To do so, close the table, go to the menu bar and click on the “Layer” option and then on “Export to...”. Then select the format you wish to create the new layer with.

8.3.3.2 Modifying a record

To modify the data of a layer element saved in the table, select the element whose data you wish to modify. The record that corresponds to the selected graphic element is highlighted in yellow in the table of attributes.
8.3.3.3 Removing a record

To remove a record from the table, you must first select the record.

Go to the “Table” menu and select “Remove row”.

Left click on the cell in which the record to be modified is located. The record changes and a cursor appears to indicate that the data can be input.
The selected record is deleted from the table and the associated graphic element disappears from the view.
8.3.4 Managing fields

This tool allows you to add, delete or rename fields.
To access this tool, go to the “Table” menu and select “Manage fields”.

(*An error occurs when you try to change the structure of a table hosted in a postgresql database above version 7.4. To modify the structure, use a suitable data base manager).

<table>
<thead>
<tr>
<th>Table</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Join</td>
<td></td>
</tr>
<tr>
<td>Link</td>
<td></td>
</tr>
<tr>
<td>Redo</td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td></td>
</tr>
<tr>
<td>Insert row</td>
<td></td>
</tr>
<tr>
<td>Remove row</td>
<td></td>
</tr>
<tr>
<td><strong>Manage fields</strong></td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td></td>
</tr>
<tr>
<td>Ascending order</td>
<td></td>
</tr>
<tr>
<td>Descending order</td>
<td></td>
</tr>
<tr>
<td>Statistics</td>
<td></td>
</tr>
<tr>
<td>Move selection to top</td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td></td>
</tr>
<tr>
<td>Remove joins</td>
<td></td>
</tr>
<tr>
<td>Remove links</td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td></td>
</tr>
</tbody>
</table>

When the menu option is selected, a window appears in which the fields of the selected table and the buttons to create a new field or delete or rename an existing field are included.
If you click on “New field”, a new window appears in which some of the properties of the new field to be added to the table can be configured.

- **Field name**: Enter the name of the new field.
- **Type**: If you click on the arrow on the right, a pull-down menu appears in which the type of field data (string, double...) can be configured.
- **Length**: Indicate the required length of the field. Debe tener en cuenta que el tamaño máximo para un campo de tipo string es 254.
• **Precision:** Indicates the number of decimals a numerical field must have (only for numerical type fields).

• **Default value:** Indicates the default value for the field when no specific value is defined in the table.

If you wish to use the delete tool (“Delete field”) and the renaming tool (“Rename field”), simply select the field to be modified and click on the corresponding button.

### 9 Geoprocessing tools

#### 9.1 Introduction

The gvSIG geoprocessing extension allows you to apply a series of standard processes to the vector information layers loaded in the layer tree in a gvSIG view (ToC), thus creating new vector information layers which will provide new information for the source layers.

The following geoprocesses have been implemented in the first version of the geoprocessing extension:

- Buffer.
- Clip.
- Dissolve (by adjacents and alphanumerical criteria).
- Merge.
- Intersection.
- Join.
- Spatial Join.
- Convex Hull (minimum convex polygon).
- Difference.

The output layer can take one of the output formats supported by gvSIG (it can only be saved in shp format at the moment).

To start the geoprocess wizard, click on the “Geoprocesses“ icon in the tool bar
or go to the menu bar and select the “View” option, then “Geoprocess toolbox”.

The geoprocess toolbox window will appear.
If you click on each of the tree nodes, the different geoprocesses will drop down.
When a geoprocess has been selected, a description of the process will be shown on the right hand side and the "Open Geoprocess" button will be enabled.

When you find the geoprocess you wish to run, select it in the geoprocess tree and click on the “Open geoprocess” button.

When some geoprocessing tools are applied (for example, Clip) a window appears in which a spatial index can be created for the input layer. This is an internal process which is only carried out once per layer and per new project and speeds up the spatial intersection processes.

To create a spatial index for the input layer which can be used by the geoprocesses, click
9.2 Accessing the geoprocesses

You can run the geoprocesses available in gvSIG with the geoprocessing wizard by clicking on the following tool bar button:

The “Geoprocess toolbox” will appear and you can use it to select the geoprocess you require.

To access the different geoprocesses, pull down the tree in the window shown below (double click with the left button of the mouse on the "Geoprocesses" folder and the rest of the folders will appear).

When you have found the geoprocess you wish to use, click on the “Open geoprocess” button.
9.3 Buffer

9.3.1 Introduction

This geoprocess generates “areas of influence” around the vector element geometries (points, lines and polygons) of an “input layer”, thus creating a new polygon vector layer.

Several equidistant concentric radial rings can be generated around the input geometries. Moreover, in the case of polygon input geometries, the area of influence can be outside the polygon, inside the polygon or both inside and outside it.

Some examples of the creation of areas of influence include:

- Which urban areas lack schools in a 1000m radius.
- Which wells do not comply with regulations on observing the minimum distance between two consecutive wells.
- River bed flood zones to monitor flood risks.
9.3.2 Creating an area of influence or buffer

When you click on the “Geoprocessing wizard” button, the following dialogue appears:

If you select “Buffer” and click on the “Open geoprocess” button, the window associated with this process is shown:

This geoprocess creates a new polygon layer, with polygon buffers of the geometries of the input layer.

Input layer geometries could have any geometry type (point, line or polygon). For each input geometry, you could create one or many equidistant polygon buffer rings. Also, if input geometry type is polygon, the buffer could be internal, external or both.
The form is divided into the following parts:

- **Selecting the elements whose buffer is to be computed.** This is a pull-down list in which you can select the vector layer the calculation is to be applied to. If you wish, you can enable the “Use selected features only” check box so that the process only computes the buffer of the elements currently selected in the specified layer.
• **Inputting the features of the buffer to be computed.** You can choose to input the buffer defined by distance (in the first text box) or to input a field in the input layer, from which the buffer radius value to be applied will be taken. This second option allows you to apply different buffer radii to different vector elements (whilst the first option applies the same radius to all the elements in the input layer).

When the buffer of all the input layer elements has been generated, the “Dissolve features” option allows you to merge the elements whose geometries touch each other in a second iteration.

The “Rectangle end cap” option allows you to generate buffers with perpendicular edges (not rounded).

• **Selecting the number of concentric buffers and their situation regarding the original geometry.** The gvSIG “Buffer” geoprocess allows you to generate several equidistant areas of influence of the original geometry (for example, if the buffer distance to be applied is 200m and you choose to generate two concentric radial rings, the buffer distance of the second ring will be between 200-400m. Currently, you can only generate a maximum of three concentric radial buffer rings for efficiency reasons.

If the vector layer we are working on is a polygon layer, the “Create Buffer…” option will be enabled, thus allowing the user to generate buffers outside, inside and both inside and outside the original polygon.

• **Introducing the result layer characteristics.** Currently, the result of running a geoprocess can only be saved as an shp file. Thus, gvSIG allows you to select an existing shp file to overwrite it or to specify a new one. As new formats are supported to save the result of the geoprocesses, wizards will be provided to
indicate the characteristics of these formats.

When you have input all the necessary information to compute the buffer, and clicked on the “Ok” button, a check routine is carried out to ensure that the information input is correct: whether the radius distance is numerical, whether the attribute from which the buffer radii are taken are numerical, whether a result file has been input, etc. If the check routine is not correct, a dialogue box appears so that the input data can be corrected.

If the input information that you have entered is correct, a window with a progress bar appears, in which the buffer processing rate is shown.

The process can be cancelled at any time by clicking on the “Cancel” button. As a consequence, the result file and any other intermediate product generated as a result of running the process are deleted.

Whilst the buffer computing process is underway, other tasks can be carried out, such as changing the zoom or adding new layers to the layer tree in the gvSIG view. Other tasks can be carried out because all the geoprocessing extension geoprocesses are run in the background.

When the process has finished, the new result layer is added to the layer tree in the active view. It is made up of buffer polygons with a specified radius based on the source layer.
Finally, the “Dissolve elements” option can be useful in specific situations (such as when the aim of computing the buffer polygons is to determine the total surface area affected by a phenomenon: quarantine areas, etc.), because when the generated polygons are merged the surface area covered by the buffer will be a real surface area, i.e. the sum of two buffers will not have any overlays.

The above image shows non-merged overlay polygons. The total area covered by the phenomenon does not coincide with the sum of the individual areas.
However, this second image shows merged overlay polygons. The total area covered by the phenomenon is real.

When the buffer computing process includes the merger of overlay areas (dissolve) we cannot predict its exact duration (we do not know how many polygons will touch each other a priori). This is why the gvSIG geoprocessing extension does not show us a progress bar as such, it shows us a bar which periodically reaches the end and then goes back to the beginning. This type of process is called an “indeterminate” process.

9.4 Clipping

9.4.1 Introduction

This geoprocess allows you to limit the working area of a vector layer (points, lines or polygons), and to extract an area of interest from it.
To do so, you need an “input layer” (the layer you will use to extract an area) and a “clipping layer” so that the union of the geometries included in the “clipping layer” defines the working area.

The geoprocess checks all the vector elements in the “input layer” and will calculate the intersections for the vector elements contained in the working area defined by the “clipping layer”, so that in the “result layer” only the vector elements of our working area will appear. The geometry portion that lies outside the working area will be clipped.

The alphanumeric schema of the input layer remains intact.

Examples of use:

• Setting up a local GIS would allow you to include national or regional maps and then to delimit the city or town as the working area.

9.4.2 Clipping

When the “Clip” geoprocess has been selected, the following dialogue appears.
This dialogue allows you to select which layer you wish to clip, and gives you the chance to only clip the elements which are selected in the layer.

It allows you to select which layer will be used as the clipping layer and whether you wish to use the union of all the polygons in the clipping layer as the clipping polygon or just the selected elements.

Finally, as in the case of the other geoprocesses in gvSIG's geoprocessing extension, you can define how the result layer will be saved (at present you can only save it as a shp file).
As a result of running the geoprocess, you will have a new layer in which only the geometries which came under the union of the clipping geometries have been kept.

9.5  Dissolve

9.5.1  Introduction

This geoprocess only acts on one “input layer” whose geometry must be a polygon type. The process analyses each polygon in the “input layer” and merges the polygons that have an identical value for a specific field into one polygon. Moreover, it allows you to involve spatial criteria in the decision to merge several polygons. This allows you to establish that for two polygons to be merged, they must be adjacent to each other in addition to having the same value in the specified attribute.
Example:

- We have a polygon layer which represents the municipalities of a particular autonomous region and we need a polygon layer with the provinces which make up this region. We can generate a province layer by launching the “Dissolve” geoprocess and specifying that the polygons that have the same value for the "PROV" field in which a unique code for the province is specified are merged.

### 9.5.2 Running the “Dissolve” geoprocess

Using the previous example, we start by taking a "local layer" which we wish to convert into a "provincial layer".
When the "Dissolve" geoprocess has been selected, the following window appears:
Firstly, select the layer you wish to dissolve (you can only work with a selection of elements in this layer).

You then need to specify the attribute of this layer which is going to be used as the criterion to merge the adjacent polygons. In our example, we must choose the “PROV” attribute.
The polygons to be merged must have the same value for the dissolving attribute and in addition, you can choose whether they are adjacent to each other (spatial criteria). If you wish to choose this option, enable the "Only dissolve adjacents" check box.

The gvSIG geoprocessing module allows you to keep a summary of the input layer polygon attributes once they have been merged. To do so, the “Summary function” concept is introduced. As each polygon of the “Dissolve” geoprocess result layer is the product of joining several input layer polygons, a summary function on the numerical attributes of the merged polygons can be applied.

If you click on the button with the "<-" icon, a dialogue will be shown in which you can choose one of several summary functions for a selected attribute.

The summary functions supported are maximum, minimum, average and summatory. A field will be included in the result layer for each summary function selected for the
numerical attributes you have selected a summary function for.

When you have specified the field you wish to merge and the numerical attributes you wish to obtain a summary value for in the result layer, you are ready to run the geoprocess.

9.6 Merge

9.6.1 Introduction

This geoprocess acts on one or several layers, generating a new layer which joins all the geometries in the “input layer”. The “result layer” of this geoprocess will keep the attributes of the “input layer” specified by the user. For the rest of the layers which have not been selected, the attributes whose name and type of data coincide with any of the attributes in the selected layer will be kept.
Example:

- When a cartographic series arrives which is separated into sheets and you wish to join the content of the different sheets in one layer. This is the case of the Magna series of sheets, published by the Spanish Technological and Geomining Institute (ITGME).

### 9.6.2 Running the “Merge” geoprocess

If you select the “Merge” geoprocess, the following dialogue appears:
The geoprocess allows any of the layers loaded in the layer tree in the gvSIG active view as an input layer.

To run the process, first select the layers you wish to merge in the "Input layers" text box. Then, click on the "Select" button. A new window will open in which you can give the new layer file a name or choose a target file.
Click on the "Save" button when you have finished and gvSIG will return you to the geoprocess window.
Click on the "Ok" button. This will start the geoprocess.

A new layer will be created at the end of the process which will be added to the view.
However, in the example of the sheets in a cartographic series, it would be awkward to load all the pages in the series one by one. Thus, there is an extra option to select a directory and to add all the layer files (with extensions supported by gvSIG) contained in this directory to the geoprocess input layer list. The only layer files currently supported are shp format files.

If you click on the “Folder with files...” button and select a directory, a list of the layer files contained in it are shown and can be selected as part of the geoprocess input layers.

Until you select at least one layer to merge with one of the two possible lists (the layer list in the gvSIG layer tree and the layer list contained in the specified directory), no layer will be shown in the pull-down list. This list allows you to select which layer is going to define the attributes of the result layer’s attributes.

When you select the layers to merge in one of the two lists, the layer whose attributes we
wish the result layer to have and when you have specified the file you wish to save the result layer in, you can run the geoprocess. An initial requirement is that all the geoprocess input layers have the same type of geometries.

The result will be a new layer with all the input layer geometries.

9.7 Convex hull

9.7.1 Introduction

This geoprocess calculates the “Convex hull”, or the smallest convex polygon which surrounds all the vector elements in an “input layer”.

It only works with an “input layer” whose geometry type can be any type (point, line or polygon).

There are different types of applications for this geoprocess:

- Determining the coverage area for a specific geographical phenomenon.
- Calculating the diameter of the area covered by a series of geometries, etc.

9.7.2 Creating a convex hull

If you select the “Convex hull” geoprocess, the following dialogue appears:
After selecting the layer whose “Convex Hull” you wish to calculate and specifying an shp result file, you can run the geoprocess and generate a new result layer.

The following image shows the convex hull created which surrounds all the points in the input layer.
9.8 Intersection

9.8.1 Introduction

This geoprocess operates on two layers, the “input layer” and the “overlay layer”, whose geometries must be polygons.

It calculates the intersection with the different geometries in the “overlay layer” for each geometry in the “input layer”, thus creating a new element for each intersection. This element will take all the alphanumerical attributes in the geometries that created it (input and overlay). This is why (it models space areas which comply with the condition of belonging to the two polygons that created it) this geoprocess is known as “Spatial AND” operator.

An example of how this geoprocess can be applied:
• Given a land use layer (e.g. Corine2000), and a national geological map layer, you can obtain a polygon layer with homogeneous information on land use and geological material.

9.8.2 Running the “Intersection” geoprocess

After selecting the "Intersection" geoprocess, the following dialogue appears:

Select the input layer and the overlay layer. You must also specify a file in which to save the results. Finally, click on "Ok" and the geoprocess will be run.

In this case, we will use a very simple example to better understand the function of the geoprocess. The previous figure shows two overlaying polygons. The result of launching
the “Intersection” geoprocess with these layers as parameters is as follows:

![Diagram showing the Intersection geoprocess]

### 9.9 Difference

#### 9.9.1 Introduction

The “Difference” geoprocess works with two layers, the “input layer” and the “overlay layer”. It is known as “Spatial NOT” and allows you to obtain the areas in a layer which are not present in the other layer.

The geometries in both the “input layer” and the “overlay layer” must be polygons. The alphanumerical schema of the “input layer” will remain intact in the "result layer", as in the end it gives more information about it.
This geoprocess is very useful in numerous situations. For example, it can be used to complement the "Clip" geoprocess. If "Clip" allows you to exclude everything that does not belong to a geographical area under study, "Difference" allows you to do exactly the opposite; exclude a specific area from our working layer.

A useful example:

- Transferring territorial jurisdiction between different governing bodies. Thus, if the national government transfers certain jurisdiction to a regional authority, it can decide to exclude the geographical area of the transfer in question from its data bases.

**9.9.2 Running the “Difference” geoprocess**

Click on the “Open Geoprocess" button to access the dialogue window which allows you to run the "Difference" geoprocess.
You can enable the “selected features” check boxes at this point of the geoprocess for the input layer and the overlay layer. If you click on the “Ok” button, the geoprocess will be run.

In the following image, the “Difference” geometry appears in black between a flood zone
and one of the selected cities or towns.
In this case, the new layer resulting from the calculation of the difference will take the
schema (alphanumerical attributes) of the geoprocess input layer.

9.10 Union

9.10.1 Introduction
This geoprocess is similar to the “Intersection” and "Difference" geoprocesses in that it
operates on two polygon layers to obtain their intersections (this is why these three
ggeoprocesses are known as “overlay geoprocesses”).
The “Union” geoprocess is known as “Spatial OR”, because the result layer is made up of the geometries which appear in the two layers (intersections between the polygons), plus the geometries which only appear in one of the two associated layers. This means that the geoprocess carries out three analyses: the first time it calculates the intersection of both layers, the second time it calculates differences between the first layer and the second, and the third time it calculates the differences between the second layer and the first.

This geoprocess may be of interest if you wish to generate new layers which show the occurrence of two phenomena so that the occurrence of one of the two or of both is highlighted.

### 9.10.2 Running the “Union” geoprocess

If you select the “Union” option, the following dialogue appears:
When you have selected the input layer, the clip layer and an output layer, click on "Ok".

The result layer will have all the intersections and differences between the two layers. If you click on the “Information” button and then on the different polygons in the result layer, you will see that the intersections have all the attributes, whilst the differences only have
the attributes of the layer that created them.

9.11 Spatial Join

9.11.1 Introduction

This geoprocess allows you to transfer the attributes of one layer to another based on a common element. In contrast to the join sql operator in the relational data bases, in this case, the common element is not that a field of the two tables takes the same value, but that the related elements in the two layers meet some spatial criteria.

The “Spatial join” geoprocess allows you to follow two types of spatial criteria to establish the spatial link:

- Nearest neighbour (1->1 relationship). This assigns the attributes of the nearest
element in the related layer to an element in the source layer. If the nearest element intersects (or in the case of polygons is “Contained in”) with the source element, the algorithm will take the first element analysed in the possible intersections.

- **Contained in (1-M relationship).** This relates an element in the source layer with several elements in the destination layer (in particular, with those that intersect). In this case, the source layer will not inherit the related layer’s attributes, but the operation will be very similar to the “Dissolve” geoprocess. The user can choose one or several summary functions (average, minimum, maximum, summatory) to be applied on the numerical attributes of the related layer for the M elements related to an element in the source layer.

### 9.11.2 Running a “Spatial Join”

When you have selected the "Spatial join" option, the following window appears:

![Spatial Join Window](image)

This window is practically the same as the windows in the overlay geoprocesses (Union, Difference, Intersection) with one difference. It allows you to choose whether you want to run a 1-1 relationship (using the nearest neighbour spatial criterion) or run a 1-N relationship (using the “Intersect” or “Contained in” spatial criterion). The choice can be made by enabling or disabling the "Use nearest geometry" check box.
If when you have selected the source layer and the layer to be related, the geoprocess is launched and you have not enabled the "Use nearest geometry" check box, a window appears in which you can select the summary functions you wish to apply for each numerical attribute of the layer to be related:

![Group by functions window](image)

The summary functions are the same as in the “Dissolve” geoprocess:

![Group by functions window](image)

Thus, the attributes transferred to the source layer will be the result of the summary functions selected for each numerical field. If you run the geoprocess and the “Use nearest geometry” option is enabled, this window does not appear.
9.12 2D Translation

9.12.1 Introduction

This geoprocess allows a translation transformation to be applied to all the points, lines and polygons of the geometries in the input layer. The geoprocess can be applied to all types of vector layers (shp, dgn, dxf...). To do so, the movement on X and Y must be specified.

This geoprocess is extremely useful when combining cartographies which come from different sources, a process which is referred to as conflation.

Bear in mind that although translations can be carried out on all types of vector layers (shp, dgn, dxf, dwg...), the resulting output layer will always be a shape file. In other words, the input layer can be a shp, dxf or dgn file, but when translation is applied to these layers, the result will be one or various different output layers which are always shape files.

When a translation is carried out in which the input layer is a vector layer which is not a shape file, the result of the translation will be three layers in SHP format (one line layer, one point layer and one polygon layer).

If, for example, the input layer to which the translation is applied contains only points and lines, the polygon .shp file will be created but it will be empty.

NB. At the end of this section there is a table giving details of the relationship between the
type of input file and the resulting output layer.

9.12.2 Translating a vector layer

Firstly, load a vector layer in gvSIG and then click on the geoprocessing wizard in the tool bar.

Select the option “2D Translation” from the “Data Conversion” folder.

Click on the “Open Geoprocess” button and the geoprocess data input window opens.

For the input layer, select the vector layer (dgn, dxf, dwg, shp...) you wish to translate and introduce the values corresponding to X and Y.

Select an output layer and click on “Ok”.

The following image shows the result of applying the translation process.
**Relationship between the type of layer before and after translation.**

<table>
<thead>
<tr>
<th>Input layer</th>
<th>Output layer/s</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point Shp file</td>
<td>Point Shp file</td>
</tr>
<tr>
<td>Multipoint Shp file</td>
<td>Multipoint Shp file</td>
</tr>
<tr>
<td>Line Shp file</td>
<td>Line Shp file</td>
</tr>
<tr>
<td>Polygon Shp file</td>
<td>Polygon Shp file</td>
</tr>
<tr>
<td>Dxf (points, lines, polygons)</td>
<td>Point Shp file</td>
</tr>
<tr>
<td>Dgn (points, lines, polygons)</td>
<td>Point Shp file</td>
</tr>
<tr>
<td>Dwg (points, lines, polygons)</td>
<td>Point Shp file</td>
</tr>
</tbody>
</table>
9.13 Reprojection

9.13.1 Introduction

This geoprocess allows you to change the geodesic projection of the vector elements in the input layer. In order to do so, the user must specify the new projection to be applied. This process is extremely useful when standardising cartographies in the same project if these are in different projections.

9.13.2 Reprojection of a layer

Click on the geoprocessing wizard in the tool bar and select the “Reproject” option from the “Data conversion” folder.

Click on “Open geoprocess”. The wizard will open to guide you through the reprojection process.

In “Input layer”, select the layer you wish to reproject from the layers loaded in the ToC.

To select the new projection for the layer, click on the button next to the destination projection and select the new reference system.
10 Maps

“Map” type documents allow you to design and combine all the elements you wish to have on a printed map.

10.1 Accessing maps

You can access “Map” type documents via gvSIG’s “Project manager”.

![Herramientas de análisis window](image)
Click on “New” to create a new map.

When you have created the document (it will appear by default as “Untitled– 0”), you will be able to insert elements, rename the map, delete it or access its properties and modify them. When the map is open, it will appear in gvSIG as shown below:
10.2 Map properties

You can access the map properties window from the “Project manager” by clicking on the “Properties” button or from the view by going to the “Map” menu and then to “Properties”.
You can use the properties window to rename the map, change its creation date, add an owner and comments.

You can select some default characteristics by activating the corresponding check boxes:

- **Active grid**: Activating the grid means that any element inserted in the map will be adjusted to the grid. Remember the following two points if you enable “Active grid”:
  1. The horizontal and vertical grid spacing defines the distance between the different points which make up the grid. This can be modified by inserting new values in the text boxes.
  2. Output size of the chosen document (A2, A3, A4,...). The zoom tools may need to be used to be able to view the grid when you open the document.

- **Visualise grid**: If this box is disabled, the grid will not be viewed when you open the newly created document.

- **Enable ruler**: By enabling this check box a ruler appears which can be used as a drawing aid.
• **Editable:** If you do not enable this option, the objects that make up the map will be blocked, thus preventing modifications.

## 10.3 Preparing a page

You can use this tool to define the working area, i.e. the size and properties of the page to be used for the map layout.

You can access this tool by clicking on the “Configure page” button in the tool bar or from the menu bar by selecting the “Map” option and then “Prepare page”.

When you have selected the tool a new window will appear:
• **Page size**: The pull-down menu allows you to define the source and size of the paper to be used to print the map. You can select a standard size or define your own.

• **Measuring units**: You can select the units of measurement for the page Height and Width.

• **Orientation**: This defines whether the paper will be printed horizontally or vertically.

• **Margins**: This allows you to define the page’s four margins. The ruler is adjusted to fit in with the page margins.

• **Resolution of the result**: You can choose between high, low and normal resolution.

When you have finished configuring the page, click on the “Ok” button.

### 10.4 Inserting elements in a map

gvSIG can be used to add the following cartographic elements to a map:

- Views
- Images
- Scale bars
- Legends
- Graphic objects
- North
- Texts
- Boxes

Many of these cartographic elements are closely linked to the “View” document, so that when changes are made in the view, they are shown in the map (changes in zooms, panning, legend modifications, layer organisation, etc.).

You can access the different options from the tool bar or by going to the “Map” menu and then to “Insert”.
10.4.1 View

You can insert a view in the map by clicking on the “Insert View” button in the tool bar. Place the mouse pointer on one of the vertexes of the rectangle which define the view area, left click and drag the pointer to the opposite vertex and drop.

A dialogue box appears in which you can define the view-type element properties you have just inserted.
- View: You can use the text box to select the view you wish to insert, if there is more than one.

- Active link: If this check box is enabled, any changes made in the view (changing colour, adding a layer…) will be shown in the map. Remember that scale changes will not be affected by this check box, because these modifications are regulated by the scale pull-down menu which appears below.

- Scale: Select one of the following three scale types:
  - Automatic: If this option is chosen, any scale change made in the view will automatically be shown on the map.
  - Keep visualisation scale: In this case, although you change the view frame in the map, the layer associated with the view will not resize itself and will keep the same size it has in the view.
  - User-defined: This option allows you to define a specific scale.

- Quality: This defines the visualisation, as either presentation or draft quality.

- Degrees: This allows you to specify a degree of rotation when the view is inserted in the map. This option also appears in the rest of the elements that can be inserted: images, scales, legends and texts.
10.4.2 Legend

The legend represents the visible layers of the ToC in the selected view. If a legend is inserted, it is added in the same order as it appears in the ToC.

![Legend Dialogue Box](image)

In the view frame, select the view the legend is associated with. The order in which the legends in the ToC will be added appears in the panel on the right.

10.4.3 Scale

![Scale Dialogue Box](image)

This tool allows you to insert a scale (associated with the view) in the map. The scale bar dialogue box is shown below:
• **View frame**: Select the view, if there is more than one, the inserted scale is related to.

• **Bar**: Select the type of scale you wish to insert (numeric or graphic). By clicking on the pull-down menu, you can see the different options with which the scale to be inserted in the map can be shown.

• **Intervals**: Select the number of intervals, what each one represents and the number of divisions to the left of the 0 that you require in the interval.

• **Scale**: You can use this section to make the numeric scale appear above the bar.

• **Units**: This defines the graphic scale units of measurement (metres, Km., etc.).
• **Labels:** You can use this box to select the label colour, font and location (numeric scale, units…).

### 10.4.4 North symbol

If you click on the “Insert “North” button in the tool bar, you can insert a “North” symbol in the map. Place the mouse pointer on one of the vertexes of the rectangle which define the space to be occupied by the symbol, left click, then drag the pointer to the opposite vertexes and drop. A dialogue box appears in which you can choose between several default North symbols.

You can add new symbols by copying them in the folder:

`bin/gvSIG/extensiones/com.iver.cit.gvsig/northimages`

of the folder you have installed gvSIG in.
The acceptable format for North symbols is SVG (Scalable Vector Graphics).

To add a new North symbol you will need to use an external application (such as Inkscape http://www.inkscape.org). Moreover, in order to ensure that the new North symbol will be correctly processed by gvSIG, it is better to base it on one of the default symbols suggested by gvSIG.

10.4.5 Box

gvSIG has a tool which allows you to insert a box in the map.

If you wish to insert a box, select the following button from the tool bar:

![Box Icon]

Left click on the map area you wish to insert the object in and drag it to create a frame which will define the future box size.

When you drop it, a window will automatically appear for you to define some of the box properties.

![Box Properties Window]

10.4.6 Image
You can use this tool to insert an image in the map. You can access this tool by clicking on the “Insert image” button or by going to the “Map” menu bar, then to “Insert” and then to “Image”.

If you activate this tool and create the frame to insert the image on the map (similar to “Insert view”), the following dialogue box will appear:

If you click on the “Browse” button, you can select the file path of the image to be inserted. You can insert an image in any of the following formats: jpeg, jpg, gif, png and bmp.

From gvSIG version 0.4 onwards, you can add vector files in SVG format to the map.

10.4.7 Texts

Texts, which can also be inserted by clicking on the corresponding button in the tool bar or by selecting “Maps” then “Insert” and then “Text”, are defined in the following dialogue box.
You can write the text you wish to appear in the map in the text box.

**Align**: This can be used to select the alignment type (left, centred or right respectively).

**Font**: This can be used to select the font type. You can also set the font size by activating the corresponding check box and specifying the required size in the text box.

**Degrees**: This defines the text slope, from the horizontal axis.

**Frame**: This allows you to define a border around the text you are using.

**Text field title**: You can also define a title for the corresponding border.

### 10.4.8 Graphics

You can insert the following types of graphic elements:
Points
Rectangles
Circles
Lines
Polylines
Polygons

All these elements can be inserted by going to “Insert” in the “Map” menu or by clicking on the corresponding button in the tool bar.

If you wish to insert a graphic element, left click on the map in the place you wish the graphic element to be inserted in.
10.4.8.1 Editing graphic elements in a map

When you have inserted a graphic element, you can edit its vertexes.

You can access this tool by going to the "Map" menu, then to "Edit" and then to “Edit vertexes” or from the following tool bar button.

If you wish to edit a vertex in a graphic element, select the element from the map and go to the tool.

10.5 Undoing / Redoing

These tools allow you to undo actions you have taken on the map or redo the actions you have previously undone.

You can access these tools by clicking on the “Undo” (left-facing arrow) or “Redo” (right-facing arrow) buttons

or by going to the menu bar and selecting the “Map” option.

You can also undo several actions by using the command stack. This tool allows you to view the actions you have carried out on the map and decide which point you wish to continue working from. The advantage of this tool is that you can undo or redo several actions at the same time. However, you cannot undo a specific action, i.e. if you take six actions, you cannot undo just the fourth one. The sixth and the fifth action will also be undone.

You can also access this tool by clicking on the command stack button in the tool bar
or by going to the “Map” menu bar and then to “Command stack”.

### 10.6 Deleting a selection

You can delete any of the elements selected in the “Map” by clicking on the “Delete selection” button in the tool bar.

### 10.7 Map-inserted element properties

When the elements have been inserted in a map, you can access its properties. Select the element. Right click to show its contextual menu and select "Properties".

#### 10.7.1 Aligning

You can access this tool by going to the “Map” menu, then to “Graphics” and to “Align”. This tool can be used to modify the alignment, distribution and size of the map elements selected.
• **In the layout:** If this button is enabled, the tools in the "Align" menu will use the map limits as a reference. If it is disabled, the selection will be used as the reference.

• **Alignment:** The tools in this section allow you to align the selected graphics (place a series of objects on the same axis) according to your needs (left, horizontally centred, right, top, vertically centred and bottom).

• **Distribution:** This allows you to space out objects at equal distances over a specific area.

• **Match size:** This allows you to modify the size of a selected object, using another object as a reference. The adjustments are made based on the largest object in the selection.

  The object sizes can be made to coincide in width, height or both.

• **Space:** This allows the selected elements to be “spatially distributed”.

  If, for example, you decide to spatially distribute two selected elements in the map (using the active "In the layout" button), the objects will be moved to the same distance from the map’s left and right-hand margins when you click on the first option.

  If we click on the second button, the images will be moved to the same distance from the top and bottom margins.

### 10.7.2 Grouping / Ungrouping

You can access this tool from the tool bar by clicking on the buttons.
or by going to the “Map” menu, then to “Graphics” and to “Group” or “Ungroup”.

10.7.3 Simplifying the legend

When a legend has been inserted and selected in a map, this option can be accessed by going to the “Map” menu, then to “Graphics” and to “Simplify legend” or from the contextual menu (right click on the selected element) by selecting “Simplify legend”.

When the legend has been simplified, it loses its link to the view. This means that any modifications made in the gvSIG view will not affect the legend.

If you wish to group the legend again, select the “Group graphics” option.

10.7.4 Viewing order

You can access this tool by going to the “Map” menu then to “Graphics” and then to “Bring to front” or “Send to back” respectively or from the tool bar by clicking on the following buttons:
You can use this option to change the viewing order of the selected elements in the map by bringing them to the front or sending them to the back.

### 10.7.5 Graphic line

This tool draws a frame around a selected element or elements. You can access this tool from the tool bar by clicking on the following button:

![Graphic line button](image)

or by going to the “Map” menu and then to “Graphics” and "Graphic line". The available options are shown in the following dialogue box:

![Graphic line settings dialog](image)

The different options include a check box which allows you to group the graphic line and the object you have inserted in the map so that they make one single element and not two separate ones.
If you click on the “Configure” button, another dialogue box appears which can be used to define the properties of the graphic line or frame to be inserted. Select the properties and click on the “Ok” button if you wish to use the new configuration or "Cancel" if you wish to maintain the default values.

![Graphic properties dialogue box]

10.7.6 Size and position

You can access this tool by going to the tool bar and clicking on the following button

![Tool button]

or by going to the “Map” menu then to “Graphics” and to “Size/Position”.

This tool opens a dialogue box which allows you to specify the size and position of the selected element.
You can edit the different text fields and modify and specify the object’s size and position.

10.8 **Tools for navigating in a map**

You can use these tools to move around and zoom in and out of the maps page.

You can access the tool from the tool bar or by going to the “Map” menu and then to “Navigation”.

- **Zoom in**: This allows you to zoom into the page.
- **Zoom out**: This allows you to zoom out of the page.
- **Panning (Frame)**: This allows you to move the map page.
- **Full extent**: This carries out a full zoom of the page.
- **Scale 1:1 zoom**: This carries out a “real” size zoom of the configured page.
- **Zoom in**: This zooms into the centre of the page.
- **Zoom out**: This zooms away from the centre of the page.
10.9 Exploring the view of the map

There are several tools you can use to navigate around the view

**Zoom in**: Enlarges a particular area of the view.

**Zoom out**: Reduces a particular area of the view.

**Full extent**: Full zoom of the total area included in all the layers of the view.

**Panning**: This allows you to change the view zoom by dragging the viewing field all over the view with the mouse. Click and hold down the left button of the mouse then move the mouse in the direction you require.

10.10 Templates

**10.10.1 Saving templates**

gvSIG allows the configuration of a map to be saved as a template. This can then be used at a later date with different data sources.

The element distribution and properties from a map can be saved.
If you click on the “File” menu then on “Save as template”
a dialogue box appears so you can save your .gvt file which can be recovered at a later date and will allow you to reconstruct the map configuration.

10.10.2 Open template

If you wish to retrieve a saved template to use it in a new project, go to the "File" menu and then to "Open template".
10.11 Printing

This option opens the printing dialogue box from which you can select the printing options (selecting printer, quality, etc.).
N.B.: The specifications which are not enabled depend on the type of printer installed.

10.12 Tools for exporting to postScript and pdf

You can use these tools to export a layout to a postScript and/or pdf file by going to the "File" menu and then selecting "Export to ps" or "Export to pdf" respectively.
or by clicking on the following buttons in the tool bar:

<table>
<thead>
<tr>
<th>File</th>
<th>Show</th>
<th>Window</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>New project</td>
<td>Alt-N</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open project</td>
<td>Alt-A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save project</td>
<td>Alt-C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save as...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PDF Export to pdf</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PS Export to ps</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open template</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save as template</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scripting</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td>Alt-X</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This opens a dialogue box in which you are asked to specify a file to save the resulting postscript file (with the .ps extension) or pdf file (with the .pdf extension). When you have selected where you wish to save the document, click on “Save”.
11 geoDB Extension (database manager)

This extension allows users easy, standardised access to geographic databases from different providers. At present, gvSIG supports the following database management systems:
- PostGIS
- MySQL
- HSQLDB
- Oracle Spatial (SDO Geometry)

gvSIG stores the different connections made during the various sessions. Thus, users do not need to input the parameters of every server they connect to. Likewise, if a project file is opened which has a database connection, the user will only be required to enter the password.

The extension has two user interfaces, one to manage the data sources and another to add the layers to the view.

11.1 The spatial database connection manager

Select the menu See – Spatial database connection manager (figure 1) to open the dialogue box which allows you to add, remove, connect and disconnect the connections to the different types of databases containing geographic information. If you have already used this manager in an earlier gvSIG session, the previous connections will appear (figure 2). If not, the dialogue box will be empty.
Figure 1. Access to the geoDB connection manager

Figure 2. The connection manager

Click on *Add* to introduce the parameters of a new connection (figure 3).

**NB:** From gvSIG version 1.1 onwards, it should be noted that the name of the database must be written correctly and that it is case sensitive. If you wish to open a project saved in a version prior to gvSIG 1.1 which includes layers belonging to a database whose connections have not taken this factor into consideration, the data must be recovered by reconnecting to the original database.

You can either connect there and then or remain offline. Open connections appear with a link and with “[C]” before their name (figure 4). If you wish to open a connection, select it and click on *Connect*. You will be asked to enter the password (figure 5) and the connection will then be made.
11.2 Adding a geoDB layer to the view

In the Project Manager, create a new view and open it using the New and Open buttons. Use the Add layer icon to add a layer to the view. Go to the GeoDB tab in the dialogue box to add a new layer of this type (figure 6).

You must choose a connection (if you select one which is disconnected, you will then be asked to enter the password), select one or more tables and the attributes you wish to download from each layer and, optionally, set an alphanumeric restriction and an area of interest. You can give each layer a different name to that of the table. Click on Ok to view
the table’s geometries in the view.

This window also allows you to specify a new connection if the database is not registered in the data source catalogue.

Any alphanumeric restriction must be introduced by means of a valid SQL expression which is attached as a WHERE clause to each call to the database.

Given that the table may take several seconds to load, a small icon appears next to the name of the table indicating that this process is underway. When the table has been loaded, the small blue icon disappears and the gvSIG view is automatically refreshed to allow the geometries to be viewed.

Figure 6. Adding a geoDB layer

Figure 7. Views with geometries from a geographic database
11.3 Exporting a gvSIG layer to a spatial database

This function allows new tables to be created in the spatial database from any vectorial source in gvSIG. These tables can be created as follows:

3. Create a vectorial layer of any type, for instance by opening an SHP file using the Add layer button (figure 9).
4. Select the layer by clicking on its name in the left-hand side of the screen (figure 10).
5. In the Layer – Export to menu, select the type of database you wish to export the layer to. The example shows an Oracle database (figure 11).
6. You will then be asked to introduce the name of the table which will be created in the database (Oracle) and whether or not you wish to include the newly-created layer in the current view.

If all goes well, the new vectorial geoDB layer will appear in the view and you will be able to work with it in the usual way.
11.4 Oracle Spatial

These notes supplement the documentation for the geoDB extension with regard to the driver for Oracle Spatial.

This driver allows access to any table from an installation of both Oracle Spatial and Oracle Locator (in both cases from version 9i onwards) which has a column that stores SDO-type geometries.
11.4.1 Metadata

The driver only lists tables which have their geographic metadata in the USER_SDO_GEOM_METADATA view.

Given that each table’s metadata is available, the interface makes use of that data and automatically presents the column (or columns) of geometries. Likewise, ROWID, which is a unique descriptor for each row used internally by Oracle, is used and this ensures that identification is correct.

11.4.2 Data types

Two and three-dimensional data of the following types are supported:

8. Point and multipoint
9. Line and multiline
10. Polygon and multipolygon
11. Collection

At present, layers in LRS format (Linear Referencing System) are not supported.

11.4.3 Coordinate systems in Oracle

Oracle has its own system for cataloguing coordinate and reference systems. Miguel Ángel Manso, on behalf of the Polytechnic University of Madrid, has provided a list of equivalent values for the Oracle system and the EPSG system and this is included in the driver as a DBF file.

Conversions from one coordinate system to another are carried out by gvSIG since its performance has proved to be superior.

11.4.4 Notes on reading geometries

The driver constantly performs geometric requests (in other words constantly calculates which geometries intersect with the current gvSIG view) and it is therefore essential that the database has a spatial index linked to the column in question. If this index does not exist, an error window appears (figure 1) and the table or view cannot be added to the gvSIG view.

In addition, the driver needs to set a unique identifier for the records of the table or view, and this is not possible for certain types of views. If such a problem occurs, it will be detected by the driver and an error message will also appear (figure 2). As a result, the view cannot be loaded to gvSIG from the database.
11.4.5 **Transferring a layer from gvSIG to Oracle**

If you wish to export a layer to an Oracle database, you will also be asked if you wish to include the view’s current coordinate system in the table at the end of the process described in the manual. This may be useful in cases where we do not wish to include such information in the table for reasons of compatibility with other applications or information systems.

To work with two Oracle geometries (the most common case is an intersection), the two geometries must have the same coordinate system. Each geometry has an SRID field which can have the value NULL.

For instance, if we have a table with geometries in EPSG:4326 (Oracle code 8307) and another with geometries in EPSG:4230 (Oracle code 8223), it will not be possible to carry out SQL instructions to perform calculations directly between the geometries of one table and another. However, if these tables’ geometries do not have a coordinate system (i.e. SRID is NULL), then operations can be performed between the geometries of these tables, bearing in mind the errors involved in carrying out intersections between different coordinate systems.

When reading a table whose geometries have a coordinate system set at NULL, it is understood that the user will make sure that the geometries are appropriate for the current view, since no reprojection is possible (this may change with the new gvSIG extension for the advanced use of coordinate systems).

In short, not storing the coordinate system allows for a more flexible use of geometries.
12 JCRS Extension (Coordinate Reference System management)

12.1 Introduction

The JCRS extension aims to enable gvSIG to accurately manage Coordinate Reference Systems and coordinate operations. In addition, information has been incorporated regarding standard CRS repositories and operations, such as EPSG and IAU2000, which are the only ones available in this initial version.

These additions provide a solution to the problem of the ED50 – ETRS89 transition.

Furthermore, the two official IGN solutions have also been included:

- Through the EPSG, the various official IGN solutions concerning seven-parameter transformations have been introduced.
- Through Proj4, the official IGN transformation has been incorporated with a NTv2 grid file.

Selecting a view’s default CRS

In gvSIG, the CRS associated with a view by default can be determined when the view is created. To do so, open the gvSIG preferences dialogue box from the “Window/Preferences” menu or click on the corresponding button in the tool bar:

Select the “View” menu from the pull-down tree menu on the left-hand side of the window. The following window appears:
In the “Default project” section, clicking on the “Change” button will open the dialogue box to search for and select CRSs:
Figure 2. Selecting the CRS. Recent CRSs

This box allows you to choose between three possible CRS repositories:

7. **Recent**: The CRSs which have been used previously are displayed (Figure 2). The list of recent CRSs is available during current and future gvSIG sessions but it is not associated with any particular project.

8. **EPSG**: This allows CRSs to be searched for and selected from the EPSG database (European Petroleum Survey Group).
In order to perform a search, write the name of the CRS you wish to find in the corresponding text box. The following search criteria can be used:

12. **EPSG Code** (e.g. 4230)
13. **CRS name** (e.g. ETRS89)
14. **Area of application** (e.g. Spain)

To change the search criteria, select the corresponding check box.

The “CRS Info” button provides detailed information about the CRS selected in the table at that time.

*Figure 3: EPSG Repository*
13. **IAU2000**: This allows the user to search for and select CRSs from the IAU2000 database. Clicking on the corresponding check box allows searches to be made “By code” or “By name”.

![IAU2000 Repository](image)

*Figure 4. IAU2000 Repository.*
12.2 Setting a view’s CRS

In order to set the CRS associated with a view, select the view in the gvSIG Project Manager and click on “Properties”.

![gvSIG Project Manager](image)

*Figure 5. gvSIG Project Manager*

In the “View properties” box, click on the “Current projection” button.
Figure 6. View properties

The CRS search box will open.

Figure 7. Selecting the CRS
12.3 Selecting the CRS associated with a layer

A layer’s CRS can be selected when the layer is added to the view. In the “Add layer” text box, click on “Current projection”.

Figure 8. Adding a layer

A box will open which is similar to the one used to select the view’s CRS, the difference being that there is a pull-down menu to select the transformation to be applied when reproducing the layer on the view (if this is required).
Figure 9. Selecting the layer's CRS
12.4 Transformations

Changing a layer’s reference system requires a conversion or transformation operation, or a conversion and transformation operation:

A coordinate conversion operation is applied when the layer’s CRS datum coincides with the view’s CRS datum. In other words, both CRSs correspond to the same geodesic reference system but use different coordinate systems.

In this case, the “No transformation” option would be selected.

A coordinate transformation operation is applied when the layer’s CRS datum does not coincide with the view’s CRS datum. In this case, two types of coordinate operations can be carried out:

- The operation may only involve a transformation operation. This is the case when the layer’s CRS coordinate system coincides with the view’s CRS coordinate system, that is to say that the position is expressed in the same coordinate system in both CRSs but using different datum.

- The operation may require a joint transformation and conversion operation because neither the datum nor the coordinate system of the layer’s CRS and the view’s CRS coincide.

If such a transformation operation is required, select the type of transformation in the layer’s CRS’ selection box and click on “Next”. This opens the corresponding transformation panel. There are three types of transformations: “EPSG transformation”, “Manual transformation” and “Transformation by grid file”.

12.4.1 EPSG Transformation

These are the official seven-parameter transformation operations defined in the EPSG repository and are used when the view’s and the layer’s CRS belong to this repository.

The panel for this type of transformation shows the transformations which can be applied. The source CRS is taken to be the one chosen for the layer and the target CRS is the one set in the view.
It must be taken into account that transformation operations of this kind are always carried out on base CRSs, that is to say non-projected CRSs. Consequently, if the CRS of the view or the layer is projected, the corresponding CRS base will appear in the CRS source and CRS target fields.

12.4.2 Manual Transformation

In this case, the transformation operation is defined by introducing seven parameters; the translation of “x”, “y”, “z”, the rotation of “x”, “y”, “z” and the scale.
12.4.3 Transformation by grid file

This involves carrying out a transformation operation based on an NTv2 grid file.

Select the file you wish to use from the ones available by clicking on the “Nadgrids file” pull-down menu. If you wish to use any other NTv2 file, it must first be imported. To import a “nadgrids” file, click on the “Import .gsb” button. This then opens the list of files which can be used for the transformation.

Grid files are calculated for a specific CRS and this data must be provided by checking one of the two options under the “Grid file calculated on:” label.

**NB:** A grid file has a specific area of application which can be seen in the information about this file in the transformation panel. No transformations are performed outside this area. As a result, the reprojection is considerably less accurate as it simply carries out the corresponding conversion operation between coordinate systems.
Recent transformations

This function allows a previously-used transformation to be selected. The list of recent transformations is available in current and subsequent gvSIG sessions and is not linked to a specific project.
13 Scripting extension

gvSiG has an extension which allows you to create your own scripts in different programming languages, such as Jython, javascript, beanShell or groovy.

**Jython** is an implementation of the high-level, object-oriented language Python written in Java, and integrated with the Java platform. It allows you to run Python on any Java platform.

**BeanShell** is an object-oriented Java source code interpreter with script utilities. It executes standard Java expressions and statements as well as scripting commands and syntax.

**Groovy** is a powerful language for the Java virtual machine which compiles Java byte code and implements several high-level utilities for Java developers.

A scripting extension tutorial is available in [www.gvsig.org](http://www.gvsig.org).
13.1 Jython console

gvSIG includes a command console for Jython language which can be accessed by going to the "File" menu bar, then to "Scripting" and "Jython console".
Anexos

1 Icons and cursors in gvSIG

1.1 Icons which appear in the ToC (Table of contents)

The following table shows the icons which appear in the ToC to the left of the name and which vary depending on the type of layer.

<table>
<thead>
<tr>
<th>Original Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>icon-layer</td>
<td>![Icon Image]</td>
<td>A generic icon for a layer which does not have its own icon.</td>
</tr>
<tr>
<td>icon-layer-group</td>
<td>![Icon Image]</td>
<td>An icon for a group of layers in the ToC.</td>
</tr>
<tr>
<td>icon-layer-vect.shp</td>
<td>![Icon Image]</td>
<td>An icon used by default for a vector layer.</td>
</tr>
<tr>
<td>icon-layer-wms</td>
<td>![Icon Image]</td>
<td>An icon used for WMS layers in the OGC service.</td>
</tr>
<tr>
<td>icon-layer-wfs</td>
<td>![Icon Image]</td>
<td>An icon used for WFS layers in the OGC service.</td>
</tr>
<tr>
<td>icon-layer-raster</td>
<td>![Icon Image]</td>
<td>An icon used for raster layers.</td>
</tr>
</tbody>
</table>

1.2 Cursors

These cursors are used by the application depending on the tool which is enabled at that time.

<table>
<thead>
<tr>
<th>Original Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cursor-query-information</td>
<td>![Icon Image]</td>
<td>A cursor used when the information request tool is selected.</td>
</tr>
<tr>
<td>cursor-zoom-in</td>
<td>![Icon Image]</td>
<td>A cursor which appears when zooming in.</td>
</tr>
<tr>
<td>cursor-zoom-out</td>
<td>![Icon Image]</td>
<td>A cursor which appears when zooming out.</td>
</tr>
<tr>
<td>cursor-hyperlink</td>
<td>![Icon Image]</td>
<td>A cursor used for the hyperlink tool.</td>
</tr>
<tr>
<td>cursor-insert-polygon</td>
<td>+</td>
<td>A cursor used by the insert polygon tool in an editing session.</td>
</tr>
<tr>
<td>----------------------</td>
<td>---</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>cursor-insert-rectangle</td>
<td>+</td>
<td>A cursor used by the insert rectangle tool in an editing session.</td>
</tr>
<tr>
<td>cursor-pan</td>
<td>🏛️</td>
<td>A cursor which appears when panning is allowed.</td>
</tr>
<tr>
<td>cursor-query-area</td>
<td>+</td>
<td>A cursor used by the area measuring tool.</td>
</tr>
<tr>
<td>cursor-query-distance</td>
<td>+</td>
<td>A cursor used by the distance measuring tool.</td>
</tr>
<tr>
<td>cursor-select-by-rectangle</td>
<td>+</td>
<td>A cursor which appears when selecting by rectangle.</td>
</tr>
<tr>
<td>cursor-select-point</td>
<td>+</td>
<td>A cursor used to make a point selection.</td>
</tr>
</tbody>
</table>

### 1.3 Actions

Icons which appear in the tool bar or in the application menus.

<table>
<thead>
<tr>
<th>Original Name</th>
<th>Name in gvSIG</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>application-console</td>
<td>Information console</td>
<td>📝</td>
<td>This displays the application's error console.</td>
</tr>
<tr>
<td>application-exit</td>
<td>Exit</td>
<td>🚫</td>
<td>This closes the application.</td>
</tr>
<tr>
<td>application-preferences</td>
<td>Preferences</td>
<td>🛠️</td>
<td>This displays the application's preferences dialogue box.</td>
</tr>
<tr>
<td>edit-copy</td>
<td>Copy</td>
<td>📝</td>
<td>This copies documents</td>
</tr>
<tr>
<td>edit-cut</td>
<td>Cut</td>
<td>� tbody</td>
<td>This cuts documents.</td>
</tr>
<tr>
<td>edit-delete</td>
<td>Delete</td>
<td>🗑️</td>
<td>This deletes documents.</td>
</tr>
<tr>
<td>edit-paste</td>
<td>Paste</td>
<td>📑</td>
<td>This pastes documents.</td>
</tr>
<tr>
<td>edit-redo</td>
<td>Redo</td>
<td>🔄</td>
<td>This redoes an action.</td>
</tr>
<tr>
<td>edit-undo</td>
<td>Undo</td>
<td>🔄️</td>
<td>This undoes another action</td>
</tr>
<tr>
<td>document-print</td>
<td>Print</td>
<td>📝</td>
<td>This allows access to the print configuration dialogue box.</td>
</tr>
<tr>
<td>project-new</td>
<td>Create a new Project</td>
<td>🖋️</td>
<td>This creates a new blank project.</td>
</tr>
<tr>
<td>project-open</td>
<td>Open an existing project</td>
<td>📑</td>
<td>This shows the “Open” dialogue box which allows an existing project to be located.</td>
</tr>
<tr>
<td>project-save-as</td>
<td>Save as</td>
<td>📑️</td>
<td>This saves the changes made to a project.</td>
</tr>
<tr>
<td>project-save</td>
<td>Save project</td>
<td>📑️</td>
<td>This saves the changes made to a project.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>layer-add</td>
<td>Add layer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>layer-show-attribute-table</td>
<td>See table</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edition-command-stack</td>
<td>Command stack</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edition-complex-selection</td>
<td>Complex selection</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edition-geometry-copy</td>
<td>Copy</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edition-geometry-edit-vertex</td>
<td>Edit vertex</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edition-geometry-insert-line</td>
<td>Line</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edition-geometry-move</td>
<td>Move</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edition-geometry-rotate</td>
<td>Rotate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edition-geometry-scale</td>
<td>Scale</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edition-geometry-select</td>
<td>Select</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edition-geometry-symmetry</td>
<td>Symmetry</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edition-insert-geometry-arc</td>
<td>Arc</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edition-insert-geometry-circle</td>
<td>Circle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edition-insert-geometry-ellipse</td>
<td>Ellipse</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edition-insert-geometry-multipoint</td>
<td>Multipoint</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edition-insert-geometry-point</td>
<td>Point</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edition-insert-geometry-polygon</td>
<td>Polygon</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edition-insert-geometry-polyline</td>
<td>Polyline</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edition-insert-geometry-rectangle</td>
<td>Rectangle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>edition-modify-geometry-internalpolygon</td>
<td>This shows the dialogue box to add layers to a view.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This shows the table of attributes of the selected layer.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This shows the command stack window of an editing session.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This activates the complex selection tools on a view.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This makes a copy of the selected element.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This allows a geometry vertex to be edited.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This allows a line to be inserted in a line layer editing session.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This moves the selected geometries.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This allows the selected geometries to be rotated.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This scales (reduces or increases) the selected geometries.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This selects a geometry</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This divides a geometry symmetrically.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This activates the tool to insert an arc in the layer.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This activates the tool to insert a circle in the layer.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This activates the tool to insert an ellipse in the layer.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This activates the tool to insert points in a multipoint geometry.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This activates the point insertion tool.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This activates the polygon insertion tool.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This activates the tool to insert a polyline.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This activates the rectangle insertion tool.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This allows a polygon to be extracted from a closed geometry.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Maps**
<table>
<thead>
<tr>
<th>Layout Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>layout-add-border</td>
<td>Graphic line This adds a border to the map.</td>
</tr>
<tr>
<td>layout-bring-to-front</td>
<td>Bring to front This puts the selected element in front of other elements.</td>
</tr>
<tr>
<td>layout-clear-selection</td>
<td>Clear selection This eliminates the selected element.</td>
</tr>
<tr>
<td>layout-command-stack</td>
<td>Command stack This displays the map's command stack window.</td>
</tr>
<tr>
<td>layout-edit-vertex</td>
<td>Edit vertex This allows vertexes of graphic elements inserted in the map to be edited.</td>
</tr>
<tr>
<td>layout-export-pdf</td>
<td>Export pdf This exports the map to pdf format.</td>
</tr>
<tr>
<td>layout-export-ps</td>
<td>Export ps This exports the map to postscript format.</td>
</tr>
<tr>
<td>layout-group</td>
<td>Group graphics This groups together the selected elements of the map.</td>
</tr>
<tr>
<td>layout-insert-box</td>
<td>Insert box This inserts a box in the map.</td>
</tr>
<tr>
<td>layout-insert-circle</td>
<td>Circle This inserts a circle in the map.</td>
</tr>
<tr>
<td>layout-insert-image</td>
<td>Insert image This inserts an image in the map.</td>
</tr>
<tr>
<td>layout-insert-legend</td>
<td>Insert legend This adds the view legend to the map.</td>
</tr>
<tr>
<td>layout-insert-line</td>
<td>Insert line This tool allows a line to be added to the map.</td>
</tr>
<tr>
<td>layout-insert-north</td>
<td>Insert north Adds the element “North” to the map.</td>
</tr>
<tr>
<td>layout-insert-point</td>
<td>Insert point This tool allows a point to be inserted in the map.</td>
</tr>
<tr>
<td>layout-insert-polygon</td>
<td>Insert polygon This tool allows a polygon to be inserted in the map.</td>
</tr>
<tr>
<td>layout-insert-polyline</td>
<td>Insert polyline This tool allows a polyline to be inserted in the map.</td>
</tr>
<tr>
<td>layout-insert-scalebar</td>
<td>Insert scale This tool allows the view scalebar to be inserted in the map.</td>
</tr>
<tr>
<td>layout-insert-text</td>
<td>Insert text This inserts a text in the map.</td>
</tr>
<tr>
<td>layout-insert-view</td>
<td>Insert view This inserts a view in the map.</td>
</tr>
<tr>
<td>layout-page-setup</td>
<td>Page setup This opens the map’s page preference dialogue box.</td>
</tr>
<tr>
<td>layout-pan</td>
<td>Frame the view This activates the panning tool to move around the view.</td>
</tr>
<tr>
<td>layout-save-template</td>
<td>Save as template This saves the map design as a template.</td>
</tr>
<tr>
<td>layout-select</td>
<td>Select by rectangle This selects an element in the map.</td>
</tr>
<tr>
<td>layout-send-to-back</td>
<td>Send to back This sends the selected element to the back.</td>
</tr>
<tr>
<td>layout-set-size-position</td>
<td>Size/position This changes the size and position of an element in the map.</td>
</tr>
<tr>
<td>layout-show-tag</td>
<td>Move image to be georeferenced This allows you to move the image to be georeferenced in the view.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>layout-template-open</td>
<td>Open template</td>
</tr>
<tr>
<td>layout-ungroup</td>
<td>Ungroup graphics</td>
</tr>
<tr>
<td>layout-zoom-centre-in</td>
<td>Zoom in to centre</td>
</tr>
<tr>
<td>layout-zoom-centre-out</td>
<td>Zoom out from centre</td>
</tr>
<tr>
<td>layout-zoom-fit</td>
<td>Zoom fit</td>
</tr>
<tr>
<td>layout-zoom-in</td>
<td>Zoom in</td>
</tr>
<tr>
<td>layout-zoom-out</td>
<td>Zoom out</td>
</tr>
<tr>
<td>layout-zoom-real</td>
<td>Zoom 1.1</td>
</tr>
<tr>
<td>layout-zoom-selected</td>
<td>Zoom to selection</td>
</tr>
</tbody>
</table>

### Tables

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>table-filter</td>
<td>Filter</td>
</tr>
<tr>
<td>table-join</td>
<td>Join</td>
</tr>
<tr>
<td>table-link</td>
<td>Link</td>
</tr>
<tr>
<td>table-order-asc</td>
<td>Ascending order</td>
</tr>
<tr>
<td>table-order-desc</td>
<td>Descending order</td>
</tr>
<tr>
<td>table-selection-up</td>
<td>Move the selection up</td>
</tr>
<tr>
<td>table-statistics</td>
<td>Statistics</td>
</tr>
</tbody>
</table>

### Views

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>view-add-event-layer</td>
<td>Add event layer</td>
</tr>
<tr>
<td>view-centre-to-point</td>
<td>Centre the view on a point</td>
</tr>
<tr>
<td>view-clear-selection</td>
<td>Clear selection</td>
</tr>
<tr>
<td>view-locator</td>
<td>Locate by attribute</td>
</tr>
<tr>
<td>view-pan</td>
<td>Panning</td>
</tr>
<tr>
<td>view-query-area</td>
<td>Measure area</td>
</tr>
<tr>
<td>view-query-distance</td>
<td>Measure distances</td>
</tr>
<tr>
<td>view-query-link</td>
<td>Hyperlink</td>
</tr>
<tr>
<td>view-save-to-raster</td>
<td>Save to raster</td>
</tr>
</tbody>
</table>
2 Details of known errors in gvSIG 1.1

2.1 Windows which roll up and affect the installation launcher and the application windows (only applies to Linux and KDE desktops)

An error has been detected which affects the way in which the application windows and the gvSIG installer are displayed. There are occasions on which the windows roll up and only the title bar can be seen. To solve this problem, follow the steps below:

– Open the application and place the cursor over the gvSIG icon in the top left-hand
corner. Right click on the mouse.

If the window has already rolled itself up, open the window again before continuing. To do this, right click on the mouse on the window’s title bar and disable the “Shade” option so that the window is displayed again.

9. Select the “Configure window behaviour” option from the contextual menu.

In the following window, select the “Specific window preferences” option and click on “New”.

© 2007 Conselleria de Infraestructuras y Transporte
In the next window, click on the “Detect” button and click on any part of the gvSIG view.

15. A new window will then open. Select the option “Use window type (all the application)” and click on “Ok”.

14. Return to the “Edit specific window options” window, go to the “Geometry” tab, select the “Shade” option and click on the “Force” option in the pull-down menu.
2.2 Error in the management of Date values in gvSIG

At present there is no uniform date format in gvSIG, which leads to problems involving date value management.

Problems have been detected when performing calculations with Date values using the Field Calculator.

2.3 Error when attempting to join two tables with accented field names.

At present, it is not possible to correctly join two tables whose field names contain accents.

2.4 Error when configuring a web browser in preferences (only applies to Linux)

In the web browser option of the gvSIG preferences menu, the section “Execute own command” does not work correctly in this version.

2.5 The fields of a dbf table joined to a dxf table cannot be labelled.

At present, it is not possible to see the labels on the field of a dbf table which has been
joined to a dxf table by means of the table-joining process.

2.6 Rotating an element inserted in a map using the graphics rotation arrow in the properties window (Error in Windows XP)

At present, graphics cannot be rotated clockwise as there is no arrow with which to do so. If you wish to rotate graphics in this direction, input the corresponding degrees (together with a minus sign) in the associated text box.

2.7 Symmetry tool do not work on an annotation layer.

At present, it is not possible to use the symmetry tools on an annotation layer.

2.8 Once loaded, the image format of a WMS layer cannot be changed.

A problem has been detected with some WMS servers in which, on attempting to access the layer properties again and change the image formats, these are not displayed correctly.

2.9 Problems recognising the printer (only applies to Linux and Java 1.5)

If gvSIG displays a warning message indicating that there is no default printer even if there is a printer installed, go to the system preferences menu and set the printer as default.

2.10 Error in the results of the grouping functions in the “Dissolve” geoprocessing tool.

It has been found that the results obtained after applying the grouping functions in the “Dissolve” geoprocess are not correct.

2.11 Known errors in the “Export to raster” tool.

When attempting to clip jpg2000 and ecw layers, the RGB bands are interchanged in the resulting layer.
3 GNU GENERAL PUBLIC LICENSE

GNU GENERAL PUBLIC LICENSE
Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.,
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your
freedom to share and change it. By contrast, the GNU General Public
License is intended to guarantee your freedom to share and change free
software—­to make sure the software is free for all its users. This
General Public License applies to most of the Free Software
Foundation's software and to any other program whose authors commit to
using it. (Some other Free Software Foundation software is covered by
the GNU Lesser General Public License instead.) You can apply it to
your programs, too.

When we speak of free software, we are referring to freedom, not
price. Our General Public Licenses are designed to make sure that you
have the freedom to distribute copies of free software (and charge for
this service if you wish), that you receive source code or can get it
if you want it, that you can change the software or use pieces of it
in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid
anyone to deny you these rights or to ask you to surrender the rights.
These restrictions translate to certain responsibilities for you if you
distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether
gratis or for a fee, you must give the recipients all the rights that
you have. You must make sure that they, too, receive or can get the
source code. And you must show them these terms so they know their
rights.

We protect your rights with two steps: (1) copyright the software, and
(2) offer you this license which gives you legal permission to copy,
distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain
that everyone understands that there is no warranty for this free
software. If the software is modified by someone else and passed on, we
want its recipients to know that what they have is not the original, so
that any problems introduced by others will not reflect on the original
authors' reputations.

Finally, any free program is threatened constantly by software
patents. We wish to avoid the danger that redistributors of a free program will individually obtain patent licenses, in effect making the program proprietary. To prevent this, we have made it clear that any patent must be licensed for everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.

GNU GENERAL PUBLIC LICENSE
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder saying it may be distributed under the terms of this General Public License. The "Program", below, refers to any such program or work, and a "work based on the Program" means either the Program or any derivative work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or with modifications and/or translated into another language. (Hereinafter, translation is included without limitation in the term "modification".) Each licensee is addressed as "you".

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of running the Program is not restricted, and the output from the Program is covered only if its contents constitute a work based on the Program (independent of having been made by running the Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:

a) You must cause the modified files to carry prominent notices stating that you changed the files and the date of any change.

b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under the terms of this License.

c) If the modified program normally reads commands interactively
when run, you must cause it, when started running for such interactive use in the most ordinary way, to print or display an announcement including an appropriate copyright notice and a notice that there is no warranty (or else, saying that you provide a warranty) and that users may redistribute the program under these conditions, and telling the user how to view a copy of this License. (Exception: if the Program itself is interactive but does not normally print such an announcement, your work based on the Program is not required to print an announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Program, and can be reasonably considered independent and separate works in themselves, then this License, and its terms, do not apply to those sections when you distribute them as separate works. But when you distribute the same sections as part of a whole which is a work based on the Program, the distribution of the whole must be on the terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to exercise the right to control the distribution of derivative or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work based on the Program) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the terms of Sections 1 and 2 above provided that you also do one of the following:

a) Accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,

b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost of physically performing source distribution, a complete machine-readable copy of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,

c) Accompany it with the information you received as to the offer to distribute corresponding source code. (This alternative is allowed only for noncommercial distribution and only if you received the program in object code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an executable work, complete source code means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to control compilation and installation of the executable. However, as a special exception, the source code distributed need not include anything that is normally distributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then offering equivalent access to copy the source code from the same place counts as distribution of the source code, even though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will automatically terminate your rights under this License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or distribute the Program or its derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by modifying or distributing the Program (or any work based on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives a license from the original licensor to copy, distribute or modify the Program subject to these terms and conditions. You may not impose any further restrictions on the recipients' exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a patent license would not permit royalty-free redistribution of the Program by all those who receive copies directly or indirectly through you, then the only way you could satisfy both it and this License would be to refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under
any particular circumstance, the balance of the section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution system, which is implemented by public license practices. Many people have made generous contributions to the wide range of software distributed through that system in reliance on consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted interfaces, the original copyright holder who places the Program under this License may add an explicit geographical distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus excluded. In such case, this License incorporates the limitation as if written in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number of this License which applies to it and "any later version", you have the option of following the terms and conditions either of that version or of any later version published by the Free Software Foundation. If the Program does not specify a version number of this License, you may choose any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are different, write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve this is to make it free software which everyone can redistribute and change under these terms.

To do so, attach the following notices to the program. It is safest to attach them to the start of each source file to most effectively convey the exclusion of warranty; and each file should have at least the "copyright" line and a pointer to where the full notice is found.

<one line to give the program's name and a brief idea of what it does.>
Copyright (C) <year> <name of author>

This program is free software; you can redistribute it and/or modify it under the terms of the GNU General Public License as published by the Free Software Foundation; either version 2 of the License, or (at your option) any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public License for more details.

You should have received a copy of the GNU General Public License along with this program; if not, write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA.

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this when it starts in an interactive mode:

Gnomovision version 69, Copyright (C) year name of author
Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type `show w'. This is free software, and you are welcome to redistribute it
under certain conditions; type `show c' for details.

The hypothetical commands `show w' and `show c' should show the appropriate parts of the General Public License. Of course, the commands you use may be called something other than `show w' and `show c'; they could even be mouse-clicks or menu items—whatever suits your program.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a "copyright disclaimer" for the program, if necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the program `Gnomovision' (which makes passes at compilers) written by James Hacker.

<signature of Ty Coon>, 1 April 1989
Ty Coon, President of Vice

This General Public License does not permit incorporating your program into proprietary programs. If your program is a subroutine library, you may consider it more useful to permit linking proprietary applications with the library. If this is what you want to do, use the GNU Lesser General Public License instead of this License.